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Operational Precautions and
Limitations 1
Note: Before operating the system, carefully read all of the sections of this guide.

This section contains general safety-related information and provides regulatory compliance
information. It also describes potential hazards and associated warnings for the system and the
precautions that should be taken to minimize the hazards.

In addition to this section, for information about the symbols and conventions used in the
laboratory environment, on the system, and in this documentation, refer to the section:
Glossary of Symbols. For site requirements, including mains supply, source exhaust, ventilation,
compressed air, nitrogen, and roughing pump requirements, refer to the document: Site Planning
Guide.

General Safety Information
To prevent personal injury or system damage, read, understand, and obey all safety precautions
and warnings in this document, the manufacturer chemical safety data sheets (SDSs), and
product label information. Labels are shown with internationally recognized symbols. Failure to
heed these warnings could result in serious injury.

This safety information is intended to supplement federal, state, provincial, and local
environmental health and safety (EHS) regulations. The information provided covers system-
related safety information applicable to the operation of the system. It does not cover every
safety procedure that should be practiced. Ultimately, the user and the organization are
responsible for compliance with federal, state, provincial, and local EHS regulations and
maintaining a safe laboratory environment.

Refer to the appropriate laboratory reference material and standard operating procedures.

Documentation Symbols and Conventions
The following symbols and conventions are used throughout the guide.

DANGER! Danger signifies an action that leads to severe injury or death.

Operational Precautions and Limitations
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WARNING! Warning signifies an action that could cause personal injury if
precautions are not followed.

CAUTION: Caution signifies an operation that could cause damage to the system or
corruption or loss of data if precautions are not followed.

Note: Note emphasizes significant information in a procedure or description.

Tip! Tip provides useful information that helps apply the techniques and procedures in the text
for a specific need and provides shortcuts, but is not essential to the completion of a procedure.

Regulatory Compliance
This system complies with the regulations and standards listed in this section. For dated
references, refer to the Declaration of Conformity included with the system and the individual
system components. Applicable labels have been affixed to the system.

Canada
• Electromagnetic Interference (EMI): CAN/CSA CISPR11. This ISM device complies with

Canadian ICES-001. Refer to the section: Electromagnetic Interference.

• Safety:

• CAN/CSA C22.2 No. 61010-1

• CAN/CSA C22.2 No 61010-2-061

• CAN/CSA C22.2 No. 61010-2-101

Europe
• In Vitro Diagnostic Devices (IVD): In Vitro Diagnostics Regulation 2017/746

• Electromagnetic Compatibility (EMC): Electromagnetic Compatibility Directive 2014/30/EU
as implemented in these standards:

• EN 61326-1

• EN 61326-2-6

• EN 55011 (Class A)

Refer to the section: Electromagnetic Compatibility.

Operational Precautions and Limitations

System User Guide
IVD-IDV-05-6996-D

SCIEX 4500MD Systems
13/313



• Safety: Low Voltage Directives 2014/35/EU as implemented in these standards:

• EN 61010-1

• EN 61010-2-061

• EN 61010-2-101

• Waste Electrical and Electronic Equipment (WEEE): Waste Electrical and Electronic
Equipment Directive 2012/96/EEC, as implemented in EN 40519. Refer to the section: Waste
Electrical and Electronic Equipment.

• Packaging and Packaging Waste (PPW): Packaging and Packaging Waste Directive
94/62/EC

• RoHS Restriction of Hazardous Substances: RoHS Directive 2011/65/EU and
2015/863/EU

United States
• Radio Emissions Interference Regulations: 47 CFR 15, as implemented in FCC Part 15

(Class A)

• Safety: Occupational Safety and Health Regulations, 29 CFR 1910, as implemented in these
standards:

• UL 61010-1

• IEC 61010-2-061

• IEC 61010-2-101

International
• Electromagnetic Compatibility (EMC):

• IEC 61326-1

• IEC CISPR 11 (Class A)

• IEC 61000-3-2

• IEC 61000-3-3

Refer to the section: Electromagnetic Compatibility.

• Safety:

• IEC 61010-1

• IEC 61010-2-061

Operational Precautions and Limitations
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• IEC 61010-2-101

Electrical Precautions
WARNING! Electrical Shock Hazard. Do not remove the covers. Removing
the covers might cause injury or malfunctioning of the system. The covers
need not be removed for routine maintenance, inspection, or adjustment.
Contact a SCIEX Field Service Employee (FSE) for repairs that require the
covers to be removed.

• Follow required electrical safe work practices.

• Use cable management practices to control electrical cables. This will decrease the chance of
a tripping hazard.

For information about system electrical specifications, refer to the section: Performance
Characteristics and Specifications or the document: Site Planning Guide.

Mains Supply
Connect the system to a compatible mains supply as instructed in this guide.

WARNING! Electrical Shock Hazard. Use only qualified personnel for the
installation of all of the electrical supplies and fixtures, and make sure that
all of the installations adhere to local regulations and safety standards.

WARNING! Electrical Shock Hazard. Make sure that the system can be
disconnected from the mains supply outlet in an emergency. Do not block
the mains supply outlet.

WARNING! Electrical Shock Hazard. Use only the mains supply cables
supplied with the system. Do not use mains supply cables that are not
properly rated for the operation of this system.

An external line transformer is not needed for the mass spectrometer, optional bench, or
roughing pump.

Protective Earth Conductor
The mains supply must include a correctly installed protective earth conductor. The protective
earth conductor must be installed or examined by a qualified electrician before the system is
connected.

Operational Precautions and Limitations
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WARNING! Electrical Shock Hazard. Do not intentionally interrupt the
protective earth conductor. Any interruption of the protective earth
conductor creates an electrical shock hazard.

WARNING! Electrical Shock Hazard. Make sure that a protective earth
conductor (grounding cable) is connected between the sample loop and
an appropriate grounding point at the ion source. This supplementary
grounding reinforces the safety configuration specified by SCIEX.

Chemical Precautions
WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical
Hazard. Determine whether decontamination is required before cleaning
or maintenance. If radioactive materials, biological agents, or toxic
chemicals have been used with the system, then the customer must
decontaminate the system before cleaning or maintenance.

WARNING! Environmental Hazard. Do not dispose of system components in
municipal waste. Follow local regulations when disposing of components.

WARNING! Biohazard or Toxic Chemical Hazard. Connect the drain tubing
to the mass spectrometer and the source exhaust drain bottle properly, to
prevent leaks.

• Determine which chemicals have been used in the system prior to service and regular
maintenance. For the health and safety precautions that must be followed for a chemical,
refer to the document: Safety Data Sheet. For storage information, refer to the document:
Certificate of Analysis. To find a SCIEX Safety Data Sheet or Certificate of Analysis, go to
sciex.com/tech-regulatory.

• Always wear assigned personal protective equipment, including powder-free gloves, safety
glasses, and a laboratory coat.

Note: Nitrile or neoprene gloves are recommended.

• Work in a well-ventilated area or fume hood.

• Avoid ignition sources when working with flammable materials, such as isopropanol,
methanol, and other flammable solvents.

• Take care in the use and disposal of any chemicals. There is a potential risk of personal injury
if proper procedures for handling and disposal of chemicals are not followed.

• Avoid skin contact with chemicals during cleaning, and wash hands after use.

Operational Precautions and Limitations
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• Make sure that all exhaust hoses are connected properly and that all connections are
functioning as designed.

• Collect all spent liquids and dispose of them as hazardous waste.

• Comply with all of the local regulations for the storage, handling, and disposal of
biohazardous, toxic, and radioactive materials.

• (Recommended) Use secondary containment trays beneath the roughing pump, the solvent
bottles, and the waste container to capture potential chemical spills.

System Safe Fluids
The following fluids can safely be used with the system.For information about safe cleaning
solutions, refer to the section: Required Materials.

CAUTION: Potential System Damage. Do not use any other fluid until confirmation is
received from SCIEX that it does not present a hazard. This is not an exhaustive list.

Note: Use only new, freshly prepared LC-MS-grade or better solvents for the LC mobile phases.

• Organic Solvents

• LC-MS-grade acetonitrile; up to 100%

• LC-MS-grade methanol; up to 100%

• LC-MS-grade isopropanol; up to 100%

• LC-MS-grade or higher water; up to 100%

• Buffers

• Ammonium acetate; less than 100 mM

• Ammonium formate; less than 100 mM

• Acids and Bases

• Formic acid; less than 1%

• Acetic acid; less than 1%

• Trifluoroacetic acid (TFA); less than 1%

• Heptafluorobutyric acid (HFBA); less than 1%

• Ammonia/ammonium hydroxide; less than 1%

Operational Precautions and Limitations
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Ventilation Precautions
The venting of fumes and disposal of waste must comply with all of the federal, state, provincial,
and local health and safety regulations. It is the responsibility of the customer to make sure that
the air quality is maintained in compliance with local health and safety regulations.

The source exhaust system and roughing pump must be vented to a dedicated laboratory fume
hood or an external exhaust system.

WARNING! Fire Hazard. Make sure that the source exhaust system is connected
and functioning, to prevent flammable vapor from accumulating in the ion source.

WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical
Hazard. Take care to vent exhaust gases to a dedicated laboratory fume
hood or exhaust system and make sure that the ventilation tubing is
secured with clamps. Make sure that the laboratory has appropriate air
exchange for the work performed.

WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical Hazard.
Do not operate the mass spectrometer if the source exhaust drain and
roughing pump exhaust hoses are not properly connected to the laboratory
ventilation system. Examine the exhaust tubing regularly to make sure that
there are no leaks. The use of mass spectrometers without proper system
ventilation might constitute a health hazard and might result in serious
injury.

WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical
Hazard. Do not use the ion source without knowledge of and training
in the proper use, containment, and evacuation of toxic or injurious
materials used with the ion source.

WARNING! Puncture Hazard, Ionizing Radiation Hazard, Biohazard, or
Toxic Chemical Hazard. Discontinue use of the ion source if the ion
source window is cracked or broken, and then contact a SCIEX Field
Service Employee (FSE). Any toxic or injurious materials introduced in
the equipment will be present in the source exhaust output. Exhaust from
equipment should be vented from the room. Dispose of sharps following
established laboratory safety procedures.

Operational Precautions and Limitations
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Physical Precautions
WARNING! Hot Surface Hazard. Let the Turbo V ion source cool for at least
30 minutes before starting any maintenance procedures. Some surfaces of
the ion source and vacuum interface become hot during operation.

WARNING! Lifting Hazard. Use a mechanical lifting device to lift and move the
mass spectrometer. If the mass spectrometer must be moved manually, then at
least six people are required to move it safely. Follow established safe lifting
procedures. We recommend the use of a professional moving service. For the
weights of system components, refer to the document: Site Planning Guide.

Environmental Precautions
Use qualified personnel for the installation of electrical mains, heating, ventilation, and plumbing
supplies and fixtures. Make sure that all of the installations comply with local bylaws and
biohazard regulations. For information about the required environmental conditions for the
system, refer to the document: Site Planning Guide.

Allow access space around the equipment when setting up the system.

DANGER! Explosion Hazard. Do not operate the system in an environment containing
explosive gases. The system is not designed for operation in an explosive environment.

WARNING! Biohazard. For biohazardous material use, always comply with local
regulations for hazard assessment, control, and handling. This system or any part
is not intended to act as a biological containment.

WARNING! Environmental Hazard. Follow established procedures for disposal
of biohazardous, toxic, radioactive, and electronic waste. The customer
is responsible for disposal of hazardous substances, including chemicals,
waste oils, and electrical components, in accordance with local laws and
regulations.

CAUTION: Potential Mass Shift. Maintain a stable ambient temperature. If the temperature
changes by more than 2 °C per hour, then the resolution and mass calibration might be
affected.

Operational Precautions and Limitations
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CAUTION: Potential System Contamination. When using a gas generator, refer to
the documentation that accompanies the gas generator for information from the
manufacturer on the use of a gas generator with a compressor. For example, use of a gas
generator with a compressor can result in hydrocarbons entering the mass spectrometer,
if they are present in the environment.

Electromagnetic Environment
Electromagnetic Compatibility
Basic Electromagnetic Environment: Environment existing at locations characterized by being
supplied directly at low voltage from the public mains network.

Performance Criteria A (Criteria A): Equipment shall operate as intended with no degradation
of performance and no loss of function during or after the test.

Performance Criteria B (Criteria B): Equipment may experience loss of function (one or
more) during the test but shall operate as intended with some degradation of performance and
functions self-recoverable after the test.

Performance Criteria C (Criteria C): Equipment may experience loss of function (one or
more) during the test but shall operate as intended with some degradation of performance and
functions recoverable by an operator after the test.

The equipment is intended for use in a basic electromagnetic environment.

The expected performance loss under the electromagnetic immunity conditions is less than 20%
change in total ion count (TIC).

CAUTION: Potential Wrong Result. Do not use this device in close proximity to sources
of strong electromagnetic (EMC) radiation, such as unshielded intentional RF sources,
because EMC radiation might interfere with the proper operation.

Make sure that a compatible electromagnetic environment for the equipment can be maintained
so that the device will operate as intended. If the power supply line is subject to high electrical
noise, then install a surge protector.

Electromagnetic Interference
Group 1 Equipment: This equipment is classified as industrial, scientific, and medical (ISM)
equipment that might use RF energy for internal operation.

Class A Equipment: Equipment which is suitable for use in all establishments other than
domestic and those directly connected to a low voltage power supply network which supplies
buildings used for domestic purposes. [Derived from CISPR 11:2009, 5.3] Class A equipment
shall meet Class A limits.

Operational Precautions and Limitations
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CAUTION: Potential Radio Interference. This equipment is not intended for use in
residential environments and may not provide adequate protection to radio reception in
such environments.

This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to Part 15 of the FCC (Federal Communications Commission) Compliance Rules.

These limits are designed to provide reasonable protection against harmful interference when
the equipment is operated in a commercial environment. This equipment generates, uses,
and can radiate radio frequency energy and, if not installed and used in accordance with the
operator's manual, can cause harmful interference to radio communications.

Operation of this equipment in a residential area is likely to cause harmful interference in
which case you will be required to correct the interference, at your own expense. Changes or
modifications not expressly approved by the manufacturer could void your authority to operate
the equipment.

Decommissioning and Disposal
WARNING! Environmental Hazard. Follow established procedures for disposal
of biohazardous, toxic, radioactive, and electronic waste. The customer
is responsible for disposal of hazardous substances, including chemicals,
waste oils, and electrical components, in accordance with local laws and
regulations.

Before decommissioning, decontaminate the entire system following local regulations.

When removing the system from service, separate and recycle different materials according to
national and local environmental regulations. Refer to the section: Storage and Handling.

Note: SCIEX will not accept any system returns without a completed Decontamination Form.
Contact an FSE to obtain a copy of the form.

Do not dispose of system components or subassemblies, including computer parts, as unsorted
municipal waste.

Waste Electrical and Electronic Equipment
Follow local municipal waste ordinances for proper disposal provisions to reduce the
environmental impact of waste, electrical, and electronic equipment (WEEE). To safely dispose
of this equipment, contact a local Customer Service office for complimentary equipment pick-up
and recycling.
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Use and Function 2

Intended Use
The 4500MD system is a liquid chromatography-tandem mass spectrometry (LC-MS/MS)
systems intended to identify inorganic or organic compounds in human specimens by ionizing
the compound under investigation and separating the resulting ions by means of an electrical
field according to their mass. For In Vitro Diagnostic Use.

Limitations of Use
The 4500MD system is intended for use in a clinical laboratory environment by qualified
laboratory personnel for professional use only.

Description
The 4500MD system includes the following components:

• A SCIEX Triple Quad 4500MD mass spectrometer or a QTRAP 4500MD mass spectrometer
with a Turbo V ion source that uses either the TurboIonSpray probe or the atmospheric
pressure chemical ionization (APCI) probe, a roughing pump, and a source of compressed air
and nitrogen.

• A SCIEX-supplied computer and monitor with the Analyst MD software for instrument
optimization, acquisition method development, and data acquisition, and the MultiQuant MD
software for processing.

Note: In China, only triple quadrupole mass spectrometers are available. These systems do not
support the linear ion trap (LIT) scan types.

Qualified Personnel
Only qualified SCIEX personnel shall install, inspect, and service the equipment. After installing
the system, the Field Service Employee (FSE) uses the Customer Familiarization Checklist to
orient the customer on system operation, cleaning, and basic maintenance. SCIEX might not
cover the damage to a system under warranty if it is serviced by personnel not authorized by
SCIEX.
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Only personnel qualified by the manufacturer shall maintain the equipment. A laboratory
designate can be familiarized with the Qualified Maintenance Person (QMP) procedures during
the installation. A QMP is a person who is suitably aware of the electrical and chemical risks
associated with servicing laboratory equipment.

Quality Control Guidelines
It is expected that a clinical laboratory using a 4500MD system adheres to procedures that cover
issues such as, but not limited to, operator training, assay development and validation, and
external audits of laboratory assay performance.

Laboratory Processes
Verify methods before their implementation in clinical use for reporting results2,5. As well,
establish standard operating procedures (SOPs) for analytical methods to make sure that pre-
analytical, analytical, and post-analytical processes do not vary from their intended use3. For
example, at a minimum, an SOP must be in place for:3,4

• Sample collection methods

• Sample preparation methods

• Liquid chromatography settings and initial conditions

• Mass spectrometer setup and calibration initial conditions

• Liquid chromatography and mass spectrometry maintenance

• Mass spectrometer acquisition methods

• Sample batch list preparation methods

• Data analysis methods

• Data review

• Release protocols once the data is analyzed

We recommend that users manually review all of the integration results to make sure of the
quality of the raw data and the correctness of peak integrations performed by the Analyst MD
software. The review of chromatographic peaks must be performed by a trained professional.
If the Analyst MD software has not correctly integrated a chromatographic peak, which can be
caused by the presence of closely eluting peaks, split peaks, noisy data, or high background
signal, then the peak integrations should be corrected according to SOPs for analytical methods
established by the laboratory.
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Quality Control Samples
Quality control (QC) samples provide feedback on the performance of the analytical method
and assess the integrity and validity of the unknown samples analyzed within the run2. QC
sample data should be monitored day-to-day. Follow appropriate guidance for the inclusion of
QC samples in an analytical run.

QC samples can be obtained from a commercial source with the appropriate documentation or
from a well characterized pool of patient samples2. We recommend that at least two QC samples
be included per analytical run of patient samples1,2. Use the data review process to confirm
that the QC samples are within pre-defined limits for the analytical method. Data acquired in an
analytical run where the QCs are outside the pre-defined limits might be invalid2. Refer to the
laboratory SOP.

Internal Standards
Internal standards are analytes that are structurally similar analogs or stable, isotopically
labeled analytes that are added to all of the sample types, (that is, standards, blanks, QCs,
and unknowns) at known and constant concentrations to facilitate quantitation3. The internal
standard signal intensity can be monitored across an analytical run to confirm the integrity of the
analytical method and validity of an individual sample.

SOPs should include criteria for the evaluation of internal standard analytes and QC samples.
Samples that fall outside the criteria might indicate issues with the performance of the method,
system, or sample2,5. Use internal standards (isotopically labeled analytes) for measurements
involving critical decisions. Identifying these issues early allows the laboratory to investigate,
correct, and potentially repeat the analysis, if necessary2,5.

References
1. Guidance for Industry: Bioanalytical Method Validation; U.S. Department of Health and

Human Services Food and Drug Administration; Center for Drug Evaluation (CDER) Centre
for Veterinary Medicine (CVM), May 2001 BP

2. CLSI Standard C50–A–Vol. 27, No. 24—Mass Spectrometry in the Clinical Laboratory:
General Principles and Guidance: Approved Guideline

3. ISO 17025: 2005—General requirements for the competence of testing and calibration
laboratories

4. ISO 15189:2012 Medical laboratories-Requirements for quality and competence

5. CLSI document C62-A: Liquid Chromatography-Mass Spectrometry Methods; Approved
Guideline Volume 34 Number 16, October 2014
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Equipment Use and Modification
WARNING! Personal Injury Hazard. Contact the SCIEX representative if product
installation, adjustment, or relocation is required.

WARNING! Electrical Shock Hazard. Do not remove the covers. Removing
the covers might cause injury or malfunctioning of the system. The covers
need not be removed for routine maintenance, inspection, or adjustment.
Contact a SCIEX Field Service Employee (FSE) for repairs that require the
covers to be removed.

WARNING! Personal Injury Hazard. Use SCIEX-recommended parts only. Use of
parts not recommended by SCIEX or use of parts for any purpose other than their
intended purpose can put the user at risk of harm or negatively impact system
performance.

WARNING! Lifting Hazard. Use a mechanical lifting device to lift and move the
mass spectrometer. If the mass spectrometer must be moved manually, then at
least six people are required to move it safely. Follow established safe lifting
procedures. We recommend the use of a professional moving service. For the
weights of system components, refer to the document: Site Planning Guide.

WARNING! Crushing Hazard. Wear protective footwear when moving heavy
objects.

Use the system indoors in a laboratory that complies with the environmental conditions
recommended in the mass spectrometer document: Site Planning Guide.

If the system is used in an environment or in a manner not prescribed by the manufacturer, then
the performance and protection provided by the equipment might be impaired.

Unauthorized modification or operation of the system might cause personal injury and
equipment damage, and might void the warranty. Erroneous data might be generated if the
system is operated outside the recommended environmental conditions or with unauthorized
modifications. Contact an FSE for information on servicing the system.

Warranty terms are available from the sciex.com/warranty page. The 4500MD system has an
expected lifetime of 7 years from manufacture date. This lifetime might be extended when
scheduled maintenance procedures are followed.
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Laboratory Conditions

Safe Environmental Conditions
The system is designed to operate safely under these conditions:

• Indoors

• Altitude: Up to 2,000 m (6,560 ft) above sea level

• Ambient temperature: 5 °C (41 °F) to 40 °C (104 °F)

• Relative humidity: 20% to 80%, non-condensing

• Mains supply voltage fluctuations: ± 10% of the nominal voltage

• Transient overvoltages: Up to the levels of Overvoltage Category II

• Temporary overvoltages on the mains supply

• Pollution Degree 2

Performance Specifications
The system is designed to meet specifications under these conditions:

• An ambient temperature of 15 °C to 30 °C (59 °F to 86 °F)

Over time, the temperature must remain within a range of 4 °C (7.2 °F), with the rate
of the change in temperature not exceeding 2 °C (3.6 °F) per hour. Ambient temperature
fluctuations exceeding the limits might result in mass shifts in spectra.

• Relative humidity from 20% to 80%, non-condensing
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Installation Procedures and Special
Requirements 3
A SCIEX Field Service Employee (FSE) installs and configures the system.

This section includes procedures to connect and configure the system hardware and software.
Refer to these procedures if the system must be moved, replumbed, or reconfigured.

WARNING! Electrical Shock Hazard. Make sure that the system can be
disconnected from the mains supply outlet in an emergency. Do not block
the mains supply outlet.

For information on installing the Analyst MD software, refer to the document: Software
Installation Guide.

Adjust the Integrated Syringe Pump Position
WARNING! Puncture Hazard. Take care when handling the syringe. The tip of
the syringe is extremely sharp.

WARNING! Puncture Hazard. Make sure that the syringe is seated properly
in the syringe pump and that the automatic syringe pump stop is adjusted
properly to avoid damaging or breaking the glass syringe. If the syringe
breaks, follow established safety procedures for sharps disposal.

For the location of the syringe pump on the mass spectrometer, refer to the figure: Mass
Spectrometer Overview.

1. Open the syringe cover.

2. Press the Release button on the right side of the syringe pump to lower the base and then
insert the syringe.
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Figure 3-1 Lowering the Syringe

Item Description

1 Syringe plunger

2 Release button. Press to raise or lower the base.

3. Make sure that the end of the syringe is flush with the base and that the shaft of the syringe
rests in the cutout.

4. Adjust the post so that it triggers the automatic syringe stop before the syringe plunger hits
the bottom of the glass syringe.
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Figure 3-2 Automatic Syringe Stop

Item Description

1 Automatic syringe stop. After the post hits the automatic syringe stop,
the syringe pump stops.

2 Post. Adjust the height to prevent the syringe plunger from hitting the
syringe during sample infusion.

3 Post lock screw. Tighten the screw after the height of the post is
adjusted.

5. Turn the syringe pump screws to secure the syringe.
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Figure 3-3 Syringe Pump Screws

6. Make sure that the mass spectrometer and integrated syringe pump are activated in the
software.

Note: For subsequent manual use, after the mass spectrometer is in Ready state, start the
flow by pressing the button on the mass spectrometer that is to the right of the syringe. The
LED beside the button flashes when the syringe pump is in use. The syringe pump flow can
also be controlled automatically by the Analyst MD software.
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Figure 3-4 Syringe Pump LED

Item Description

1 Syringe pump on and off button

2 Syringe pump status LED

7. In the Analyst MD software, on the Navigation bar, double-click Manual Tuning.

8. Click Start Syringe.

9. To stop the syringe pump, click Stop Syringe.

Plumb the Diverter Valve
The integrated diverter valve, which is located next to the ion source, can be plumbed in injector
mode or diverter mode. To configure the valve, open the Configuration tab and then make sure
that the Use integrated injector/diverter valve check box is selected. Refer to the section: Add
Devices to a Hardware Profile.
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CAUTION: Potential Wrong Result. Do not press the diverter valve button during a run.
Doing so might result in incorrect data.

Plumb the Diverter Valve in Injector Mode
When the valve is in Position A, the sample flows through the external loop. When the valve
switches to Position B, the sample is injected.

Plumb the valve for Injector mode.

Figure 3-5 Diverter Valve—Injector Mode Position A
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Figure 3-6 Diverter Valve—Injector Mode Position B

Item Description

1 Sample in

2 Waste out

3 Sample loop (ports 3 and 6)

4 Mobile phase in

5 To column, or to the mass spectrometer, if a column is not installed

Plumb the Diverter Valve in Diverter Mode
When the valve is in Position A, the sample flow goes to the mass spectrometer. When the valve
switches to Position B, the flow goes to waste.

Plumb the valve for Diverter mode.
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Figure 3-7 Diverter Valve—Diverter Mode Position A

Figure 3-8 Diverter Valve—Diverter Mode Position B
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Item Description

1 To mass spectrometer

2 From column

3 Waste out

Ion Source Installation
WARNING! Electrical Shock Hazard. Install the ion source on the mass
spectrometer as the last step in this procedure. High voltage is present when
the ion source is installed.

CAUTION: Potential System Damage. Do not lift or carry the ion source with one hand.
The ion source is designed to be lifted or carried using two hands, one on each side of
the ion source.

The ion source is connected to the vacuum interface and is held in position by two source
latches. The interior of the ion source is visible through the windows on the side and front of the
ion source.

When the ion source is installed, the software recognizes the ion source and shows the ion
source identification.

In this guide, the software that controls the mass spectrometer is referred to as the control
software.

Required Materials

• Ion source

• TurboIonSpray probe or APCI probe

• Red PEEK tubing (0.005 inch bore)

Prepare for Installation
WARNING! Puncture Hazard. Be careful when handling the electrode. The tip of the
electrode is extremely sharp.

Tip! Do not discard the empty package. Use it to store the ion source when it is not in use.
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Adjust the electrode adjustment nut on the probe to move the electrode tip inside the electrode
tube. Refer to the figures: Figure 4-4 and Figure 4-5.
For optimum stability and performance, the electrode tip should extend between 0.5 mm and 1.0
mm from the end of the probe. Refer to the section: Optimize the TurboIonSpray Probe Position
or Optimize the APCI Probe Position.

Install the Probe
WARNING! Electrical Shock Hazard. Make sure that the ion source is
completely disconnected from the mass spectrometer before proceeding.

WARNING! Puncture Hazard. Be careful when handling the electrode. The tip of the
electrode is extremely sharp.

CAUTION: Potential System Damage. Do not let the protruding electrode tip or the corona
discharge needle touch any part of the ion source housing, to avoid damaging the probe.

CAUTION: Potential System Damage. Make sure that the corona discharge needle tip is
turned away from the aperture if the TurboIonSpray probe is in use.

Prerequisite Procedures

• Remove the Ion Source.

The probe is not pre-installed in the ion source. Always remove the ion source from the mass
spectrometer before exchanging probes.

Note: If the probe is not properly installed in the ion source, then the high-voltage power for the
mass spectrometer and source exhaust system is turned off.
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Figure 3-9 Ion Source Components

Item Description

1 Sample tubing

2 Electrode adjustment nut

3 Retaining ring

4 Probe tower

5 Corona discharge needle adjustment screw
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Item Description

6 Micrometer used to position the probe on the horizontal axis for ion source
sensitivity adjustments

7 Window port

8 One of two source latches that secure the ion source to the mass
spectrometer

9 Grounding union, located under the ion source cover

10 Micrometer used to position the probe on the vertical axis for ion source
sensitivity adjustments

1. Make sure that the corona discharge needle tip is pointed away from the curtain plate
aperture. Refer to the section: Adjust the Position of the Corona Discharge Needle.

2. Insert the probe in the tower. Align the hole on the probe with the corona discharge needle
adjustment screw at the top of the ion source. Refer to the section: Ion Source Components.

3. Gently push the probe down until the contacts engage with those in the tower.

4. Turn the retaining ring over the probe, push it down to engage the threads on the probe with
the threads on the tower, and then tighten it until it is finger-tight.

5. For the APCI probe only, make sure that the corona discharge needle tip is pointed toward
the curtain plate aperture. Refer to the section: Adjust the Position of the Corona Discharge
Needle.

Connect the Ion Source Tubing
WARNING! Electrical Shock Hazard. Do not bypass the grounding union
connection. The grounding union provides grounding between the mass
spectrometer and the sample introduction device.

WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical
Hazard. Make sure that the sample tubing nut is tightened properly
before operating this equipment, to prevent leakage.

Refer to the section: Ion Source Components.

1. Insert a 30 cm piece of red PEEK tubing in the sample tubing nut.

2. Install the sample tubing nut in the port at the top of the probe, and then tighten the sample
tubing nut until it is finger-tight.

3. Connect the other end of the tubing to the grounding union on the ion source.
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Install the Ion Source on the Mass Spectrometer
WARNING! Electrical Shock Hazard. Install the probe in the ion source before
installing the ion source on the mass spectrometer.

WARNING! Pinching Hazard. When installing the ion source, be careful not to
pinch fingers between the ion source and the vacuum interface.

CAUTION: Potential System Damage. Do not let the protruding electrode tip or the corona
discharge needle touch any part of the ion source housing, to avoid damaging the probe.

Note: If the probe is not properly installed in the ion source, then the high-voltage power for the
mass spectrometer and source exhaust system is turned off.

Prerequisites

• Make sure that all of the O-rings are present on the vacuum interface.

Figure 3-10 O-rings on the Vacuum Interface

Item Description

1 Curtain plate

2 O-rings
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1. Make sure that the ion source latches on either side of the ion source are pointing up in the
12 o’clock position. Refer to the section: Ion Source Components.

2. Align the ion source with the vacuum interface, making sure that the guide pins on the ion
source are aligned with the sockets in the vacuum interface.

3. Push the ion source gently against the vacuum interface and then rotate the ion source
latches down to lock the ion source in place.
The mass spectrometer recognizes the ion source and then shows the ion source
identification in the control software.

4. Connect the red PEEK tubing from the sample supply device to the other side of the
grounding union on the ion source.
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Principles of Operation 4
The system is intended to identify inorganic or organic compounds in human specimens.

The system is designed for analysis of small molecules in biological samples. Depending on
the properties of the analytes or the complexity of the starting sample, sample preparation can
include various types of extraction or filtration prior to extraction of analytes in solution. The
sample is separated by a liquid chromatograph. The separated fractions are then introduced
in a mass spectrometer for further separation based on the specific molecular mass of the
compounds.

For information on the computer and software, refer to the document: Software Installation
Guide for the software.

System Overview
The 4500MD system includes the following components:

• A SCIEX Triple Quad 4500MD or a 4500MD QTRAP mass spectrometer with a roughing
pump and a source of compressed air and nitrogen.

• A Turbo V ion source that uses either the TurboIonSpray probe or the atmospheric pressure
chemical ionization (APCI) probe.

• SCIEX-supplied computer and monitor with the Analyst MD software for instrument
optimization, acquisition method development, data acquisition, and processing. For
computer specifications and requirements, refer to the document: Software Installation Guide
for the Analyst MD software.
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Mass Spectrometer Overview
Figure 4-1 Front View

Item Description Primary Materials Refer To

1 Panel symbols Plastic Panel Symbols.

2 Syringe pump Paint over steel (body),
stainless steel (rails),
brass, Cu, Sn, Pb
(bearings)

Adjust the Integrated
Syringe Pump Position

3 Ion source N/A Ion Source Overview

4 Diverter valve Stainless steel Plumb the Diverter
Valve.

Panel Symbols
The following table describes the mass spectrometer status LEDs.
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Table 4-1 Panel Symbols

LED Color Name Description

Green Power Illuminated when the system is powered
up.

Green Vacuum Illuminated when the operating vacuum
level has been achieved. Flashing if the
vacuum is not at the correct level, that is,
during pump down and venting.

Green Ready Illuminated when the system is in the
Ready state. The system must be in the
Ready state to operate.

Blue Scanning Flashing when the system is acquiring
data.

Red Fault Illuminated when the system encounters
a system fault.

After the system is turned on, all of the LEDs illuminate. The power LED remains illuminated.
The other LEDs flash for two seconds and then turn off. The vacuum LED starts flashing. After
the operating vacuum level is achieved, this LED remains illuminated.

Connections
The following figure shows the location of the mass spectrometer connections, including the
locations of the RESET and VENT buttons and the mass spectrometer convenience switch.

WARNING! Personal Injury Hazard: Exercise caution when working with
pressurized gas lines. Failure to do so could result in personal injury.
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Figure 4-2 Back and Side Views

Item Description Primary Materials For More Information

1 Roughing pump vacuum
connection

Aluminum (hose fitting),
zinc-plated steel (hose
clamp)

Contact an FSE. This
connection is not user
serviceable.

2 Air supply (Gas 1/Gas 2) Plastic Refer to the Site
Planning Guide.

3 Source exhaust supply Plastic Refer to Source
Exhaust System and the
document: Site Planning
Guide.

4 Source communication
connection

Aluminum Contact an FSE.

5 RESET button Plastic Refer to the section:
Reset the Mass
Spectrometer.
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Item Description Primary Materials For More Information

6 Mains supply connection Aluminum/plastic Refer to the section:
Start Up the System or
Shut Down and Vent the
System.

7 Mass spectrometer
convenience switch

• Up = On

• Down = Off

Plastic Refer to the section:
Start Up the System or
Shut Down and Vent the
System.

8 Aux I/O connection Sheet metal (zinc-
plated)

Refer to the document:
Peripheral Devices
Setup Guide.

9 Ethernet connection,
connects the mass
spectrometer and the
computer

Sheet metal (zinc-
plated)

Contact an FSE.

10 VENT button Plastic Refer to the section:
Start Up the System or
Shut Down and Vent the
System.

11 Source exhaust waste,
to the source exhaust
drain bottle

Stainless steel Refer to the document:
Site Planning Guide.

12 Nitrogen gas supply
(Curtain Gas™ supply,
CAD gas)

Stainless steel Refer to the document:
Site Planning Guide.

Ion Source Overview
The Turbo V ion source can be used for either electrospray ionization (ESI) or atmospheric
pressure chemical ionization (APCI).

The TurboIonSpray probe is used for ESI mode operation. The APCI probe is used for APCI
mode operation.
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Ion Source Components

Figure 4-3 Ion Source Components

Item Description Primary Materials

1 Sample tubing from a sample supply device Red PEEK

2 Electrode adjustment nut Polyoxymethylene

3 Retaining ring PEEK

4 Probe tower Stainless steel

5 Corona discharge needle adjustment screw PEEK
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Item Description Primary Materials

6 Micrometer used to position the probe on
the horizontal axis for ion source sensitivity
adjustments

Glass

7 Window port Stainless steel

8 One of two source latches that secure the ion
source to the mass spectrometer

Stainless steel

9 Grounding union, located under the ion source
cover.

Stainless steel

10 Micrometer used to position the probe on
the vertical axis for ion source sensitivity
adjustments

Polyoxymethylene

Probes
The TurboIonSpray and APCI probes provide a range of capability for testing samples. Select
the probe and method most suitable for the compounds in the sample.

Table 4-2 Ion Source Specifications

Specification TurboIonSpray Probe APCI Probe

Temperature range From ambient temperature to
750 °C, depending on liquid
flow

From ambient temperature to
750 °C, depending on liquid
flow

Liquid flow inlet 5 µL/min to 3,000 µL/min 200 µL/min to 3,000 µL/min

Ion source gas 1 / ion source
gas 2

Refer to the mass spectrometer document: Site Planning
Guide

The software for the mass spectrometer identifies the installed probe and enables the
corresponding user controls. All of the data acquired using the ion source is identified with an
abbreviation representing the probe used to acquire the data (TIS for the TurboIonSpray probe
and HN for the APCI probe).

TurboIonSpray Probe

The TurboIonSpray probe consists of 300 μm outer diameter (o.d.) (0.012 inch) stainless steel
tubing. It is located centrally with the two turbo heaters placed at a 45 degree angle to each
side. Samples introduced through the TurboIonSpray probe are ionized within the tubing, by the
application of high voltage (IonSpray Voltage). Then they are nebulized by a jet of hot, dry,
Zero-grade air from the turbo heaters, creating a mist of small, highly-charged droplets. The
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combination of the ion source effluent and the heated dry gas from the turbo sprayer is projected
at a 90 degree angle to the ion path. Refer to the section: Theory of Operation — Ion Source.

WARNING! Puncture Hazard. Be careful when handling the electrode. The tips of
the electrodes are extremely sharp.

Figure 4-4 Parts of the TurboIonSpray Probe

Item Description

1 Electrode adjustment nut (black collar) that adjusts the extension of the
electrode tip

2 Retaining ring that fastens the probe to the probe tower on the ion source
housing

3 Electrode tip through which samples are sprayed in the sample inlet area of
the ion source

APCI Probe

The APCI probe consists of 100 μm inner diameter (i.d.) (0.004 inch) stainless steel tubing
surrounded by a flow of nebulizer gas (Gas 1). The liquid sample stream is pumped through
the sprayer, where it is nebulized in a ceramic tube containing a heater. The inner wall of the
ceramic tube can be maintained at a temperature range of 100 °C to 750 °C and is monitored by
the sensor embedded in the heater.

A high-velocity jet of nebulizer gas flows around the electrode tip to disperse the sample as a
mist of fine particles. It moves through the ceramic vaporization heater to the reaction region
of the ion source and then past the corona discharge needle where the sample molecules are
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ionized as they pass through the ion source housing. Refer to the section: Theory of Operation
— Ion Source.

WARNING! Puncture Hazard. Be careful when handling the electrode. The tips of
the electrodes are extremely sharp.

Figure 4-5 Parts of the APCI Probe

Item Description

1 Electrode adjustment nut (black collar) that adjusts the extension of the
electrode tip

2 Retaining ring that secures the probe in the probe tower

3 Electrode tip through which samples are sprayed in the sample inlet area of
the ion source

Gas and Electrical Connections
Gas and low- and high-voltage electrical connections are provided on the front plate of the
vacuum interface and they connect internally through the ion source housing. When the ion
source is installed on the mass spectrometer, all of the electrical and gas connections are
complete.

Ion Source Sense Circuit
An ion source sense circuit disables the high-voltage power supply for the mass spectrometer
and the source exhaust system under these conditions:

• The ion source is not installed or is improperly installed.

• A probe is not installed.
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• The mass spectrometer senses a gas fault.

• A turbo heater has failed.

• The ion source has overheated.

Source Exhaust System

WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical Hazard.
Make sure that the source exhaust system is connected and functioning,
to safely remove sample vapor exhaust from the laboratory environment.
Emissions from the equipment must be exhausted in the general building
exhaust and not allowed to exhaust in the workspace of the laboratory. For
requirements for the source exhaust system, refer to the document: Site
Planning Guide.

WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical
Hazard. Vent the source exhaust system to either a dedicated
laboratory fume hood or an external ventilation system to prevent
hazardous vapors from being released in the laboratory environment.

WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical
Hazard. If an LC system is used with the mass spectrometer, and if the
source exhaust system is not functioning properly, then shut down the
LC system until functionality of the source exhaust system has been
restored.

WARNING! Fire Hazard. Do not direct more than 3 mL/min of flammable solvent
in the ion source. Although the LC components can provide a flow rate of up to
5 mL/min, exceeding the maximum flow rate can cause solvent to accumulate in
the ion source. Do not use the ion source if the source exhaust system is not
enabled and functioning when the ion source and the probe are properly installed.

Note: Make sure that all of the exhaust tubing is securely connected to reduce the chance of
equipment exhaust entering the room.

An ion source produces both sample and solvent vapors. These vapors are a potential hazard to
the laboratory environment. The source exhaust system is designed to safely remove and allow
for the appropriate handling of the sample and solvent vapors. When the ion source is installed,
the mass spectrometer does not operate unless the source exhaust system is operating.

A vacuum switch installed in the source exhaust sense circuit measures the vacuum in the
source. If the vacuum in the source rises above the set point while the probe is installed, then
the system enters an exhaust fault, that is, Not Ready, state.
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An active exhaust system removes ion source exhaust, including gases, solvent, and sample
vapor, through a drain port, without introducing chemical noise. The drain port connects through
a drain chamber and a source exhaust pump to a drain bottle, and from there to a customer-
supplied exhaust ventilation system. For information about the ventilation requirements for the
source exhaust system, refer to the document: Site Planning Guide.

Note: Examine the source exhaust system periodically to make sure that the exhaust tubing is
intact and that exhaust is not leaking in the room.

Analyst MD Software Overview
The Analyst MD software works with the mass spectrometer and the liquid chromatography (LC)
system and the associated firmware to control the system and data acquisition. During system
operation, the acquired data is sent to the Analyst MD software, where it can be shown as full
mass spectra, intensity of single or multiple ions over time, or total ion count over time.

Different Data Views

MS Parameters
The working parameters are the set of mass spectrometer (MS) parameters currently being
used.

The compound parameters and source and gas parameters are stored with the method.
The resolution and detector parameters are mass spectrometer-dependent and are stored
as instrument data. If the Tune and Calibrate mode is used to create a method, then the
working parameters can be optimized for best instrument performance. Alternatively, ramp each
parameter, one at a time, while cycling the experiment.

• Source and gas parameters: These parameters can change depending on the ion source
used.

• Compound parameters: These parameters consist mostly of voltages in the ion path.
Optimal values for compound-dependent parameters vary depending on the compound being
analyzed.

• Resolution parameters: These parameters affect the resolution and calibration.

• Detector parameters: These parameters affect the detector.
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Figure 4-6 Ion Optics Path and Parameters

Location Parameter Parameter
Type

Use Scan Type

1 IonSpray
Voltage (IS)

Source and
gas

The IS parameter controls the voltage
applied to the electrode in the ESI
probe that ionizes the sample in the ion
source. The parameter depends on the
polarity and it affects the spray stability
and the sensitivity. The parameter can
be compound-dependent and must be
optimized for each compound.

All

1 Nebulizer
Current
(NC)

Source and
gas

The NC parameter controls the current
applied to the corona discharge needle
in the APCI probe. The discharge
ionizes solvent molecules, which in turn
ionize the sample molecules.

All

1 Ion Source
Gas 1
(GS1)

Source and
gas

The GS1 parameter controls the
nebulizer gas for both the ESI and
APCI probes.

All

1 Ion Source
Gas 2
(GS2)

Source and
gas

The GS2 parameter controls the heater
gas for the ESI probe.

All

1 Temperatur
e (TEM)

Source and
gas

The TEM parameter controls the
temperature of the heater gas for the
ESI and APCI probes.

All
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Location Parameter Parameter
Type

Use Scan Type

1 Curtain Gas
(CUR)

Source and
gas

The CUR parameter controls the flow of
the gas for the Curtain Gas interface.
The Curtain Gas interface is located
between the curtain plate and the
orifice. It prevents the contamination of
the ion optics.

All

1 Declusterin
g Potential
(DP)

Compound The DP parameter controls the voltage
on the orifice, which controls the ability
to decluster ions between the orifice
and the QJet ion guide. It is used
to minimize the solvent clusters that
might remain on the sample ions
after they enter the vacuum chamber,
and, if required, to fragment ions.
The higher the voltage, the higher the
energy imparted to the ions. If the DP
parameter is too high, then unwanted
fragmentation might occur.

Use the preset value and optimize for
the compound.

All

2 Entrance
Potential
(EP)

Compound The EP parameter controls the potential
difference between the voltage on Q0
and ground. The entrance potential
guides and focuses the ions through
the high-pressure in the Q0 region.

Use the preset value.

All
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Location Parameter Parameter
Type

Use Scan Type

2 Q0
Trapping

Compound The Q0 trapping parameter controls the
storage of ions in the Q0 region. It is
used to increase sensitivity and duty
cycle by trapping ions in the Q0 region
while ions are being mass-selectively
ejected from the linear ion trap. Use a
fixed fill time with this parameter.

Either select or clear the feature as
required by the experiment.

We recommend using a fixed fill time of
20 ms or greater.

EMS, EPI,
ER, and
MS/MS/MS

3 CAD Gas Source and
gas

The CAD Gas parameter controls the
pressure of the CAD gas in the collision
cell during Q3, MS/MS, and LIT scans.
For Q3 scans, the collision gas helps
to focus the ions as they pass through
the Q2 collision cell. The preset value
for the CAD Gas parameter is in Fixed
mode. For MS/MS scan types, the CAD
gas helps to fragment the precursor
ions. When the precursor ions collide
with the collision gas, they dissociate to
form product ions. For LIT scan types,
the collision gas helps to focus and trap
ions in the linear ion trap.

Use the preset value and optimize for
the compound.

Q3 MI, Q3
MS, MRM,
Prec, NL,
EMS, ER,
EPI, and
MS/MS/MS

Principles of Operation

SCIEX 4500MD Systems
54/313

System User Guide
IVD-IDV-05-6996-D



Location Parameter Parameter
Type

Use Scan Type

3 Collision
Energy
(CE)

Compound The CE parameter controls the
potential difference between the Q0
region and the Q2 collision cell. It is
used only in MS/MS scan types. This
parameter is the amount of energy that
the precursor ions receive as they are
accelerated in the Q2 collision cell,
where they collide with gas molecules
and fragment.

Use the preset value and optimize for
the compound.

EPI,
MS/MS/MS,
MRM, MS2,
Prec, NL,
and LIT

3 Collision
Energy
Spread
(CES)

Compound The CES parameter, in conjunction
with the CE parameter, determines
which three discrete collision energies
are applied to the precursor mass in
an Enhanced Product Ion (EPI) or
MS/MS/MS (MS3) scan when CES is
used. When a collision energy spread
value is entered, CES is automatically
turned on.

Use the preset value and optimize for
the compound.

EPI and
MS/MS/MS

3 Collision
Cell Exit
Potential
(CXP)

Compound The CXP parameter is only used
in Q3 and MS/MS scan types. This
parameter transmits the ions in the Q3
quadrupole.

Use the preset value and optimize for
the compound.

Q3, MRM,
MS2, Prec,
NL

4 Q3 Entry
Barrier

Compound The Q3 Entry Barrier parameter is used
to transfer the ions from the Q2 collision
cell in the linear ion trap.

Use the preset value.

EMS, EPI,
ER, and
MS/MS/MS
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Location Parameter Parameter
Type

Use Scan Type

5 MS/MS/MS
Fragmentati
on
Excitation
Time

Compound The MS/MS/MS Fragmentation Time
parameter controls the amount of time
that the excitation energy is applied.
It is used in combination with the
excitation energy to fragment the
isolated second precursor ion.

Use the preset value.

MS/MS/MS

6 Fixed LIT
Fill Time

Compound The Fixed LIT Fill Time parameter
controls the amount of time that the LIT
fills with ions.

Use the preset value and adjust it to
achieve the desired signal response
based on sample concentration.

EMS, EPI,
ER, and
MS/MS/MS

6 Dynamic Fill
Time (DFT)

Compound The DFT parameter dynamically
calculates the amount of time that
ions are collected in the linear ion
trap based on the incoming ion signal.
When DFT is turned on, the signal is
optimized to either increase sensitivity
or minimize space-charging.

Either select or clear the feature based
on the experiment.

In the Tools > Settings > Method
Options dialog, the DFT settings are
optimized for the default scan rate.
These settings are also suitable for
other LIT scan speeds.

EMS, EPI,
ER, and
MS/MS/MS

7 CEM Detector The CEM parameter controls the
voltage applied to the detector. The
voltage controls the detector response.

All
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Theory of Operation
Mass spectrometry measures the mass-to-charge ratio of ions to identify unknown compounds,
to quantify known compounds, and to provide information about the structural and chemical
properties of molecules.

The mass spectrometer has a series of quadrupole filters that transmit ions according to their
mass-to-charge ratio (m/z). The first quadrupole in this series is the QJet ion guide, located
between the orifice plate and the Q0 region. The QJet ion guide does not filter ions, but focuses
them before they enter the Q0 region. The QJet ion guide helps to focus ions into the Q0 region.
In the Q0 region, the ions are again focused before they enter the Q1 quadrupole.

Figure 4-7 Ion Path

Item Description

1 Curtain plate and orifice plate

2 QJet ion guide

3 Q0 region

4 Q1 quadrupole

5 Q2 collision cell

6 Q3 quadrupole

7 Detector

The Q1 quadrupole is a filtering quadrupole that sorts the ions before they enter the Q2 collision
cell. In the Q2 collision cell the internal energy of an ion is increased through collisions with gas
molecules until the molecular bonds break, creating product ions. This technique allows users
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to design experiments that measure the m/z of product ions to determine the composition of the
parent ions.

After passing through the Q2 collision cell, the ions enter the Q3 quadrupole for additional
filtering. Then they enter the detector. In the detector, the ions create a current that is converted
into a voltage pulse. The voltage pulses leaving the detector are directly proportional to the
quantity of ions entering the detector. The system monitors these voltage pulses and then
converts the information into a signal. The signal represents the ion intensity for a particular m/z
value and the system shows this information as a mass spectrum.

The linear ion trap (LIT) functionality provides a number of Enhanced modes of operation. A
common factor of the Enhanced modes is that ions are trapped in the Q3 quadrupole region
and then scanned out to produce full spectrum data. Many spectra are rapidly collected in a
short period of time and are significantly more intense than spectra collected in a comparable
standard quadrupole mode of operation.

During the collection phase, ions pass through the Q2 collision cell where the CAD gas focuses
the ions into the Q3 region. The Q3 quadrupole is operated with only the main RF voltage
applied. Ions are prevented from passing through the Q3 quadrupole and are reflected back by
an exit lens to which a DC barrier voltage is applied. After the fill time elapses, a time defined
by the user, or determined by the Dynamic Fill Time feature, a DC barrier voltage is applied to
the Q3 entrance lens (IQ3). This voltage confines the collected ions in the Q3 region and stops
additional ions from entering. The entrance and exit lens DC voltage barriers and the RF voltage
applied to the quadrupole rods confine the ions within the Q3 region.

During the scan out phase, the voltage on the exit lens and the auxiliary RF voltage are ramped
simultaneously with the main RF voltage for increased resolution and sensitivity as compared to
quadrupole scan types. An auxiliary AC frequency is applied to the Q3 quadrupole. The main
RF voltage amplitude is ramped from low to high values, which sequentially brings masses into
resonance with the auxiliary AC frequency. When ions are brought into resonance with the AC
frequency, they acquire enough axial velocity to overcome the exit lens barrier and are axially
ejected towards the mass spectrometer ion detector. Full spectra data can be acquired from the
ions collected in the Q3 region by rapidly scanning the main RF voltage.

ESI Mode
ESI produces gas phase ions of analytes in a sample by applying a high voltage to the sample
effluent flowing through a needle. With the aid of heated gas flow, ESI produces singly and
multiply charged ions in a relatively mild condition so that it is suitable for a wide range of
compounds including small molecules, such as drugs or pesticides, and larger molecules,
such as peptides, proteins, and other biopolymers. The sensitivity depends on the chemical
properties of the analyte, the gas flow rate, the temperature, the voltage, and the mobile phase
composition.

Principles of Operation

SCIEX 4500MD Systems
58/313

System User Guide
IVD-IDV-05-6996-D



The ESI technique is mild enough to be used with labile compounds, such as peptides, proteins,
and thermally labile pharmaceuticals. It functions with flow rates from 5 µL/min to 3,000 µL/min
and it vaporizes 100% aqueous to 100% organic solvents.

Refer to the section: Electrospray Ionization Mode.

APCI Mode
The APCI mode is suitable for:

• Ionization of compounds that do not readily form ions in solution. These are usually non-polar
compounds.

• Creation of simple APCI spectra for LC-MS/MS experiments.

• High-throughput analyses of complex and dirty samples. It is less sensitive to ion suppression
effects.

• Rapid sample introduction by flow injection with or without an LC column.

The APCI technique can be used for volatile and thermally labile compounds with minimal
thermal decomposition. The rapid desolvation and vaporization of the droplets and entrained
analyte minimizes thermal decomposition and preserves molecular identity for ionization by the
corona discharge needle. Buffers are readily tolerated by the ion source without significant
contamination and the flash vaporization of the sprayed effluent allows up to 100% water to be
used. The probe can accept the entire effluent, without splitting, at flow rates from 200 µL/min to
3,000 µL/min, through a wide-bore column.

Refer to the section: APCI Mode.

Data Handling
Reporter Software

The Analyst MD software is responsible for data acquisition and processing and does not make
any clinical decisions. The Reporter software extends the reporting functionality available in the
Analyst MD software. The Reporter software can be used to create custom reports.

MultiQuant MD Software

The MultiQuant MD software is quantitative data processing software that enables the
processing of multiple analytes and samples at the same time. It is co-installed with the
Analyst MD software. The MultiQuant MD software does not make any clinical decisions. The
reporting functionality is available in the MultiQuant MD software and it can be used to create
custom reports.

Cliquid MD Software
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The Cliquid MD software provides users with an easy-to-use mass spectrometry workflow, and
works in conjunction with the Analyst MD software. The Cliquid MD software does not control
the mass spectrometer and it does not process data directly. Rather, it interacts directly with
the Analyst MD software to interact with the mass spectrometer during data acquisition, process
acquired data, and perform peak review. The Cliquid MD software does not make any clinical
decisions.

Theory of Operation—Software
This section describes concepts used in the software.

Analyst MD Software Window
Figure 4-8 Analyst MD Software Window
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Item Description

1 Navigation bar: The Navigation bar gives access to the various software
modes. Users can customize some elements of the Navigation bar to suit
their preferences. For example, users can resize it, move it, or fix it in place.
To hide the Navigation bar, click the × in the top right corner. To view the
Navigation bar, click View > Navigation Bar.

The top level of the navigation tree has an icon that represents each
software mode. Double-click the icon for a particular mode to expand
or collapse the tree. This shows or hides the icons for the available
functionality within the selected mode.

2 Menu bar: Changes depending on the mode. Some options, such as Cut,
Copy, and Paste, are the same in every mode. Other options are specific to
certain modes and are unavailable in other modes.

3 Mode list: Click to change modes. Different modes have different toolbar
icons available.

4 Project list: Click to change the project in which data is saved.

5 Instrument and peripheral device status: The Status bar contains
information about current activities. It depicts the state of the instrument by
color: green (Ready), yellow (Idle), red (Error), or white (no local instrument
workstation). An icon indicates the status of a remote instrument. Double-
click an icon to open the device status window.

6 Companion Software: Contains any installed companion software that is
opened from the software.

Analyst MD Software Modes
The software is divided into modes, which are discrete functional areas where users can perform
a range of activities related to a main task. Users can access modes through the Navigation bar
or the Mode list in the toolbar and can switch from one mode to another without losing any work.

Table 4-3 Modes in the Analyst MD software

Name Description

Configure Use this mode to configure devices and system settings. Set various options
and parameters for the software, including hardware configuration and report
template settings.
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Table 4-3 Modes in the Analyst MD software (continued)

Name Description

Tune and
Calibrate

Use this mode to set options for tuning the instruments to ensure optimal
results. In this mode, users can:

• Perform instrument optimization.

• Perform manual tuning.

• Change the appearance of graphical views, select the types of information
that are shown when file information is opened, and set linking options and
other appearance options.

• Change processing options.

Acquire Use this mode to set options to decide how samples should be acquired. In this
mode, users can:

• Create an IDA acquisition method with the IDA Method Wizard.

• Create an acquisition method with the Acquisition Method Editor.

• Create a batch with the Batch Editor.

• View the queue with Queue Manager.

• Monitor the acquisition status.

Explore Use this mode to perform qualitative analysis on samples. In this mode, users
can:

• View a graph.

• View a chromatogram.

• View a spectrum.

• Show data in real time during batch acquisition.

Quantitate Use this mode to analyze the acquired data and build a quantitative method
to generate a Results Table. Use the Results Table to manually review all of
the peaks for each analyte and internal standard within a batch and to view
calibration curves, sample statistics, and metric plots.

Quantitative Analysis
Quantitative analysis is used to find the concentration of a specific substance in a sample. By
analyzing an unknown sample and comparing it to standard samples, that is, samples containing
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the same substance with known concentrations, the software can calculate the concentration
of the unknown sample. The process involves creating a calibration curve using the signal
response or response ratio of the standards and then calculating the concentrations of the
unknown samples. The calculated concentrations of all of the samples are added to a Results
Table.

Quantitative analysis is most commonly performed using a Multiple Reactions Monitoring (MRM)
scan. In an MRM scan, a precursor ion and a characteristic product ion are used to define
an MRM transition that is highly specific to the analyte. The MRM transition, coupled with the
retention time associated with the analyte during liquid chromatography, provides the specificity
required for quantitation.

Quantitation is accomplished through the use of validated MRM LC-MS/MS acquisition methods,
acquisition of calibration standard curves, and the subsequent integration of the peaks
associated with the compounds of interest. The calibration curve relationship between signal
response and concentration is used to determine the quantity of a particular analyte in an
unknown sample.

Integration
In LC-MS/MS data, integration refers to obtaining the area under a curve for the peak associated
with a specific compound. Using a method that specifies the transitions, expected retention
times, internal standards, integration, and regression parameters, the software is able to
automatically integrate peaks for a given set of samples.

Results Tables
Results Tables summarize the calculated concentration of an analyte in each unknown sample,
based on the calibration curve. Results Tables also include the calibration curves as well as
statistics for the results. The user can customize the Results Tables and view the Results Tables
in layouts.

The data from a Results Table can be exported to a txt file for use in other applications, such as
Microsoft Excel. The user can also export data in the table or just the data in the visible columns.

We recommend that users do not rename data files after Results Tables are created.

For information on using the Results Table right-click menu, refer to the section: Results Table.

Calibration Curves
A calibration curve, also know as a standard concentration curve, is a method for determining
the concentration of a substance in an unknown sample by comparing the unknown sample to
a set of standard samples of known concentration. The calibration curve is a plot of how the
instrument responds (the analytical signal) to changes in the concentration of the analyte (the
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substance to be measured). The operator prepares a series of standards across a range of
concentrations near the expected concentration of the analyte in the unknown sample.

Calibration standards are used to build calibration curves. Incorrect readings or missing readings
on some of the calibration samples might indicate issues with the analytical run. Follow
acceptable methods found in literature and regulatory agency guidances to create a calibration
curve. Examples of good practices in the preparation of calibration curves include:

• Preparing calibration standards in a blank matrix in which the analyte is to be measured.

• Generating a calibration curve for each analyte to be measured.

• Making sure of the coverage of the expected concentration range of the analyte, including
typical and atypical specimens.

• Using six to eight standards to generate the curve.

This is not a comprehensive list and other guidances should be used in determining the best
practice in developing a calibration curve for the laboratory.

Note: In some analytical runs, single-point calibration standards are used. Single-point
calibrations are performed using a matrix blank sample and a single standard concentration. The
relationship between instrument response and analyte concentration is determined by the line
created by these two points. Both the acquisition and quantitation methods should be validated
before being accepted for their intended use.

Regression Types
• Linear (y = mx + b)

• Linear through Zero (y = mx)

• Quadratic (y = a2 + bx + c)
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Performance Characteristics and
Specifications 5
This section includes characteristics and specifications for the SCIEX Triple Quad 4500MD
LC-MS/MS system and the QTRAP 4500MD LC-MS/MS system .

Mass Spectrometer Specifications
Table 5-1 Mass Spectrometer and Roughing Pump Specifications

Sensitivity (MRM mode) Reserpine 200 fg on column S/N greater than 2000

CV less than 5%

Maximum scan speed 12,000 Da/sec

Maximum linear ion trap scan
speed (QTRAP systems only)

20,000 Da/sec

Polarity switching 50 msec in Scheduled MRM mode and a minimum of 50 msec
in MRM mode

Minimum MRM dwell time 1 msec

Mass range (m/z) 5 Da to 2000 Da

Linear ion trap mass range
(m/z) (QTRAP systems only)

50 Da to 2000 Da

Cross talk for reserpine
609/195

Less than 0.5% cross talk is detectable with a 2 msec dwell
time and a 3 msec inter-MRM pause time

Mass stability
(Mass stability evaluated
using Q1 scan and Product
Ion scan, at a scan rate of 10
Da/sec.)

0.1 Da over 24 hours
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Table 5-1 Mass Spectrometer and Roughing Pump Specifications (continued)

Scan types Full scan MS and selected ion MS for both Q1 and Q3,
product ion scan, precursor ion scan, neutral loss or gain scan,
multiple reaction monitoring (MRM) scan, and scheduled MRM
scan types. For QTRAP systems only, enhanced MS scan,
enhanced product ion scan, enhanced resolution scan, and
MS3 scan.

Dynamic range Four orders of magnitude

Weight

Stackable—max weight on top
of mass spectrometer

77.5 kg (171 lbs)

Weight—mass spectrometer 130 kg (287 lbs)

Weight—roughing pump 34 kg (75 lbs)

Dimensions

Mass spectrometer
(W × D × H)

79 cm × 79 cm × 59 cm

32 inches x 32 inches x 24 inches

Roughing pump
(W × D × H)

12 inches x 17 inches x 9 inches

Instrument bench
(W × D × H)

100 cm × 84 cm × 78 cm

Table 5-2 Probe Specifications

Parameter TurboIonSpray Probe APCI Probe

Ion source temperature range Probe temperature from
ambient temperature to 750
°C, depending on liquid flow

Probe temperature from
ambient temperature to 750
°C, depending on liquid flow

Flow rate compatibility 5 µL/min to 3 mL/min 200 μL/min to 3 mL/min

CAUTION: Potential System Damage. Do not exceed
the maximum flow rate. Doing so can cause erratic
performance or damage to the system.
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Table 5-2 Probe Specifications (continued)

Parameter TurboIonSpray Probe APCI Probe

Gas 1

Gas 2

• Zero-grade air, or contact SCIEX for gas input options.

• Delivery pressure of 100 psi (6.89 bar) to 105 psi (7.25 bar)
with flows up to 22 L/min

Refer to the document: Site Planning Guide.

Table 5-3 Electrical Specifications

Mass Spectrometer

Nominal input voltage 200 VAC to 240 VAC

Input voltage fluctuation ± 10% of nominal

Frequency 50 Hz or 60 Hz

Maximum input current 10 A

Maximum input power 1,000 VA

Roughing Pump

Nominal input voltage 200 VAC to 240 VAC

Input voltage fluctuation ±10% of nominal

Frequency 50 Hz or 60 Hz

Maximum input current 4.2 A (50 Hz), 4.7 A (60 Hz)

Maximum input power 1,420 VA (50 Hz), 1250 VA (60 Hz)

Computer

Nominal input voltage 100 VAC to 240 VAC

Input voltage fluctuation ±10% of nominal

Frequency 50 Hz or 60 Hz

Maximum input current 8 A (50 Hz), 6 A (60 Hz)

Maximum input power 460 W

Monitor

Nominal input voltage 100 VAC to 240 VAC

Frequency 50 Hz or 60 Hz
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Table 5-3 Electrical Specifications (continued)

Maximum input current 2.5 A
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Operating Instructions — Sample
Workflows 6
Table 6-1 Instrument Setup Workflow

Step To Do This Find The
Information In

What Does It Do?

1 Create a hardware
profile.

Create a
Hardware Profile

Each hardware profile must include a
mass spectrometer and other devices,
such as an LC system. Only devices
included in the active hardware profile
can be used when creating acquisition
methods.

2 Create projects to
store data.

Create Projects
and Subprojects

Using projects and subprojects
facilitates data management and
makes comparison of results easier.

3 Optimize the mass
spectrometer.

Verify Instrument
Performance

This is the process of optimizing
the resolution and mass spectrometer
parameters, and calibrating the mass
spectrometer to obtain the best
sensitivity and performance from the
system.

Table 6-2 Example Routine Analysis Workflow

Step To Do This Find The
Information In

What Does It Do?

1 Activate a
hardware profile
applicable to the
method.

Create a
Hardware Profile

Each hardware profile must include a
mass spectrometer and other devices,
such as an LC system. Only devices
included in the active hardware profile
can be used when creating acquisition
methods.

2 Create projects to
store data.

Create Projects
and Subprojects

Using projects and subprojects
facilitates data management and
makes comparison of results easier.
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Table 6-2 Example Routine Analysis Workflow (continued)

Step To Do This Find The
Information In

What Does It Do?

3 Create and submit
a batch.

Add Sets and
Samples to a
Batch and Submit
a Sample or Set of
Samples

After creating an acquisition method,
run samples by creating an acquisition
batch and submitting the batch to the
acquisition queue.

4 Equilibrate the
system.

Equilibrate the
System

Equilibrate the system prior to starting
data acquisition. A system that is not
equilibrated can result in poor data.

5 Run samples to
acquire data.

Acquire Data Running samples involves managing
the acquisition queue and monitoring
instrument and device status. To
submit samples and acquire data,
use the Queue Manager. The
Queue Manager shows queue, batch,
and sample status, and facilitates
management of samples and batches
in the queue.

6 Analyze data in
Explore mode
(optional).

Operating
Instructions —
Analyze and
Explore Data

In Explore mode, many tools are
available for viewing and processing
the acquired data. Graphs can be
customized with peak labels and
captions, contour plots can be shown,
and spectra can be saved in the
library.

• For quantitative analysis using the MultiQuant MD software follow steps 7 to 8. The
MultiQuant MD software is recommended for larger data sets.

• For quantitative analysis using the Analyst MD software follow steps 9 to 10a.

• For qualitative analysis using the Analyst MD software follow steps 9 to 10b.

7 Analyze
quantitative data
in the MultiQuant
MD software.

MultiQuant
MD Software
Reference Guide:
Chapter 7, 8, 10,
11, 12, 13, 14

Generate and use a Results Table
to manually review all of the peaks
for each analyte and internal standard
within a batch and to view calibration
curves, sample statistics, and metric
plots.
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Table 6-2 Example Routine Analysis Workflow (continued)

Step To Do This Find The
Information In

What Does It Do?

8 Create a report in
the MultiQuant MD
software.

MultiQuant
MD Software
Reference Guide:
Appendix C

Generate a report using the provided
report templates for the generated and
reviewed results.

9 Analyze qualitative
(or quantitative)
data in the
Analyst MD
software.

Operating
Instructions
— Analyze
and Process
Quantitative Data

Generate a Results Table to manually
review all of the peaks for each analyte
and internal standard within a batch.
For quantitative analysis, also review
calibration curves, sample statistics,
and metric plots.

10a Create a report
in the Reporter
software.

Generate Reports Generate a report using the provided
report templates for the generated and
reviewed results. For reports specific
to qualitative analysis, use the set of
report templates labeled with library
searching.

10b Select a library
and then create
a report using the
Reporter software.

Generate Reports Select the appropriate MS/MS spectra
library for the results and generate
a report using the provided report
templates labeled as library search for
the generated and reviewed results.
For reports specific to qualitative
analysis, use the set of report
templates labeled with library search.

Table 6-3 Example Method Developer Workflow

Step To Do This Find The
Information In

What Does It Do?

1 Create a hardware
profile.

Create a
Hardware Profile

Each hardware profile must include a
mass spectrometer and other devices,
such as an LC system. Only devices
included in the active hardware profile
can be used when creating acquisition
methods.

2 Create projects to
store data.

Create Projects
and Subprojects

Using projects and subprojects
facilitates data management and
makes comparison of results easier.
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Table 6-3 Example Method Developer Workflow (continued)

Step To Do This Find The
Information In

What Does It Do?

3 Optimize the
compound
automatically

Or

Step 4 - Optimize
the compound
manually.

Operating
Instructions
— Automatic
Optimization

The software automatically optimizes
the compound and mass spectrometer
parameters for the compounds of
interest.

4 Optimize the
compound
manually.

Manual
Compound
Optimization

The user manually optimizes the
compound and mass spectrometer
parameters for the compounds of
interest. Manual optimization provides
more experienced users with greater
control during the optimization
process.

5 Create an
acquisition
method.

Operating
Instructions
— Acquisition
Methods

To analyze samples, create an
acquisition method for the mass
spectrometer and any LC devices.
An acquisition method indicates which
peripheral devices to use, when to
use them to acquire data, and the
associated parameters.

6 Create and submit
a batch.

Add Sets and
Samples to a
Batch and Submit
a Sample or Set of
Samples

After creating an acquisition method,
run samples by creating an acquisition
batch and submitting the batch to the
acquisition queue.

7 Equilibrate the
system.

Equilibrate the
System

Equilibrate the system prior to starting
data acquisition. A system that is not
equilibrated can result in poor data.
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Table 6-3 Example Method Developer Workflow (continued)

Step To Do This Find The
Information In

What Does It Do?

8 Run samples to
acquire data.

Acquire Data Running samples involves managing
the acquisition queue and monitoring
instrument and device status. To
submit samples and acquire data,
use the Queue Manager. The
Queue Manager shows queue, batch,
and sample status, and facilitates
management of samples and batches
in the queue.

9 Analyze data in
Explore mode
(optional).

Operating
Instructions —
Analyze and
Explore Data

In Explore mode, many tools are
available for viewing and processing
the acquired data. Graphs can be
customized with peak labels and
captions, contour plots can be shown,
and spectra can be saved in the
library.

• For quantitative analysis using the MultiQuant MD software follow steps 10 to 12. The
MultiQuant MD software is recommended for larger data sets.

• For quantitative analysis using the Analyst MD software follow steps 13 to 15.

• For qualitative analysis, contact Support.

• For qualitative analysis using the Analyst MD software follow steps 14 to 15. For general
guidance, contact support.

10 Create a
quantitative
method in the
MultiQuant MD
software.

MultiQuant
MD Software
Reference Guide:
Quantitation
Method Editor

Use the various quantitative method
creation tools in the software to
analyze the acquired data and build
a quantitative method to generate a
Results Table.

11 Analyze
quantitative data
in MultiQuant MD
software.

MultiQuant
MD Software
Reference Guide:
Chapter 7, 8, 10,
11, 12, 13, 14

Generate and use a Results Table
to manually review all of the peaks
for each analyte and internal standard
within a batch and to view calibration
curves, sample statistics, and metric
plots.
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Table 6-3 Example Method Developer Workflow (continued)

Step To Do This Find The
Information In

What Does It Do?

12 Create a report
in MultiQuant MD
software.

MultiQuant
MD Software
Reference Guide:
Appendix C

Generate a report using the provided
report templates for the generated and
reviewed results.

13 Create a
quantitative
method in the
Analyst MD
software.

MultiQuant
MD Software
Reference Guide:
Quantitation
Method Editor

Use the various quantitative method
creation tools in the software to
analyze the acquired data and build
a quantitative method to generate a
Results Table.

14 Analyze qualitative
(or quantitative)
data in
Analyst MD
software.

Operating
Instructions
— Analyze
and Process
Quantitative Data

Generate a Results Table to manually
review all of the peaks for each analyte
and internal standard within a batch.
For quantitative analysis, also review
calibration curves, sample statistics,
and metric plots.

15 Create a report
in the Analyst
Reporter.

Generate Reports Generate a report using the provided
report templates for the generated and
reviewed results. For reports specific
to qualitative analysis, use the set of
report templates labeled with library
searching.
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Operating Instructions — Mass
Spectrometer and Ion Source 7

WARNING! Personal Injury Hazard. Follow the instructions in the documentation
when using the system. The protection provided by the equipment might be
impaired if the equipment is used in a manner not specified by SCIEX.

Start Up the System
WARNING! Electrical Shock Hazard. Make sure that the system can be
disconnected from the mains supply outlet in an emergency. Do not block
the mains supply outlet.

Note: Before operating the instrument, read the safety information in the section: Operational
Precautions and Limitations.

Prerequisites

• The site requirements specified in the Site Planning Guide are met. The Site Planning
Guide includes information on the mains supply and connections, compressed air, nitrogen,
roughing pump, ventilation, exhaust, and site clearance requirements. Contact SCIEX for
a copy of the Site Planning Guide, if required. For contact information, go to sciex.com/
contact-us.

• The source exhaust gas, compressed air, and nitrogen gases are connected to the mass
spectrometer.

• The 4 L source exhaust drain bottle is connected to the exhaust waste connection on the
back of the mass spectrometer and to the laboratory ventilation system.

• The source exhaust hoses are securely clamped at the mass spectrometer, source exhaust
drain bottle, and ventilation connections.

• The mass spectrometer convenience switch is turned off and the mains supply cable is
connected to the mass spectrometer.

• The mass spectrometer and roughing pump mains supply cables are connected to the
200 VAC to 240 VAC mains supply.

• The Ethernet cable is connected to both the mass spectrometer and the computer.
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1. Turn on the roughing pump.

2. Wait five minutes, and then turn on the mass spectrometer convenience switch. Refer to the
figure: Figure 4-2.

3. Turn on the computer.

4. Open the control software.

Ion Source Optimization
WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical
Hazard. Do not use the ion source without knowledge of and training
in the proper use, containment, and evacuation of toxic or injurious
materials used with the ion source.

WARNING! Fire Hazard. Do not direct more than 3 mL/min of flammable solvent
in the ion source. Although the LC components can provide a flow rate of up to
5 mL/min, exceeding the maximum flow rate can cause solvent to accumulate in
the ion source. Do not use the ion source if the source exhaust system is not
enabled and functioning when the ion source and the probe are properly installed.

WARNING! Puncture Hazard, Ionizing Radiation Hazard, Biohazard, or
Toxic Chemical Hazard. Discontinue use of the ion source if the ion
source window is cracked or broken, and then contact a SCIEX Field
Service Employee (FSE). Any toxic or injurious materials introduced in
the equipment will be present in the source exhaust output. Exhaust from
equipment should be vented from the room. Dispose of sharps following
established laboratory safety procedures.

Optimize the ion source whenever the analyte, flow rate, or mobile phase composition changes.

When optimizing ion source-dependent parameters, introduce the sample at a flow rate that will
be used during sample analysis, using either flow injection analysis (FIA) or tee infusion as the
method of sample introduction. Optimize the position of the ion source before optimizing the ion
source-dependent parameters.

Several parameters affect the performance of the source. Optimize the performance while
injecting a known compound and monitoring the signal of the known ion. Adjust the micrometer
and gas and voltage parameters to maximize the signal-to-noise ratio and signal stability.

Refer to the section: TurboIonSpray Probe Optimization or APCI Probe Optimization.
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TurboIonSpray Probe Optimization
WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical
Hazard. Make sure that the source exhaust system is connected and
functioning, and that good general laboratory ventilation is provided.
Adequate laboratory ventilation is required to control solvent and sample
emissions, and to provide for the safe operation of the system.

WARNING! Fire Hazard. Do not direct more than 3 mL/min of flammable solvent
in the ion source. Although the LC components can provide a flow rate of up to
5 mL/min, exceeding the maximum flow rate can cause solvent to accumulate in
the ion source. Do not use the ion source if the source exhaust system is not
enabled and functioning when the ion source and the probe are properly installed.

WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical
Hazard. Make sure that the electrode protrudes beyond the tip of the
probe, to prevent hazardous vapors from escaping from the source.
The electrode must not be recessed within the probe.

CAUTION: Potential System Damage. If the LC system connected to the mass
spectrometer is not controlled by the software, then do not leave the mass spectrometer
unattended while in operation. The liquid stream from the LC system can flood the ion
source when the mass spectrometer goes in Standby state.

Note: To keep the system clean and at optimum performance, adjust the probe position when
changing the flow rate.

Tip! It is easier to optimize signal and signal-to-noise with flow injection analysis than with
on-column injections.

Note: If the IonSpray Voltage is too high, then a corona discharge can occur. A corona
discharge is visible as a blue glow at the tip of the probe. It results in decreased sensitivity
and stability of the signal.

Flow Rate and Ion Source Temperature
The sample introduction flow rate and the sample solvent composition affect the optimal
TurboIonSpray probe temperature. A higher flow rate or a higher aqueous content requires a
higher optimal temperature.

The TurboIonSpray probe is often used with sample flow rates of 5 µL/min to 1,000 µL/min. The
heat is used to increase the rate of evaporation which improves ionization efficiency, resulting
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in increased sensitivity. Extremely low flow rates of high organic solvent usually do not require
increased temperatures. Refer to the section: Source Parameters and Voltages.

The following table gives the typical ion source temperature for different flow rates. The user
must always optimize the ion source temperature for a specific application.

Table 7-1 Flow Rate and Typical Temperatures

Flow Rate (µL/min) Typical Ion Source Temperature (°C)

1 to 20 0 to 100

20 to 100 150 to 350

100 to 300 300 to 400

300 to 1000 400 to 500

Method
The liquid sample stream is delivered to the ion source by an LC pump or by a syringe pump. If
it is delivered by an LC pump, then the sample can be injected directly in the mobile phase using
flow injection analysis (FIA) or tee infusion, through a syringe pump, or through a separation
column using a loop injector or autosampler. If it is introduced by a syringe pump, then the
sample is injected directly in the ion source. Infusion optimization can only be used for ion path
optimization and MS/MS fragment selection.

Prepare the System
To create an method that is optimized for a compound, refer to the section: Manual Compound
Optimization.

1. Open the Analyst MD software.

2. On the Navigation bar, under Tune and Calibrate mode, double-click Manual Tuning.

3. Open a previously optimized method or create a method based on the compounds.

4. If the ion source has been allowed to cool, then do the following.

a. Set the ion source temperature to 450.

b. Let the ion source warm up for 30 minutes.

The 30-minute warm-up stage prevents solvent vapors from condensing in the cold probe.

5. Start the solvent flow and sample injection.

Set the Starting Conditions
1. In the Tune Method Editor, make sure that the correct Scan Type and appropriate

compound parameters are selected.
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2. Type a starting value for Ion Source Gas 1.
For LC pumps, use a value between 40 and 60 for Gas 1.

3. Type a starting value for Ion Source Gas 2 (GS2).
For LC pumps, use a value between 30 and 50 for Gas 2.

Note: Gas 2 is used with higher flow rates typical with an LC system and in conjunction with
increased temperature.

4. Type 4500 in the IonSpray Voltage (IS) field.

5. Type 20 in the Curtain Gas (CUR) field.

6. Start acquisition.

Optimize the TurboIonSpray Probe Position

WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical
Hazard. Make sure that the electrode protrudes beyond the tip of the
probe, to prevent hazardous vapors from escaping from the source.
The electrode must not be recessed within the probe.

WARNING! Puncture Hazard. Be careful when handling the electrode. The tip of the
electrode is extremely sharp.

After the probe is optimized, it needs only minor adjustment. If the probe is removed, or if the
analyte, flow rate, or solvent composition change, then repeat the optimizing procedure.

Refer to the section: Ion Source Components.

1. Look through the window of the ion source to view the position of the probe.

2. Use the previous horizontal and vertical micrometer settings or set them to 5 as a starting
position.

3. Monitor the signal or signal-to-noise of the analytes in the control software.

4. Use the horizontal micrometer to adjust the probe position in small increments to achieve
the best signal or signal-to-noise ratio.
The probe can optimize slightly to either side of the aperture.

Tip! Adjust the horizontal micrometer setting to direct the liquid spray from the
TurboIonSpray probe away from the aperture to prevent contamination of the aperture; to
prevent piercing of the flow of the gas for the Curtain Gas interface, which can create an
unstable signal; and to prevent electrical shorting due to the presence of the liquid.
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5. Use the vertical micrometer to adjust the probe position in small increments to achieve the
best signal or signal-to-noise ratio.

Note: The vertical position of the probe depends on the flow rate. At lower flow rates, the
probe should be closer to the aperture. At higher flow rates, the probe should be farther
from the aperture.

6. Adjust the black electrode adjustment nut on the probe to move the electrode tube in or out
of the probe (to adjust the protrusion).

Note: The electrode tip should protrude between 0.5 mm and 1.0 mm from the end of the
probe.

The optimal setting for the electrode tip is compound-dependent. The distance that the
electrode tip protrudes affects the shape of the spray cone, and the shape of the spray cone
affects mass spectrometer sensitivity.

Figure 7-1 Electrode Tip Extension Adjustment

Item Description

1 Probe

2 Electrode

Optimize Source and Gas Parameters and Voltage
Optimize ion source gas 1 (nebulizer gas) for the best signal stability and sensitivity. Ion source
gas 2 (heater gas) aids in the evaporation of solvent, which helps to increase the ionization of
the sample.

Too high a temperature can cause premature vaporization of the solvent at the tip of the
TurboIonSpray probe, especially if the probe protrudes too far, which results in signal instability
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and a high chemical background noise. Similarly, a high heater gas flow can produce a noisy or
unstable signal.

Note: If the IonSpray Voltage is too high, then a corona discharge can occur. A corona
discharge is visible as a blue glow at the tip of the probe. It results in decreased sensitivity
and stability of the signal.

1. Adjust ion source gas 1 and ion source gas 2 in increments of 5 to achieve the best signal
or signal-to-noise ratio.

2. Increase the flow rate of the gas for the Curtain Gas interface until the signal begins to
decrease.

Note: To prevent contamination, use the highest possible value for the flow rate of the gas
for the Curtain Gas interface that does not sacrifice sensitivity. Do not set the flow rate lower
than the values in the table: Table 7-2. This helps to prevent penetration of the flow of the
gas for the Curtain Gas interface, which can produce a noisy signal; prevent contamination
of the aperture; and increase the overall signal-to-noise ratio.

Table 7-2 CUR Parameter Values

Mass Spectrometer Starting Value

4500MD systems 20

3. Adjust the IonSpray Voltage (IS) Spray Voltage in increments of 500 V to maximize signal-
to-noise.

Optimize the Turbo Heater Temperature
The optimal heater temperature is dependent on the compound, flow rate, and mobile phase
composition. The higher the flow rate and the higher the aqueous composition, the higher the
optimized temperature.

When optimizing the source temperature, make sure that the ion source equilibrates to the new
temperature setting.

Adjust the ion source temperature in increments of 50 °C to 100 °C to achieve the best signal or
signal-to-noise ratio.
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APCI Probe Optimization
WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical
Hazard. Make sure that the source exhaust system is connected and
functioning, and that good general laboratory ventilation is provided.
Adequate laboratory ventilation is required to control solvent and sample
emissions, and to provide for the safe operation of the system.

WARNING! Fire Hazard. Do not direct more than 3 mL/min of flammable solvent
in the ion source. Although the LC components can provide a flow rate of up to
5 mL/min, exceeding the maximum flow rate can cause solvent to accumulate in
the ion source. Do not use the ion source if the source exhaust system is not
enabled and functioning when the ion source and the probe are properly installed.

WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical
Hazard. Make sure that the electrode protrudes beyond the tip of the
probe, to prevent hazardous vapors from escaping from the source.
The electrode must not be recessed within the probe.

CAUTION: Potential System Damage. If the LC system connected to the mass
spectrometer is not controlled by the software, then do not leave the mass spectrometer
unattended while in operation. The liquid stream from the LC system can flood the ion
source when the mass spectrometer goes in Standby state.

Note: The minimum flow rate supported by the APCI probe is 200 µL/min. For a complete list of
APCI probe parameters, refer to the section: APCI Probe Parameters.

Tip! It is easier to optimize signal and signal-to-noise with flow injection analysis than with
on-column injections.

Note: When using the APCI probe, make sure that the corona discharge needle is pointing
toward the aperture.

Prepare the System
To create an method that is optimized for a compound, refer to the section: Manual Compound
Optimization.

1. Open the Analyst MD software.

2. On the Navigation bar, under Tune and Calibrate mode, double-click Manual Tuning.

3. Open a previously optimized method or create a method based on the compounds.

4. If the ion source has been allowed to cool, then do the following.
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a. Set the ion source temperature to 450.

b. Let the ion source warm up for 30 minutes.

The 30-minute warm-up stage prevents solvent vapors from condensing in the cold probe.

5. Start the solvent flow and sample injection.

Set the Starting Conditions
1. In the Tune Method Editor, make sure that the correct Scan Type and appropriate

compound parameters are selected.

2. Type 30 in the Ion Source Gas 1 (GS1) field.

3. Type 20 in the Curtain Gas (CUR) field.

4. Type 1 in the Nebulizer Current (NC) field.

5. On the Compound tab, in the Declustering potential (DP) field, type 100.

6. Start acquisition.

Optimize Source and Gas Parameters
1. Adjust ion source gas 1 in increments of five to achieve the best signal or signal-to-noise

ratio.

2. Increase the flow rate of the gas for the Curtain Gas interface until the signal starts to
decrease.

Note: To prevent contamination, use the highest possible value for the flow rate of the gas
for the Curtain Gas interface that does not sacrifice sensitivity. Do not set the flow rate lower
than the values in the table: Table 7-3. This helps to prevent penetration of the flow of the
gas for the Curtain Gas interface, which can produce a noisy signal; prevent contamination
of the aperture; and increase the overall signal-to-noise ratio.

Table 7-3 CUR Parameter Values

Mass Spectrometer Starting Value

4500MD systems 20

Adjust the Position of the Corona Discharge Needle

WARNING! Electrical Shock Hazard. Follow this procedure to avoid contact
with the high voltages applied to the corona discharge needle, curtain plate,
and turbo heaters.
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Required Materials

• Insulated flat-bladed screwdriver

When using the APCI probe, make sure that the corona discharge needle is pointing toward the
aperture. When using the TurboIonSpray probe, make sure that the corona discharge needle is
pointed away from the aperture.

1. Use an insulated flat-bladed screwdriver to rotate the corona discharge needle adjustment
screw on the top of the needle.

2. Look through the glass window to make sure that the needle is aligned with the tip facing
the aperture.

Optimize the APCI Probe Position

WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical
Hazard. Make sure that the electrode protrudes beyond the tip of the
probe, to prevent hazardous vapors from escaping from the source.
The electrode must not be recessed within the probe.

WARNING! Puncture Hazard. Be careful when handling the electrode. The tip of the
electrode is extremely sharp.

Make sure that the curtain plate aperture remains clear of solvent or solvent droplets at all times.

The position of the sprayer nozzle affects sensitivity and signal stability. Adjust the probe
position in small increments only. At lower flow rates, move the probe closer to the aperture. For
higher flow rates, move the probe farther away from the aperture. After the probe is optimized,
it needs only minor adjustment. If the probe is removed, or if the analyte, flow rate, or solvent
composition changes, then repeat the optimization procedure.
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Figure 7-2 Sprayer Nozzle Position

Item Description

1 Corona discharge needle

2 Curtain plate

3 APCI probe

1. Use the previous horizontal and vertical micrometer settings or set them to 5 as a starting
position.

Note: To avoid reducing the performance of the mass spectrometer, do not spray directly in
the aperture.

2. In the control software, monitor the signal or signal-to-noise of the analytes.

3. Use the horizontal micrometer to adjust the probe in small increments to achieve the best
signal or signal-to-noise ratio.

4. Use the vertical micrometer to adjust the probe in small increments to achieve the best
signal or signal-to-noise ratio.

5. Adjust the black electrode adjustment nut on the probe to move the electrode tube in or out
of the probe (to adjust the protrusion).
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Note: The electrode tip should protrude between 0.5 mm and 1.0 mm from the end of the
probe.

The optimal setting for the electrode tip is compound-dependent. The distance that the
electrode tip protrudes affects the shape of the spray cone, and the shape of the spray cone
affects mass spectrometer sensitivity.

Figure 7-3 Electrode Tip Extension Adjustment

Item Description

1 Probe

2 Electrode

Optimize the Nebulizer Current
The ion source is controlled by current and not by voltage. Select the appropriate current for the
acquisition method, regardless of the ion source selection position.

Start with a nebulizer current value of 3 and then increase or decrease it to achieve the best
signal or signal-to-noise ratio.
The nebulizer current applied to the corona discharge needle usually optimizes between
1 µA and 5 µA in either polarity. If no changes in signal are observed when the current is
increased, then leave the current at the lowest value that provides the best signal or signal-to-
noise ratio.

Optimize the APCI Probe Temperature
The quantity and type of solvent affects the optimal APCI probe temperature. At higher flow
rates, the optimal temperature increases.

Adjust the ion source temperature in increments of 50 °C to 100 °C to achieve the best signal or
signal-to-noise ratio.
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Optimization Tips
Optimization of the ion source minimizes the need for cleaning of the ion source and vacuum
interface components.

• Use the highest temperature possible when optimizing compounds. A temperature of 700
°C is common for many compounds. High temperatures help keep the ion source clean and
reduce background noise.

• Use the highest possible value for the flow rate of the gas for the Curtain Gas interface that
does not sacrifice sensitivity. This helps to:

• Prevent penetration of the flow of gas for the Curtain Gas interface, which can produce a
noisy signal.

• Prevent contamination of the aperture.

• Increase the overall signal-to-noise ratio.

• Adjust the horizontal micrometer setting to direct the liquid spray from the probe away from
the aperture to:

• Prevent contamination of the aperture.

• Prevent piercing of the flow of gas for the Curtain Gas interface, which can create an
unstable signal.

• Prevent electrical shorting due to the presence of the liquid.

To do so, use the vertical micrometer to move the probe up.

• Use the lowest IonSpray Voltage possible without losing signal. Focus on signal-to-noise and
not just signal.

• For flow rates greater than 2 mL/min in APCI mode, equilibrate the mass spectrometer before
starting the liquid flow, to make sure that the nebulization temperature is reached.

Mass Spectrometer Calibration Procedure
Mass calibration can change over time. Verify the mass calibration regularly. At installation,
the system is mass calibrated and the resolution of the spectral peaks optimized at both unit
and high resolution, in both Positive and Negative mode, to obtain the best sensitivity and
performance of the mass spectrometer. Mass calibration makes sure that the signals originating
from the ionized compounds are recorded at their true m/z values.1 The m/z scale is calibrated
using compounds of a known purity and mass. During resolution optimization, the peak width
and peak shape are adjusted. Mass spectral resolution is represented as (m/z)/Width where

1 CLSI Standard C50–A–Vol. 27, No. 24—Mass Spectrometry in the Clinical Laboratory: General Principles and
Guidance: Approved Guideline.
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Width is the peak width of a spectral peak at a given m/z value.1 The peak width is typically
measured at the points where the intensity is half the peak height.

Note: With increasing resolution, sensitivity decreases. It is important to find a balance between
the requirements for sensitivity and resolution.

The Instrument Optimization module in the Analyst MD software is used to mass calibrate
and optimize the resolution. Verify the mass calibration and resolution weekly or after cleaning
the instrument to confirm that the system is working properly. In general, the calibration and
resolution for a triple quadrupole mass spectrometer is stable for three months to six months
unless the system loses vacuum. If the system loses vacuum, then check the calibration and
resolution before using the system. Refer to the section: Operating Instructions — Tune and
Calibrate.

CAUTION: Potential Wrong Result. Make sure that the system is calibrated. If the system
is not calibrated properly, then a mass might be identified incorrectly or quantitation
might be inaccurate.

Refer to the sections: Operational Precautions and Limitations and Calibration Ions and
Solutions.

Reset the Mass Spectrometer
1. Stop any ongoing scans and then turn off sample flow to the mass spectrometer.

2. Close the control software.

3. Press and hold the Reset button for five seconds.
A click is heard when the relay activates. After approximately three minutes, the mass
spectrometer reaches operating pressure.

Shut Down and Vent the System
Some procedures require that the system be shut down. Others require that it also be vented.
Follow these steps to shut down and, if required, vent the system.

CAUTION: Potential System Damage. Do not turn off the roughing pumps until after the
turbo pumps have spun down.

Note: If the input gas supply must be disconnected, then relieve the pressure in the gas lines
before disconnecting it.
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Tip! If the mass spectrometer will not be used for an extended period, then leave it in Standby
state with the ion source in place. If the mass spectrometer must be shut down, then follow
these instructions.

1. Complete or stop any ongoing scans.

CAUTION: Potential System Damage. Turn off the sample flow before shutting down
the system.

2. Turn off the sample flow to the system.

3. Close the software.

4. (If required) Follow these steps to vent the system:

Note: Vent the system before performing a full cleaning of the vacuum interface, before
cleaning the Q0 region, and before replacing the roughing pump oil. For more information,
contact the Qualified Maintenance Person (QMP) or FSE.

a. Press and hold the Vent button for three seconds.
The Vacuum LED begins flashing more quickly than during pump down. The turbo
pump spins down gradually.

b. Allow the system to vent for 15 minutes and then turn off the roughing pump.

5. Turn off the mass spectrometer convenience switch.

6. Disconnect the mass spectrometer mains supply cable from the mains supply outlet.

7. (If venting the system) Disconnect the roughing pump mains supply cable from the mains
supply outlet.
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Operating Instructions — Hardware
Profiles and Projects 8

Hardware Profiles
A hardware profile tells the software how the mass spectrometer and the devices are configured
and connected to the computer. Multiple hardware profiles can be configured, but only one
profile can be active at any time.

When a hardware profile is created in the Hardware Configuration Editor, the peripheral devices
must be configured so that the software can communicate with them. Configuring the peripheral
devices requires two procedures:

• Making the physical connections. For information about making the physical connections to
the devices, refer to the document: Peripheral Devices Setup Guide.

• Configuring the software to communicate with the peripheral devices. For a list of the
supported devices, refer to the Analyst MD software document: Software Installation Guide.

When the software is installed, the driver required for each peripheral device is also installed.
After the peripheral devices are physically connected to the computer, configure the appropriate
configuration information.

Each hardware profile must include a mass spectrometer. Before creating an acquisition
method, make sure that all devices to be used in the method are included in the hardware
profile. The devices configured in the active hardware profile and selected in the Add/Remove
Device Method dialog are shown as icons in the Acquisition method pane. Only peripheral
devices included in the active hardware profile can be used to create acquisition methods.

Create a Hardware Profile
The user can create multiple hardware profiles, but only one profile can be active at any time.

1. On the Navigation bar, under Configure, double-click Hardware Configuration.
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Figure 8-1 Hardware Configuration Editor Dialog

2. Click New Profile.
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Figure 8-2 Create New Hardware Profile Dialog

3. Type a name in the Profile Name field.

4. Click Add Device.
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Figure 8-3 Available Devices Dialog

In the Available Devices dialog, Mass Spectrometer is the preset value for the Device
Type field.

5. In the Devices list, select the appropriate mass spectrometer and then click OK.

6. On the Create New Hardware Profile dialog, click Setup Device.

7. (Optional) To configure mass spectrometers that use the integrated syringe pump, on the
Configuration tab, select the Use integrated syringe pump check box.
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Figure 8-4 Configuration Tab with Syringe Pump Configured

8. (Optional) To configure the mass spectrometer for the diverter valve, on the Configuration
tab, select Use integrated injector/diverter valve.

9. (Optional) Select additional features on the Configuration and Communication tabs as
required.

10. Click OK.

11. On the Create New Hardware Profile dialog, click Add Device and then add and set up
each device that is used with the mass spectrometer. Refer to the section: Add Devices to a
Hardware Profile.

12. Click OK in the Create New Hardware Profile dialog.

13. Click the hardware profile to be activated in the Hardware Configuration Editor.

14. Click Activate Profile.
The check mark turns green. If a red × is shown, then there is an issue with the hardware
profile activation.
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Tip! A hardware profile need not be deactivated before another is activated. Click
a hardware profile and then click Activate Profile. The active profile is deactivated
automatically.

15. Click Close.

Note: The current operating mode of the active hardware profile can be viewed in the
Detailed Status dialog for the instrument by double-clicking the Mass Spec icon on the
lower-right section in the Analyst MD software window.

Add Devices to a Hardware Profile
Devices must be configured to enable the software to communicate with them. When the
software is installed, the driver required for each device is also installed. Before devices can
be configured, they must be physically connected to the computer. For more information, refer to
the document: Peripheral Devices Setup Guide.

1. Open the Hardware Configuration Editor.

2. In the Hardware Profiles list, deactivate the hardware profile.

3. Click Edit Profile.

4. Click Add Device.
The Available Devices dialog opens.

5. In the Device Type list, select the device and then click OK.
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Figure 8-5 Available Devices Dialog

6. Click OK.

7. Select the device from the Devices list and then click OK.

8. Click Setup Device.
A dialog containing configuration values for the device opens.

9. (Optional) On the Communication tab, in the Alias field, type a name or other identifier for
the device.

Note: For devices using serial communication, make sure that the serial port selected
matches the serial port to which the device is physically connected.

Note: The Alias field might also be referred to as the Name box and might be found on
another tab under Alias.

• If the device uses a Serial Port as a communication interface, then in the COM Port
Number list, select the COM port to which the device is connected.

• If the device uses Ethernet as a communication interface, then type the IP Address
assigned to the device by the administrator or use the corresponding Host Name for the
address.
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• If the device uses GPIB Board as a communication interface, then do not change the
settings for the GPIB board.

The rest of the preset values for the device are probably appropriate. Do not change them.
For information about the Configuration and Communication tabs, refer to the document:
Help.

10. To restore the device preset values, on the Communication tab, click Set Defaults.

11. To save the configuration, click OK.

12. Repeat step 4 to step 11 for each device.

13. Click OK in the Create New Hardware Profile dialog.

14. To activate the hardware profile, do this:

a. In the Hardware Configuration Editor, click the hardware profile.

b. Click Activate Profile.

The check mark turns green. If a red × is shown, then there is an issue with the hardware
profile activation. For more information, refer to the section: Troubleshoot Hardware Profile
Activation.

Tip! An active hardware profile does not have to be deactivated before another one is
activated. Click an inactive hardware profile and then click Activate Profile. The other
profile is deactivated automatically.

15. Click Close.

Edit Devices in a Hardware Profile
1. Open the Hardware Configuration Editor.

2. In the Hardware Profiles list, deactivate the hardware profile.

3. Click Edit Profile.

4. Select the applicable device and then click Setup Device.
The device configuration dialog opens.

5. Edit the configuration and then click OK.

6. Click OK.

7. Click Activate Profile.
The check mark turns green. If a red x is shown, then there is an issue with the hardware
profile activation. For more information, refer to the section: Troubleshoot Hardware Profile
Activation.
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Tip! An active hardware profile does not have to be deactivated before another one is
activated. Click an inactive hardware profile and then click Activate Profile. The other
profile is deactivated automatically.

8. Click Close.

Troubleshoot Hardware Profile Activation
If a hardware profile fails to become active, then a dialog opens indicating which device in the
profile failed to activate. A device might fail to activate because of communications errors.

1. Read the error message generated. Depending on the message, there might be an issue
with a device or how the communication is set up.

2. Make sure that the device is connected to the mains supply and is turned on.

3. Make sure that the COM port or IP address assigned to the device is correct.

Tip! On computers with two built-in serial ports, the first port on the serial port expansion
card is usually COM3, even though the cable indicates P1.

4. Make sure that the communication settings for the device, for example, the dual
inline package (DIP) switch settings, are set correctly and match the settings on the
Communication tab.

5. Turn off the device.

6. Wait 10 seconds.

7. Turn on the device.
Wait until all of the device power-up activities are complete before trying to activate the
hardware profile again. Some devices might require 30 seconds or more to complete the
power-up activities.

8. Activate the hardware profile.

9. If the issue persists, then delete the failing profile and create a new one.

10. If the issue still persists, then go to sciex.com/request-support.

Projects and Subprojects
Before beginning an experiment, decide where to store the files related to the experiment. Use
projects and subprojects for each experiment to better manage data and compare results. For
example, use subprojects to store the results for specific dates.

Operating Instructions — Hardware Profiles and Projects

SCIEX 4500MD Systems
98/313

System User Guide
IVD-IDV-05-6996-D

https://sciex.com/request-support


About Subprojects
A subproject contains a subset of the folders in the project. All subprojects must contain the
same folders. Subprojects can be very useful for organizing data. For example, if different
laboratories are running samples of various compounds using the same acquisition method,
then subprojects can be used to store the results for each laboratory while the acquisition
method folder is stored in the project folder. The acquisition method would then be available
for use with subproject or laboratory. Alternatively, if samples are run over a period of several
weeks, then the results from each day can be stored in a separate subproject.

Figure 8-6 Example of a Project and Subproject Folder Structure
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Create Projects and Subprojects
To use a subproject structure within a project, create the subproject structure when the project is
created.

1. Click Tools > Project > Create Project.

Figure 8-7 Create New Project/Subproject Dialog

Note: A new subproject cannot be created for a project that was not originally created with a
subproject.

2. Type a project name in the Project name field.

3. (Optional) To use subprojects, do this:

a. Select the required folders and then use the arrow buttons to move them to the
Subproject folders list.

b. In the Subproject name field, type a name for the first subproject or use the existing
date.

4. (Optional) To use this project and subproject folder organization for all new projects, select
the Set configuration as default for new projects check box.
All new projects are created with this folder configuration.

5. Click OK.
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Create Subprojects
Subprojects can only be created in a project that has an existing subproject structure.

1. On the Project tool bar, from the Project list, select the project.

2. Click Tools > Project > Create Subproject.

3. In the Subproject name box, type a name for the subproject or use the existing date.

4. Click OK.

Copy Subprojects
A subproject can be copied from another project that has existing subprojects. If the copied
subprojects contain folders that also exist in the destination project folder, then the software uses
the project level folders.

1. Click Tools > Project > Copy Subproject.
The Copy Subproject dialog opens.

2. Click Browse to browse to the subproject source.

3. Click OK.

4. Select the subproject from the Source Subproject list.

5. Click Browse to browse to the subproject destination.

6. Type the name in the Target Subproject field.

7. Click OK.

8. Do one of the following:

• To copy all folders and files from the Subproject Source into the Subproject
Destination, select the Copy Contents check box.

• To copy only the folders in the same structure into the Subproject Destination, make
sure that the Copy Contents check box is cleared.

9. Click Copy.

Change Between Projects and Subprojects
On the software tool bar, from the project list, click the required project or subproject.
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Figure 8-8 Project List

The project list in this figure shows the API Instrument, Default, and Example folders.

Installed Project Folders
Three project folders are installed with the software: API Instrument, Default, and
Example.

API Instrument Folder
The API Instrument folder is unique and very important to the correct functioning of the
mass spectrometer. The API Instrument folder contains the information required for tuning and
calibrating the mass spectrometer. This information includes:

• Parameter settings files

• Reference files

• Instrument data files that contain calibration and resolution information

• Acquisition methods used during automatic tuning

The API Instrument folder also contains data files for manual tuning runs that were performed
using the Start button rather than the Acquire button. These data files are saved automatically
in the API Instrument\Tuning Cache folder and named with the date and time that they
were created. The Tuning Cache folder is automatically cleared periodically.

Default Folder
The Default folder contains folders that are present in new projects and serves as a template for
new projects.

Example Folder
The Example folder contains sample methods and data files. Users can practice working with
the Explore or Quantitate modes using the example data files. The example files are sorted into
subfolders by mass spectrometer type and application area.
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Operating Instructions — Tune and
Calibrate 9
Run the Verify instrument performance option weekly or after the mass spectrometer is
cleaned to confirm that the system is working properly. In general, for triple quadrupole systems,
calibration and resolution is maintained for three to six months unless the system loses vacuum.
For QTRAP systems, the resolution should also be maintained for three to six months but the
system should be calibrated approximately monthly. If the system loses vacuum, then check
the calibration and resolution before using the system. For more information about tuning and
calibration, refer to the documents: Advanced User Guide and Manual Tuning Tutorial.

Tip! Perform maintenance tasks regularly to make sure that the mass spectrometer is
performing optimally.

Prerequisites

• The spray is stable and the correct tuning solution is being used.

• A printer is configured.

Required Materials

• Tuning solutions that are supplied in the Standards Chemical Kit shipped with the system.
If required, a new kit can be ordered from SCIEX. Refer to the section: Calibration Ions and
Solutions.

• 5 mL, 1 mL, or 250 µL serial gas-tight syringes.

• Red PEEK sample tubing.

About Tuning and Calibrating
Tuning the instrument is the process of optimizing the resolution and instrument parameters to
attain the best sensitivity and performance of the mass spectrometer. Optimizing the resolution
means adjusting the peak width and peak shape. You can tune and calibrate the instrument
either automatically or manually.

CAUTION: Potential Calibration Error. If the temperature changes by more than 2 °C, then
the resolution and mass calibration might be affected.
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Tip! Clean the Q0 region regularly to minimize the impact of charging (a significant loss of
sensitivity of the ions of interest over a short period of time) on the quadrupoles. Contact the
Qualified Maintenance Person (QMP) or FSE.

Automatic tuning: The software performs resolution optimization and mass calibration, using
the Instrument Optimization wizard. For LIT instruments, MS3 optimizations are also performed.

Manual tuning: Many of the instrument resolution optimizations and calibrations can be
performed manually.

Back Up the API Instrument Folder
Back up the API Instrument folder regularly and after routine maintenance has been
performed.

Copy the API Instrument folder, paste it to a different location, preferably on another
computer, and then rename the folder. Use the date and a mass spectrometer reference
when naming the folder, if there is more than one mass spectrometer. For example, API
Instrument_instrument model3_010107.

Back up Instrument Parameters
1. On the Navigation bar, under Tune and Calibrate, double-click Instrument Optimization.

2. Click File > Backup Instrument Settings Files in the Instrument Optimization dialog.

3. Type a file name and then click Save.

4. Click Exit.

Restore Instrument Parameters
1. On the Navigation bar, under Tune and Calibrate, double-click Instrument Optimization.

2. Click File > Restore Instrument Settings Files in the Instrument Optimization dialog.

3. Navigate to the instrument settings that you want to restore and then click Open.

4. Click Exit.
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Automatically Tune and Calibrate
Instrument Optimization is automatic instrument tuning software that tunes both quadrupole
and LIT modes and performs mass calibration. For quadrupole mode, it adjusts the resolution
offsets. For LIT mode, it optimizes AF3 and EXB. For MS3, it adjusts the Excitation and Isolation
coefficients. Select one of the instrument performance options:

• Verify instrument performance: Tests the instrument performance but leaves the instrument
settings unchanged. A report is generated at the end of the test. You can use this option
weekly to check how well the instrument is performing.

• Adjust mass calibration only: Automatically checks and adjusts the mass calibration. If the
mass calibration has changed, then the software corrects it. This option can be used weekly
for LIT instruments, or monthly to check and adjust the mass calibration if required.

• Adjust instrument settings: Checks and adjusts the instrument settings and mass
calibration. The instrument settings are updated from the current settings to optimal settings.
Use this option if the instrument performance is poor or if the peak shape is bad. Only
experienced users should adjust the instrument settings.

Note: Old LIT methods must be updated with the new settings. Toggle the LIT speed in the
advanced MS tab and then save the method.

• Reset selected scan modes to default values and adjust instrument settings: Resets the
instrument values to the factory preset values. Select this option if a major component of the
instrument is replaced or after the first installation. Only FSEs should use this feature.

Back up the current instrument parameters in case they must be restored later.
The preset location for the instrument parameters is <drive>:\Analyst Data\Projects\API
Instrument\Instrument Optimization\Instrument Settings Backups\User Created Backups.

Verify Instrument Performance
Use this procedure to verify or adjust the performance of the mass spectrometer. For information
about using the other instrument performance options, refer to the document: Help.

Prerequisites

• The syringe pump is activated in the hardware profile. If the syringe pump is not activated,
then edit the hardware profile. Refer to the section: Add Devices to a Hardware Profile.

• The API Instrument folder is selected.

1. On the Navigation bar, under Tune and Calibrate, double-click Manual Tuning.
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2. Start the syringe pump, type 5 in the Duration field, and then run a calibration method.
Confirm that the total ion chromatogram (TIC) is stable and that the peaks of interest are
present in the spectrum.

Figure 9-1 Example of a Stable TIC and Peaks of Interest
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3. On the Navigation bar, under Tune and Calibrate, double-click Instrument Optimization.
The Instrument Optimization dialog opens.

4. Click Verify instrument performance.

5. Click Next.

6. Click Approved Tuning.

7. Click Next.

8. Select a Tuning Solution from the list.
Depending on the solution selected, different modes are available:

a. Click a polarity.

b. (If available) Click Q1 and Q3 in the Quad section.

c. (If available) Click the required scan speeds.

d. (If available) Click the scan speeds in the LIT section.

e. (If available) Click Excitation in the MS/MS/MS section

9. Click Next.

10. If the Select a mode page opens, then select Automatic.

11. Click Next.

12. Click GO.
The Verifying or Adjusting Performance dialog opens. After the process has completed, the
Results Summary opens. For more information, refer to the document: Help.

13. (If applicable, depending on the options selected) When prompted, change solutions for
different scan types and polarities.

Verifying or Adjusting Performance Dialog
The top left corner shows the part of the instrument that is being tuned.

The Current Spectrum graph shows the spectrum of the current scan, the optimal scan selected
by the software, or the scan at the current parameter value when the software results are viewed
in interactive mode.

The Instrument Optimization Decision Plots, in the top right graph, dynamically show the
intensity-to-voltage curves of the parameters that are currently being optimized.
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Results Summary
The Results Summary is a record of any instrument settings changes that were made by the
Instrument Optimization wizard.

The Results Summary includes the location of the data and instrument settings backup files, as
well as a step-by-step record of the changes and results during optimization.

The Results Summary also includes a verification report. This report contains a snapshot of
the mass spectrum for each relevant mass for the scan modes being verified. The spectrum is
labeled with the target mass, where the mass was found, the mass shift, the peak width, and
the peak intensity. The spectrum can be used as a visual record of peak shape or scan mode
performance. A summary table of results follows the spectra.

The Results Summary is automatically saved in the following path: <drive>:\Analyst
Data\Projects\API Instrument\Data\Instrument Optimization\yyyy-mm-
dd\results.pdf, where yyyy-mm-dd is the date on which the report was created. Users can
print the Results Summary or open a previously saved Results Summary.

Recover the API Instrument Folder
Back up the API Instrument folder regularly and after routine maintenance has been
performed.

1. Rename the current API Instrument folder.

2. Copy the backup folder into the Projects folder.

3. Change the name of the backup folder to API Instrument.
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Operating Instructions — Automatic
Optimization 10
To tune instrument parameters for particular compounds the following steps are recommended.
The mixture of four compounds is used for illustrating the steps of the procedure. The user
will have to apply the same procedure while using the appropriate compounds for the assay of
interest.

This section describes how to:

• Automatically optimize for the analyte using the Compound Optimization wizard.

• Choose between infusion and flow injection analysis (FIA).

• Optimize parameters:

• If infusion analysis is chosen, then use an infusion method to optimize compound-
dependent parameters.

• If FIA analysis is chosen, then use FIA to optimize compound- and ion source-dependent
parameters.

This procedure uses minoxidil, tolbutamide, reserpine, and rescinnamine as example
compounds. Other available compounds can be used, but the methods must be adjusted
accordingly.

The user can also optimize compounds manually. Refer to the document: System User Guide for
the mass spectrometer.

Prerequisites

• The mass spectrometer is tuned and calibrated.

• (For FIA analysis) An acquisition method template is available.

• (For FIA analysis) An LC pump and an autosampler are connected and configured in the
hardware profile.

• An integrated syringe pump is configured in the hardware profile.

• All of the required peripheral devices, including the LC components, if required, are
configured in the hardware profile.
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Required Materials

• Four-compound mix (10 ng/mL), consisting of reserpine, minoxidil, tolbutamide, and
rescinnamine. The solution can be used for infusion and FIA. The concentration is system-
dependent. Use a solution that is 49.9% acetonitrile, 50% deionized water, and 0.1% formic
acid as diluent.

Note: This is an example mixture for demonstration purposes. Users will create their own
compound in a suitable solvent when developing applications. A single-compound solution
is preferred. When mixing compounds, make sure that the compounds do not interfere with
each other or have the same molecular weight.

• A syringe, preferably a 1.0 mL syringe.

• (For FIA analysis) Mobile phase: 1:1 acetonitrile:water + 2 mM ammonium acetate + 0.1%
formic acid.

Note: Users can choose a different mobile phase based on the experimental properties of
the compound.

• LC pump and autosampler.

• (For FIA Analysis) Autosampler vials.

About Automatic Optimization
Automatic optimization first checks for the presence of the compounds. The voltages of the
various ion path parameters are gradually increased or decreased to determine the maximum
signal intensity of the Q1 scan for each ion. A text file is generated and shown during the
optimization process. This file records the experiments performed and the optimum value for
each parameter. A file folder containing all of the experiments performed is also generated and
can be found by opening the data file folder in Explore mode. For each experiment performed,
an acquisition method is also generated and saved in the Acquisition Method folder.

During the optimization process, select how the precursor ion and the corresponding product
ions are to be chosen.

Types of Sample Introduction
Infusion
Infusion is the continuous flow of the sample at low flow rates into the ion source using a syringe
pump. During the infusion optimization process, the software can select precursor and product
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ions and optimize for declustering potential, collision energy, and collision cell exit potential. The
voltages of the ion path parameters are gradually increased or decreased to get the maximum
signal intensity for the precursor and product ions.

Use infusion optimization to optimize compound-dependent parameters only, at much lower flow
rates than those used during LC-MS/MS analysis.

FIA
FIA is the injection of a sample by the autosampler into the mass spectrometer using an
LC system. During the FIA optimization process, multiple sample injections are performed
for various ion source- or compound-dependent parameters that are changed between
injections. FIA compound optimization optimizes parameters by performing looped experiments
in succession. One compound-dependent parameter is optimized first, followed by the next
compound-dependent parameter. FIA optimizes for ion source-dependent parameters by making
one injection for each value.

Compound parameters must be narrowed using at least two more FIA cycles.

Use FIA optimization to optimize both compound-dependent and source-dependent parameters
using an LC system at higher flow rates.

Table 10-1 Differences Between Sample Introduction Methods

Method Required Devices Parameters Typical Flow Rate
Range

Infusion Syringe pump Compound-dependent 5 µL/min to 25 µL/min

FIA LC pump and autosampler Ion source- and compound-
dependent

25 µL/min to
1000 µL/min

During optimization, a text file is generated and then shown. This file records the experiments
performed and the optimal values for each parameter. A file folder containing all the data files
is also generated. For each experiment performed, an acquisition method is also generated and
saved in the Acquisition Methods folder.

Automatically Optimize for an Analyte Using
Infusion
Use this procedure to perform automatic MS/MS optimization using infusion with a known
precursor ion and an unknown product ion.
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Confirm the Presence of Compounds
Confirm the presence of compounds of interest before continuing with automatic optimization.

1. In the Analyst MD software, create a project.

2. Activate the hardware profile.

3. Prepare the sample:

a. Aspirate the compound solution into a syringe and remove the air from the syringe.

b. Use the tubing with the special fitting to connect the syringe to the mass spectrometer.

c. Install the syringe in the integrated syringe pump.

4. Infuse the compound in solution at a rate of 5 µL/min to 10 µL/min.

5. On the Navigation bar, under Tune and Calibrate, double-click Manual Tuning.

6. In the method list field, click Syringe Pump Method.

7. On the Syringe Pump Method Properties tab, type the appropriate parameter values. Refer
to the table: Table 10-2.

Table 10-2 Syringe Pump Method Properties Tab

Parameter Typical Value

Syringe Diameter Syringe dependent; 1.0 mL syringe is 4.610
mm

Flow Rate 5 to 10

Unit µL/min

Figure 10-1 Syringe Pump Method Properties Tab

8. Click Start Syringe Pump.

9. Click MS Method in the method list.

10. On the MS tab, type the parameters shown in the table: Table 10-3.
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Table 10-3 MS Tab

Parameter Value

Scan type Q1 MS (Q1)

Start (Da) 200

Stop (Da) 700

Scan rate (Da/s) (if available) 200

Duration (min) 3

11. Click Start.

12. Wait until an even TIC is shown on the left and peaks are shown on the right. Then click
Stop.

13. Select the MCA check box.

14. Type 10 In the Cycles field.

15. Click Start.

When the ten scans are complete, the graph shows the masses of the four compounds as
ions.

Note: The intensities of the compounds should be much higher than the smallest noise
peaks but not so high that no noise peaks are not seen. In the first case, the peak might
not be a real compound. In the second case, the concentration might be too high for the
software to optimize properly.
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Figure 10-2 Compound Ions

Perform Automatic MS and MS/MS Optimization Using
Infusion with a Known Precursor Ion and an Unknown
Product Ion
Automatic optimization for MS/MS analysis optimizes certain compound-dependent parameters
for one or more MRM transitions. The software finds the ion of interest and then optimizes
the compound-dependent parameters to get the maximum sensitivity for the compound. The
software ramps CE and then selects the most intense fragments that meet all of the product ion
selection criteria.

If the initial Q1 scan signal is too high, then the software tries to reduce the CEM to keep ions
within the detector range. If the signal is still too high after the CEM is reduced, then the process
stops and an error message is shown. Dilute the solution and then restart the optimization. Make
sure to purge the infusion line.

The parameters from the last quantitative optimization are stored.

1. Make sure that the proper concentration of solution has been installed in the syringe pump,
and that the syringe pump has been started.
The syringe pump must be started in the Manual Tune window before compound
optimization begins.
If an integrated syringe pump is available and has been started, then the Syringe Pump
Status LED flashes.
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2. On the Navigation bar, under Tune and Calibrate, double-click Compound Optimization.
The Instrument Settings page opens.

3. In the Inlet section, click Infusion.

4. Click MS/MS Analysis in the Mass Spectrometer section.

5. Click Next.
The Ions to use in MS/MS Analysis page opens.

6. Select the appropriate parameter values. Refer to the table: Table 10-4.

Table 10-4 Example Parameters to use in MS/MS Analysis Page

Parameter Value

MW Ion: Search Window 2.500

Resolution Unit

Polarity Positive or Negative, depending on the properties of the
targeted compound

Product Ion Auto Select

Resolution Unit

Note: The optimization algorithm looks for the most intense peak in the specified search
window. If the most intense peak in that window is not the mass of interest, then the
software optimizes for the wrong ion.

7. Click Criteria next to the Auto Select option.
The Product Ion Auto Selection Criteria dialog opens.

8. Type the appropriate parameter values. Refer to the table: Table 10-5.

Table 10-5 Example Product Ion Auto Selection Criteria Dialog Parameters

Parameter Value Description

From the Most
Intense (peaks)

3 The number of fragment peaks to be optimized. The
algorithm generates a product ion scan spectrum
while ramping the CE in MCA mode. In this example,
the algorithm takes the three most intense fragment
ions from the spectrum and then continues the
MS/MS optimization on those fragments only.

For unknown compounds, select more peaks.
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Table 10-5 Example Product Ion Auto Selection Criteria Dialog Parameters
(continued)

Parameter Value Description

Build final
method using
(most intense
peaks)

2 The number of fragment ions per precursor ion
(target compound) to be automatically included in
the acquisition method. The specified number defines
the number of MRM transitions to be included for
each target compound in the method. The order of
preference is based on the intensity of the fragment
ion.

Two is a better starting value than one because
typically two product ions are required for
quantitation. Start with three in case there is a issue
with one of the two best. Go back and the third is
already identified.

For unknown compounds, select more peaks for use
in case of interference.

Exclude
Product Ions
within ± (Da of
Precursor Ion
m/z)

20.000 The Da value that defines the exclusion window
around the precursor ion. Fragment ions that fall
within this window are not selected for MRM
optimization. For example, if the user types ± 5 Da
for a precursor ion that has an m/z value of 500, then
any fragment ions within an m/z value of 495 to 505
are excluded. This prevents the precursor ion from
being optimized as a product ion.

Min. Mass for
Product Ion
(Da)

60.000 The lowest fragment mass to be considered for
optimization. Use this option to increase or decrease
the size of the window that contains fragment ions to
be considered from the precursor mass.

Threshold for
Product Ion
(cps)

100.000 Minimum number of counts for a product ion to be
considered.

9. Click OK to save the changes to the selection criteria.

10. Click Next.
The Target Components dialog opens.

11. Type the appropriate parameter values. Refer to the table: Table 10-6.

Note: The compound name must be unique for each compound or transition.
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Table 10-6 Example Target Compounds Dialog Parameters

Target Compound Field Value

Reserpine Compound Name Reserpine

MW (Da)2 609.3

No. Charges 1

Minoxidil Compound Name Minoxidil

MW (Da)2 210.2

No. Charges 1

Tolbutamide Compound Name Tolbutamide

MW (Da)2 271.1

No. Charges 1

Rescinnamine (IS) Compound Name Rescinnamine

MW (Da)2 635.3

No. Charges 1

12. Click Finish to start the optimization process.

Two windows are shown, a text file window and an acquisition window. The user might need
to minimize one of them to see the other. The experiment being run is shown on the top
of the acquisition window. The X-axis shows the parameter that is being optimized for each
experiment. The text file window is updated as results are generated.

After optimization is complete, an MRM acquisition file is created and named
<compound>_QOpt_FinalMRM_Pos.dam, where <compound> is the first compound in the
Target Components page.

Review the Optimization Results
When optimization completes, the optimized parameters are saved in an acquisition method. All
dam and wiff files generated during the optimization process are saved in the Acquisition
Methods folder and in a subfolder in the Data folder, respectively, in the project. The name of
the subfolder is generated using the name of the compound and the date.

1. After completing the optimization, print the text file containing the optimized parameters for
each compound.

2. Click File > Open and then select the Reserpine_QOpt_FinalMRM.POS.dam file.

2 Type the exact ion mass.
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3. Compare the values in the text file to those in the dam file.

4. Inspect the contents of the following folders:

• Data: Review all of the runs executed during optimization. Compare a wiff file with the
optimized value in the method or printed parameters.

• Acquisition Method: Reserpine_QOpt_FinalMRM.POS.dam file and other dam files
created during optimization.

• Log: Report file (rtf) shown during the optimization process.

Automatically Optimize for an Analyte Using FIA
Prerequisites

• Identify the ions for the compounds and save the basic acquisition method.

• Add an autosampler and LC pump to the basic acquisition method. Using FIA for
optimization requires that these devices be active in the hardware profile.

• Create an LC-MS/MS acquisition method based on the
Reserpine_QOpt_FinalMRM.POS.dam file and then name the new method.

Note: Although FIA can be used to optimize compound-dependent parameters, this is typically
not done because of the number of cycles required to obtain the optimal parameter values.

1. Put a dilution of the four-compound mix in an autosampler.
Sufficient sample is required to review each variable of each parameter and have sample
left over. For example, for the temperature to run at 300 °C, 400 °C, and 500 °C, if the
injection volume is 10 µL, then more than a 30 µL (3 × 10 µL injection) is required.

2. Make sure that LC Sync is selected in the method.

Note: In LC Sync mode, the mass spectrometer coordinates with the action of the LC
system to make sure that data is acquired properly.
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Figure 10-3 Acquisition Method with LC Sync Selected

3. Make sure that the ion source and gas parameters are set to reasonable levels to prevent
the contamination of the mass spectrometer while optimizing. Refer to the section: Ion
Source Optimization.

4. Set the horizontal micrometer to 5.

5. Set the vertical micrometer on the ion source for the flow rate. As a starting point, use the
parameters in the following table.

Table 10-7 Ion Source Vertical Parameters

Flow rate Initial Vertical Parameters

1 μL/min to 20 μL/min 10 mm

20 μL/min to 250 μL/min 5 mm

250 μL/min to 500 μL/min 2 mm

500 + μL/min 0 mm

6. Set the values for the LC system and use an autosampler injection volume of 10 µL, for
example. Use the same concentration for the infusion experiment, or a lower concentration.

The LC pumps must be configured for an isocratic run with no column. The MS and LC
times must be the same to collect the proper data.

The flow rate and percent of mobile phases used should be based on the LC column used,
the general chromatography, and the approximate mobile phase concentration at which the
compounds of interest elute.

7. On the Navigation bar, under Tune and Calibrate, double-click Compound Optimization.
The Instrument Settings page opens.

8. Depending on the LC system being used, type the appropriate parameter values. Refer to
the table: Table 10-8.

Operating Instructions — Automatic Optimization

System User Guide
IVD-IDV-05-6996-D

SCIEX 4500MD Systems
119/313



Table 10-8 Example Instrument Settings Parameters

Parameter Value

Inlet FIA

Rack Code Autosampler specific

Rack Position Autosampler specific

Injection Volume 10 µL (example volume)

Mass Spectrometer MS/MS Analysis

9. Select the appropriate default acquisition method.

10. Click Next.

11. Make sure that the Int. Std. check box is cleared.
Selecting the check box indicates which MRM corresponds to the internal standards.
Internal standards are not optimized during the optimization process.

12. In the Resolution group, select Unit in both the Q1 Resolution and Q3 Resolution fields.

Figure 10-4 Q1 and Q3 Resolution Fields
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13. Click Next.

14. On the FIA Source Parameters page, type numbers that are lower or higher than the original
value, but within specifications.

Note: To keep the system clean, make sure that the values are not too low. For parameters
that can be used as a starting point, refer to the table: Table 10-9.

Tip! Type the values before selecting the check box.

Table 10-9 Example Parameters for FIA Source Parameters Page

Parameter Select the Optimize Check
Box?

Values for Optimization

Curtain Gas Yes 20;40;55

Collision Gas No —

IonSpray Voltage Yes 1500;2000;3000;4000;5000

Temperature Yes 300;400;500;600;700

Ion Source Gas 1 Yes 40;50;60;70;80;90

Ion Source Gas 2 Yes 40;50;60;70;80;90

15. Select 1 or 2 beside Replicate Injection for each Parameter.
The total number of injections and the total sample volume are calculated based on the
specifications on this dialog. Note the total sample volume needed. The sample volume
increases with the number of variables for each parameter that are being optimized,
because each variable is a separate method.
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Figure 10-5 Example Replicate Injection for each Parameter Field

16. Click Next.

17. On the FIA Compound Parameters page for each analyte, use the example parameter
values provided as a starting point. Refer to the table: Table 10-10.

Note: The values in the following table are suggested values. For more information, refer to
the document: Help.

Table 10-10 Example FIA Compound Parameters Page

Parameter Select the Optimize Check
Box?

Values for Optimization

Declustering Potential Yes 60;80;100;120;200

Entrance Potential No —

Collision Energy Yes 20;30;40;50;70;80;100

Collision Cell Exit Potential Yes 2;4;6;8;10;12
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The total number of injections and the dependent sample volume update automatically.
In contrast to ion source parameters, which require one injection per value per replicate,
compound-dependent parameters only require one injection per parameter. A looped
experiment is performed for each parameter. The values are alternated scan-by-scan within
one injection.

Note: Do not specify too many values. Doing so will prevent proper evaluation of the
parameter.

18. Using the Compound list, move to another compound and type the parameters to be
optimized.

19. Repeat step 18 until all of the parameters for all of the compounds are provided.

20. Type the duration of the optimization in the Mass Spec. Duration field.

Note: This value should be at least the required length of time for each injection.

Figure 10-6 Example Mass Spec. Duration Field

21. Click Finish to begin the optimization process.
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The software optimizes the specified ion source and compound-dependent parameters to
get the maximum sensitivity for the MRM transition of the compound. As the software
proceeds through the optimization, it creates a Compound Optimization report.

22. To get optimized parameters, repeat this routine.

Note: Typically, the ion source and gas parameters must be narrowed using one more FIA
cycle.

23. Open the final optimized FIA method called *_FIA_sample_1.

Note: The software generates several acquisition methods.

24. Save this method using a simpler name.
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Operating Instructions —
Acquisition Methods 11
An acquisition method consists of experiments and periods. Use the Acquisition Method Editor
to create a sequence of periods and experiments for the mass spectrometer and any devices in
the active hardware profile.

We recommend that only users who are proficient in method development create or modify
acquisition and quantitation methods. For more information about roles and security, refer to the
document: Laboratory Director Guide.

Create an Acquisition Method Using the
Acquisition Method Editor
Tip! If users are creating a new acquisition method file from an existing file, then some or all of
the peripheral device methods in the acquisition method might be used.

Only devices configured in the active hardware profile are shown in the Acquisition method
pane. Any devices added to the hardware profile must also be added to existing acquisition
methods. For more information about devices, refer to the document: Peripheral Devices Setup
Guide.

1. Make sure that a hardware profile containing the mass spectrometer and peripheral devices
is active.

2. On the Navigation bar, under Acquire, double-click Build Acquisition Method.

3. Select a Synchronization Mode on the Acquisition Method Properties tab.

4. (Optional) Select the Auto-Equilibration check box and then type the required equilibration
time, in minutes.

5. In the Acquisition Method pane, click the Mass Spec icon.

6. On the MS tab, select a Scan type.

7. Type values in the other fields as required.

8. On the Advanced MS tab, type values in the fields as required.

9. On the MS tab, click Edit Parameters.

10. On the Source/Gas tab, specify values in the fields as required.

Operating Instructions — Acquisition Methods

System User Guide
IVD-IDV-05-6996-D

SCIEX 4500MD Systems
125/313



11. On the Compound tab, specify values in the fields as required.

12. Click OK.

13. Click a device icon and then set the parameters for the device.

14. Add any additional periods and experiments. Refer to the sections: Add an Experiment and
Add a Period.

15. Click File > Save.

About LC Methods
Creating an acquisition method using a peripheral device, such as an LC system, includes
providing the operating parameters for that device. If a new acquisition method is created from
an existing file, some or all of the peripheral device methods can be used in the acquisition
method.

Create Mass Spectrometry Methods
Use the Acquisition Method Editor to create a mass spectrometer (MS) acquisition method.
Depending on the type of mass spectrometer configured and the scan type selected, different
fields and options are available. The Acquisition Method Editor validates the settings as the
parameters are typed.

Create one of the following methods and then use it to acquire data. Refer to the section: Create
and Submit a Batch

• Create an Acquisition Method using a Q1 MS Scan Type

• Create an Acquisition Method using a Q1 MI Scan Type

• Create an Acquisition Method using an MRM Scan Type

Create an Acquisition Method using a Q1 MS Scan Type
Use the following procedure to create a method using the Q1 MS scan. The ion intensity is
returned for every requested mass in the scan range.

Prerequisites

• Make sure that a hardware profile containing the mass spectrometer and syringe pump is
active.

• On the software toolbar, make sure that the appropriate project is selected.

1. On the Navigation bar, under Acquire, double-click Build Acquisition Method.
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The Acquistion Method Editor is shown with a method template based on the active
hardware profile.

2. In the Acquisition Method pane, click Acquisition Method.

3. On the Acquisition Method Properties tab, in the Synchronization Mode list, make sure
that No Sync is selected. For more information about synchronization modes, refer to the
document: Help.

4. In the Acquisition method pane, click the Mass Spec icon.

5. On the MS tab, in the Scan type list, select Q1 MS (Q1).

6. In the Polarity section, click Positive.

7. Clear Center/Width and Parameter Range check boxes if selected.

8. In the mass ranges table, type the values that are shown in the following table.

Figure 11-1 MS Tab Parameter Values

Table 11-1 MS Tab Parameter Values

Field Example Value

Start (Da) 200

Stop (Da) 700

Time (sec) 2.5

Scan rate (Da/s) 200

Duration (min) 3
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9. On the Advanced MS tab, note that the Scan mode is set to Profile and the Step size is
0.1.

Figure 11-2 Advanced MS tab

In this example, the quadrupole (Q1) is scanning a 500 Da range in 0.1 Da steps. Therefore,
there are 5000 steps across the mass range. If the scan takes 2.5 seconds, then the dwell
time is 0.5 ms per step. This is usually the fastest that Q1 or Q3 should be scanned in a
standard calibration procedure. Proper consideration for mass calibration should be taken if
Q1 or Q3 are to be scanned faster.

Note: The step size and the time of the scan control the dwell time per step for the scan.
The dwell time is the length of time spent acquiring signal at each step in a scan.

10. On the MS tab, click Edit Parameters.
The Parameter Table dialog opens.

11. On the Source/Gas tab, type the following values:

Table 11-2 Source/Gas Tab Parameters

Source/Gas parameters Typical value

Curtain Gas (CUR) 35

IonSpray Voltage (IS) 5000

Temperature (TEM) 0
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Table 11-2 Source/Gas Tab Parameters (continued)

Source/Gas parameters Typical value

Ion Source Gas 1 (GS1) 20

Ion Source Gas 2 (GS2) 0

12. Click the Compound tab and then set the Declustering Potential (DP) to 90 and leave the
Entrance Potential (EP) at 10.
A value of 90 might not be optimal for the mass spectrometer but it is a good DP to start
with.

13. Click OK.

14. In the Acquisition method pane, click the Harvard Syringe Pump or Integrated Syringe
Pump icon.

Figure 11-3 Harvard Syringe Pump Method Properties Tab

15. Edit the syringe pump method to include Syringe Diameter, Flow Rate, and Unit.

16. Save the acquisition method.
Next steps: Use the acquisition method to acquire data for preliminary analysis. To create
and submit batches, refer to the section: Create and Submit a Batch.

Create an Acquisition Method using a Q1 MI Scan Type
Use the following procedure to create a method using the Q1 MI scan. The ion intensity is
returned for only the specified masses.

Prerequisites

• Make sure that a hardware profile containing the mass spectrometer and syringe pump is
active.

• On the software toolbar, make sure that the appropriate project is selected.

1. On the Navigation bar, under Acquire, double-click Build Acquisition Method.
The Method Editor is shown with a method template based on the active hardware profile.

Operating Instructions — Acquisition Methods

System User Guide
IVD-IDV-05-6996-D

SCIEX 4500MD Systems
129/313



2. In the Acquisition method pane, click Acquisition Method.

3. On the Acquisition Method Properties tab, in the Synchronization Mode list, make sure
that No Sync is selected. For more information about synchronization modes, refer to the
document: Help.

4. In the Acquisition method pane, click the Mass Spec icon.

5. On the MS tab, in the Scan type list, select Q1 Multiple Ions (Q1 MI).

6. In the Polarity section, click Positive.

7. In the mass ranges table, type the values that are shown in the following table.

Figure 11-4 MS Tab Parameter Values

Table 11-3 MS Tab Parameter Values

Field Value

Q1 Mass (Da) 609

Time (msec) 100

8. Click Edit Parameters.
The Parameter table dialog opens.

9. On the Source/Gas tab, type the following values:

Table 11-4 Source/Gas Tab Parameters

Source/Gas parameters Typical value

Curtain Gas (CUR) 35
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Table 11-4 Source/Gas Tab Parameters (continued)

Source/Gas parameters Typical value

IonSpray Voltage (IS) 5000

Temperature (TEM) 0

Ion Source Gas 1 (GS1) 20

Ion Source Gas 2 (GS2) 0

10. Click the Compound tab and then set the Declustering Potential (DP) to 90 and leave the
Entrance Potential (EP) at 10.
A value of 90 might not be optimal for the mass spectrometer but it is a good DP to start
with.

11. Click OK.

12. In the Acquisition method pane, click the Harvard Syringe Pump or Integrated Syringe
Pump icon.

Figure 11-5 Harvard Syringe Pump Method Properties Tab

13. Edit the syringe pump method to include Syringe Diameter, Flow Rate, and Unit.

14. Save the acquisition method.
Next steps: Create and submit a batch containing this acquisition method. To create and
submit batches, refer to the section: Create and Submit a Batch.

Create an Acquisition Method using an MRM Scan Type
Use the following procedure to create a method using the MRM scan. This scan type is used
in quantitative applications. An MRM scan can be used to determine how much of a compound
is in a sample. It is used in pharmacokinetic analysis and increasingly in applied markets and
screening applications.
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Prerequisites

• Make sure that a hardware profile containing the mass spectrometer and syringe pump is
active.

• On the software toolbar, make sure that the appropriate project is selected.

1. On the Navigation bar, under Acquire, double-click Build Acquisition Method.
The Acquistion Method Editor is shown with a method template based on the active
hardware profile.

2. In the Acquisition Method pane, click Acquisition Method.

3. On the Acquisition Method Properties tab, in the Synchronization Mode list, make sure
that No Sync is selected. For more information about synchronization modes, refer to the
document: Help.

4. In the Acquisition method pane, click the Mass Spec icon.

5. On the MS tab, in the Scan type list, select MRM (MRM).

6. In the Polarity section, click Positive.

7. In the mass ranges table, type the values that are shown in the following table.

Figure 11-6 MRM Scan Type

Table 11-5 Mass Range and Dwell Time

Q1 Mass (Da) Q3 Mass (Da) Time (msec)

609 397.2 100
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8. On the MS tab, click Edit Parameters.
The Parameter Table dialog opens.

9. On the Source/Gas tab, type the following values:

Table 11-6 Source/Gas Tab Parameters

Source/Gas parameters Typical value

Curtain Gas (CUR) 35

IonSpray Voltage (IS) 5000

Temperature (TEM) 0

Ion Source Gas 1 (GS1) 20

Ion Source Gas 2 (GS2) 0

10. On the Compound tab, set the Declustering Potential (DP) to 90 and leave the Entrance
Potential (EP) at 45.

11. Click OK.

12. In the Acquisition method pane, click the Harvard Syringe Pump icon.

Figure 11-7 Harvard Syringe Pump Method Properties Tab

13. On the Syringe Pump tab, edit the syringe pump method to include Syringe Diameter,
Flow Rate, and Unit.

14. Save the acquisition method.
Next steps: Create and submit a batch containing this acquisition method. To create and
submit batches, refer to the section: Create and Submit a Batch.

Add or Remove Devices From Acquisition Methods
Use the Acquisition Method Editor to customize the acquisition method by adding or removing
LC peripheral device methods. If the required device icon is not in the Acquisition Method
Browser pane, then add the peripheral device only if it is included in the active hardware profile.
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Note: The available parameters for the LC devices vary depending on the manufacturer.

Add or Remove an LC Device
1. With a method file open in the Acquisition Method Editor, in the Acquisition method pane,

right-click Acquisition Method and then click Add/Remove Device Method.

2. Select or clear the check boxes beside the device method to add or remove the device
method.

3. Click OK.

4. If an LC device is selected, then in the Acquisition Method Properties tab, select LC sync
for the Synchronization mode.

Modify LC Pump Properties
Modify each device in the method so that it functions properly for your method.

1. With a method file open in the Acquisition Method Editor, in the Acquisition method pane,
click the LC device icon.
The LC Pump Gradient tab opens in the Acquisition Method Editor pane.

Figure 11-8 SCIEX DX Pump Parameters

2. Edit the LC pump method as required for the experiments.

3. Save the method.
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Set Autosampler Properties
1. With a method file open in the Acquisition Method Editor, in the Acquisition method pane,

click the Autosampler device.
The Autosampler Properties tab opens in the Acquisition Method Editor pane.

Figure 11-9 SCIEX DX Autosampler Parameters

2. If required, edit the injection and wash details.

3. Save the method.

Set Column Oven Properties
1. With a method file open in the Acquisition Method Editor, in the Acquisition method pane,

click the Column Oven device.

The Column Oven Properties tab opens in the Acquisition Method Editor pane.

Figure 11-10 SCIEX DX Column Oven Parameters

2. Type the temperature of the column oven or column oven compartments in degrees Celsius.

3. Save the file.

Configure the Integrated Syringe Pump
This procedure is for the integrated syringe pump.
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1. Make sure that the integrated syringe pump is selected in the hardware device profile.

2. Click the Syringe Pump icon in the Acquisition method pane.
The Syringe Pump Method Properties tab opens in the Acquisition Method Editor.

Figure 11-11 Syringe Pump Properties tab

3. Type the syringe diameter in the Syringe Diameter (mm) field.

4. Type the flow rate in the Flow Rate field.

5. Select the units of flow from the Unit list.

Set Diverter Valve Properties
The switching valve can be used as a diverter or injection valve.

1. With a method file open in the Acquisition Method Editor, in the Acquisition method pane,
click the Valve icon.
The Valve Properties tab opens in the Acquisition Method Editor pane.
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Figure 11-12 Integrated Falco Valve

2. Change the position names from their preset names, if required.

The switching valve is sometimes used to switch the flow of solvent to waste, or to a
different column. The preset position names are A and B.

• In the Change Position Names list, select a position.

• In the Change Position Names list, rename the preset position names A and B to Inject
and Divert or to Column and Waste, depending on how the valve is plumbed.
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3. In the Total Time (min) column, click a cell and then type the total time the valve will remain
in this position.

4. In the Position column, click a cell and then, in the Position list, select the valve position.

5. Repeat step 3 and step 4 for each switch of the valve required during acquisition.

6. Save the file.

Set Diode Array Detector Properties
1. With a method file open in the Acquisition Method Editor, in the Acquisition method pane,

click the Diode Array Detector (DAD) icon.
The DAD Method Editor tab opens in the Acquisition Method Editor pane.

Figure 11-13 DAD Method Editor Tab

2. Do one of the following:

• To scan one to five individual wavelengths, in the Operating Mode section, click Signal
Data and then edit the data requirements.

• To scan over a wavelength range, in the Operating Mode section, click Spectral Data
and then edit the data requirements.

3. Save the file.
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Set Analog to Digital Converter Properties
1. With a method file open in the Acquisition Method Editor, in the Acquisition method pane,

click the Analog to Digital Converter (ADC) icon.
The Analog/Digital Convertor Properties tab opens in the Acquisition Method Editor pane.

Figure 11-14 Analog to Digital Converter Properties Tab

2. In the Sample section, in the Rate (pts/sec) field, type the rate.

Note: The interval and rate are proportional to each other. When you change the rate, the
software automatically calculates the interval.

3. Do the following to set the channel details:

• In the Channels field, click the channel name, and then select the check box beside the
name to include it in the method.

• In the Interpreted Value @ Full Scale field, type the appropriate value.

• In the Interpreted Unit field, type the appropriate unit.

The number of available channels is specified when setting up the ADC in the hardware
profile.

4. Save the file.

Change Acquisition Methods
In Acquire mode, users can add or delete periods and experiments to existing acquisition
methods.
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Periods
A period can contain one or more looped experiments. In a multi-period acquisition method,
experiments are performed for a specified amount of time and then the software switches to
another set of experiments. Periods are useful when the elution time of the compounds in an LC
run is known. The mass spectrometer can perform different experiments according to when the
compounds elute to obtain as much information as possible in the same run.

The following figure shows a three-period method.

Figure 11-15 Example of a Multi-period Experiment

Experiments
An experiment includes the mass spectrometer settings and the scan type during an MS scan.
A set of MS scans performed for a specific amount of time is called a period. An acquisition
method in which the MS parameters and actions are the same through the entire duration is
called a single-period, single-experiment method.

In looped experiments, MS settings are changed on a scan-by-scan basis. For example, if the
sample contains two compounds, A and B, users might want to loop an MS/MS experiment
of compound A with an MS/MS experiment of compound B to obtain information about both
compounds in the same run. The mass spectrometer method will alternate between the two
scan types. Other examples of looped experiments include alternating between positive and
negative modes in a run and Information Dependent Acquisition (IDA) methods.

Add an Experiment
1. In the Acquisition method pane, on the period where the experiment is to be added, right-

click and then click Add experiment.
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Figure 11-16 Add Experiment

An experiment is added below the last experiment in the period.

Note: An experiment cannot be inserted between experiments, IDA criteria, or periods.
Users can only add an experiment at the end of the period.

2. On the MS tab, select the appropriate parameters.

Copy an Experiment into a Period
1. Open a multi-period method.

2. In the Acquisition method pane, press Ctrl, and then drag the experiment to the period.
The experiment is copied below the last experiment in the period.

Copy an Experiment within a Period
Use this procedure to add the same or similar experiments to a period if most or all of the
parameters are the same.

Right-click the experiment and then click Copy this experiment.
A copy of the experiment is added below the last experiment created.

Add a Period
In the Acquisition method pane, right-click the Mass Spec icon, and then click Add period.
A period is added below the last period created.

Note: Users cannot use multiple periods in an IDA experiment.
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Scan Techniques
MS: In MS scans, also referred to as single MS scans, ions are separated according to their
mass-to-charge ratio (m/z). A single MS scan might be used to determine the molecular weight
of a compound. Single MS scans can also be referred to as survey scans. MS scans do
not provide any information about the chemical composition of the ions, other than the mass.
Perform MS/MS or MS/MS/MS scans to obtain more information about the ions.

MS/MS: MS/MS scans are used to determine structural information.

• For MS/MS scans on triple quadrupole systems, selected ions enter the Q2 collision cell
where they are collisionally activated to fragment, producing characteristic product ions.

• For MS/MS scans on QTRAP systems, precursor ion fragmentation can occur in the Q2
collision cell or the linear ion trap.

If enough energy is used, then the precursor ion fragments to produce characteristic product
ions.

MS/MS/MS: The linear ion trap (LIT) system MS/MS/MS scans go one step further than MS/MS
scans. A fragment that is produced in the collision cell is fragmented further in the LIT to give
more structural information about the molecular ion.

Quadrupole-Mode Scan Types
Triple quadrupole instruments have high-sensitivity Multiple Reaction Monitoring (MRM)
capabilities required for quantitation experiments. In addition, they have highly specific scan
types, such as precursor ion and neutral loss scans, which allow a more advanced search to be
performed on the components of the samples.

Q1 MS (Q1): A full scan type using the first quadrupole (Q1). The ion intensity is returned for
every mass in the scan range.

Q1 Multiple Ions (Q1 MI): A selective scan type using the Q1 quadrupole. The ion intensity is
returned for the specified masses only.

Q3 MS (Q3): A full scan type using the third quadrupole (Q3). The ion intensity is returned for
every mass in the scan range.

Q3 Multiple Ions (Q3 MI): A selective scan type using the Q3 quadrupole. The ion intensity is
returned for the specified masses only.

MRM (MRM): An MS/MS scan in which a user-defined ion is isolated in the Q1 quadrupole, then
fragmented in the Q2 collision cell. The Q3 quadrupole is then used to isolate a user-defined
fragment ion that is recorded by the detector. This scan type is used primarily for quantitation.
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Product Ion (MS2): An MS/MS full scan where the Q1 quadrupole is used to isolate and
transmit a specific precursor ion and the Q3 quadrupole scans a defined mass range. This scan
type is used to identify all of the fragment ions of a particular precursor ion.

Precursor Ion (Prec): An MS/MS scan where the Q3 quadrupole is fixed at a specified m/z
value to transmit a specific product ion and the Q1 quadrupole scans a mass range. This
scan type is used to confirm the presence of a precursor ion or, more commonly, to identify
compounds sharing a common product ion.

Neutral Loss (NL): An MS/MS scan where both the Q1 quadrupole and the Q3 quadrupole
scan a mass range, a fixed mass apart. A response is observed if the ion chosen by the Q1
quadrupole fragments by losing the neutral loss, the fixed mass, specified. This scan type is
used to confirm the presence of a precursor ion or, more commonly, to identify compounds
sharing a common neutral loss.

LIT-Mode Scan Types
The LIT-mode scans use the Q3 quadrupole as a linear ion trap. Ions are trapped and
stored in the Q3 quadrupole before being scanned out, giving increased sensitivity. In addition,
MS/MS/MS analysis can be performed in the linear ion trap, providing more information about
the sample. LIT-mode scan types are typically used for qualitative measurements.

Note: In China, only triple quadrupole mass spectrometers are available. These systems do not
support the linear ion trap (LIT) scan types.

Enhanced MS (EMS): Ions are scanned in the Q1 quadrupole and then collected in the linear
ion trap. These ions are scanned out of the Q3 quadrupole to produce single MS type spectra.

Enhanced Product Ion (EPI): This scan type is used to obtain a high-quality MS/MS
spectrum for a specific ion. The fragmentation is done in the Q2 collision cell and thus
provides the information-rich MS/MS spectrum typical of collisionally activated dissociation
(CAD) fragmentation. In this scan mode, the precursor ion to be fragmented is first selected
in the Q1 quadrupole with a mass window that is 1 Da to 4 Da wide, filtering out all of the other
ions. The precursor ion is fragmented by CAD gas in the Q2 collision cell. The fragment ions
generated are captured in the linear ion trap and then scanned out at one of three scan speeds,
depending on the required fragment ion resolution.

For IDA experiments, the Product Of field is set to 30 Da by default, and this value should not
be changed.

Enhanced Resolution (ER): This scan type is similar to the EMS scan except that a small 30
Da mass window around the precursor mass is scanned out of the linear ion trap at the slowest
scan rate to produce a narrow window of the best-resolved spectra.

MS/MS/MS (MS3): A precursor ion is selected by the Q1 quadrupole and fragmented with
collisionally activated dissociation in the Q2 collision cell. The resulting product ions are all
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transmitted to the linear ion trap, where a single product ion is then isolated. The isolated ion
is further fragmented in the linear ion trap, and the resulting product ions are scanned out of
the trap at one of three scan speeds. As with any in-trap Collision Induced Dissociation (CID)
technique, there is a low mass cut-off for the second MS/MS step because the lowest mass
fragment and precursor must be simultaneously stable in the trap. For QTRAP systems, this
results in the loss of ions lower than 28 percent of the mass of the precursor ion during MS3
experiments. This phenomenon is often referred to as the one-third cut-off rule.

About Spectral Data Acquisition
For a description of the modes in which spectral data can be acquired, refer to the table: Table
11-7.

Table 11-7 Spectral Data

Mode Description

Profile The preset value is 0.1 Da. Profile data is the data generated by the
mass spectrometer and corresponds to the intensity recorded at a series
of evenly spaced discrete mass values. For example, for a mass range
from 100 Da to 200 Da and a step size of 0.1 Da, the mass spectrometer
scans 99.95 to 100.05 (recorded as value 100), 100.95 to 101.05 (recorded
as value 101)…199.95 to 200.05 (recorded as value 200).

Peak Hopping The preset value is 1.0 Da. Peak hopping is a mode of operating a mass
spectrometer in which large steps (approximately 1 Da) are made. It has
the advantage of speed (fewer data steps are made) but with the loss of
peak shape information.

Centroid The mass spectrometer scans as in profile mode, but creates a centroid of
the data, replacing found peaks with the intensity-weighted center of gravity
for each peak. Centroid data has the advantage of significantly reducing file
size. The disadvantage is that peak shape information is lost and if data
has been collected as a centroid then it cannot be altered. We recommend
the use of profile mode and centroiding of the data post-acquisition.
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Operating Instructions — Batches 12
CAUTION: Potential System Damage. If the LC system connected to the mass
spectrometer is not controlled by the software, then do not leave the mass spectrometer
unattended while in operation. The liquid stream from the LC system can flood the ion
source when the mass spectrometer goes in Standby state.

A batch is a collection of information about the samples to be analyzed. Samples are usually
grouped into sets to simplify submission. Grouping the samples into a set also reduces the
amount of data that must be typed manually. A set can consist of a single sample or multiple
samples. All of the sets in a batch use the same hardware profile. However, samples in a set can
have different acquisition methods. A batch can be submitted only from an acquisition computer.

Batches include the following information:

• Sample information, such as name, ID, and comment

• Autosampler rack information, vial position, and injection volume

• Acquisition methods

• Processing method (optional)

• Quantitation information (optional)

• Custom sample data (optional)

• Set information

Create and Submit Batches
A batch is a collection of information about the samples to be analyzed. Batches tell the software
the order in which to analyze the samples. For information about importing batches, refer to the
Advanced User Guide.

Set Queue Options
The software goes one-by-one through the list of samples in the queue, acquiring each
sample with the selected acquisition method. After all of the samples have been acquired, the
acquisition stops and the mass spectrometer goes into Standby state after the Max. Idle Time
set in the Queue Options has elapsed. In the Standby state, the LC pumps stop and some
instrument voltages are turned off.
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The user can change the amount of time between acquisition of the last sample and the change
to Standby state. For information about the other fields in the Queue Options dialog, refer to the
document: Help.

1. On the Navigation bar, click Configure.

2. Click Tools > Settings > Queue Options.

Figure 12-1 Queue Options Dialog

3. In the Max. Num. Waiting Samples field, set the maximum number of samples to a value
that is greater than the number of samples that will be submitted to the queue.

4. In the Max. Idle Time field, type the amount of time the software will wait after acquisition is
completed before going to Standby state. The preset value is 60 minutes.

If gas cylinders are used, then adjust this time to make sure that the gas in the cylinders is
not depleted.

If an LC method is used, then before the run is started, make sure that there is enough
solvent in the reservoirs for all of the sample runs at the primary flow rate and the maximum
idle time.

5. Select the Leave Mass Spec on in Standby check box to keep the mass spectrometer
running after analysis has been completed.
This feature allows the heaters and gases to continue running, even after devices have
entered Idle state, so that the ion source and entrance to the mass spectrometer are kept
free of contaminants.
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6. Select the Fail Whole Batch in Case of Missing Vial check box to make the entire batch
fail when a missing vial is encountered.
If this option is not selected, then only the current sample will fail and the software will
continue to the next sample.

Create and Submit a Batch
Use this workflow to create a batch.

Do not use the automatically generated Quick Quant method to perform quantitation if the
Quick Quant feature is used to store Sample Types and Concentrations in the data file. This
quantitation method does not use compound and sample-specific integration parameters that
have been optimized for peak selection.

Add Sets and Samples to a Batch
A set can consist of a single sample or multiple samples.

Note: For more information about adding quantitation information to a batch, refer to the
document: Advanced User Guide.

1. On the Navigation bar, under Acquire, double-click Build Acquisition Batch.

Figure 12-2 Batch Editor Dialog

2. On the Sample tab, in the Set list, type a name.

3. Click Add Set.

4. Click Add Samples to add samples to the new set.
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Figure 12-3 Add Sample Dialog

5. In the Sample name section, in the Prefix field, type a name for the samples in this set.

6. To add incremental numbering to the end of the sample name, select the Sample number
check box.

7. If the Sample number check box is selected, then in the Number of digits field, type the
number of digits to include in the sample name.
For example, if 3 is typed, then the sample names would be samplename001,
samplename002, and samplename003.

8. In the Data file section, in the Prefix field, type a name for the data file that will store the
sample information.

9. Select the Set name check box to use the set name as part of the data file name.

10. Select the Auto Increment check box to increment the data file names automatically.

When the mass spectrometer is used as an in vitro diagnostic device, it is recommended
that only one sample be acquired per data file.

Note: The data for each sample can be stored in the same or a separate data file. The
names of the data file will have numerical suffixes starting from 1.

11. Type a name in the Sub Folder field.
The folder is stored in the Data folder for the current project. If the Sub Folder field is left
blank, then the data file is stored in the Data folder and a subfolder is not created.
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12. In the New samples section, in the Number field, type the number of new samples to add.

13. Click OK.
The sample table fills with the sample names and data file names.

Tip! Fill Down and Auto Increment options are available in the right-click menu after a
single column heading or several rows in a column are selected.

14. On the Sample tab, in the Acquisition section, select a method from the list.
Depending on how the system is set up, specific information for the autosampler must be
entered. Even if the injection volume is set in the method, the user can change the injection
volume for one or more samples by changing the value in the injection volume column.

Note: To use different methods for some of the samples in this set, select the Use Multiple
Methods check box. The Acquisition Method column is shown in the Sample table. Select
the acquisition method for each sample in this column.

15. In the Sample tab, from the Set list, select the set.

16. For each sample in the set, do the following if applicable:

• In the Rack Code column, select the rack type.

• In the Rack Position column, select the position of the rack in the autosampler.

• In the Plate Code column, select the plate type.

• In the Plate Position column, select the position of the plate on the rack.

• In the Vial Position column, type the position of the vial in the plate or tray.

Note: To automatically fill in the samples from the Locations tab, click on the first and last
vial within a set while pressing the Shift key. These vials appear as red circles. On the
Locations tab, multiple injections from the same vial can be done by pressing the Ctrl key
while clicking the vial location. The red circle turns green.

17. Alternatively, to use the location tab to select the vial positions, refer to the section: Select
Vial Positions Using the Locations Tab (Optional).

18. (Optional) Use the procedures in section: Table 12-1 as required.
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Table 12-1 Batch Editor Tips

Tp Do This Do This

To change all the values in a column
simultaneously

Click a column heading and then right-click.
From the menu, select the Auto Increment
and Fill Down commands to change the
values in the column.

This feature also works for multiple cells in
the same column.

To change an existing acquisition method Select the method and then click Method
Editor from the list. To create a new
acquisition method, select None from the
list and then click Method Editor. Only
experienced users should use this feature.

Do not use this feature if the Use Multiple
Methods option is selected.

To apply a previously created quantitation
method

Select the method from the Quantitation
list.

To select more than one well or vial at a time Press the Shift key while clicking the first
and last well or vial in the range.

19. (Optional) To define quantitation details prior to submitting the batch, refer to the section:
Set Quantitation Details in the Batch Editor (Optional).

20. Open the Submit tab.

Note: The order of samples can be edited before the samples are submitted to the queue.
To change the order of samples, on the Submit tab, double-click any of the numbers at
the far left of the table (a very faint square box is shown), and then drag them to the new
location.

21. If the Submit Status section contains a message about the status of the batch, then do one
of the following:

• If the message indicates that the batch is ready for submission, then go to step 22.

• If the message indicates that the batch is not ready for submission, then make the
changes as indicated by the message.

22. After confirming that all of the batch information is correct, click Submit.
The batch is submitted to the queue and can be viewed in the Queue Manager.

23. Save the file.
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Submit a Sample or Set of Samples
Note: Run the sample again if an abnormal termination occurs during sample acquisition. If the
abnormal termination is caused by a power failure, then the temperature of the autosampler tray
is not maintained and sample integrity might be compromised.

1. Select one sample or a set of samples.

2. Open the Submit tab in the Batch Editor.

3. If the Submit Status group contains a message about the status of the batch, then do one of
the following:

• If the message indicates that the batch is ready for submission, then go to the next step.

• If the message indicates that the batch is not ready for submission, then make the
changes as indicated by the message.

4. Click Submit.

Change Sample Order
The order of the samples can be changed before the samples are submitted to the Queue.

On the Submit tab, double-click any of the numbers at the far left of the table (a very faint square
box is visible), and then drag them to the new location.

Select Vial Positions Using the Locations Tab (Optional)
1. In the Batch Editor, open the Locations tab.

2. In the Set list, select the set.

3. From the Autosampler list, select the autosampler.

4. In the space associated with the rack, right-click and then select the rack type.
The plates or trays are shown in the rack.

5. Double-click in the white space labeled rack type. A visual sample rack layout is shown.
The appropriate number of rack spaces for the autosampler is shown in the graphic rack
view.
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Figure 12-4 Visual Sample Location

6. Double-click one of the rectangles.
The circles depicting the wells or vials for the plate or tray are shown.

Tip! To see the corresponding vial number in the graphical representation, move the cursor
over the sample position. Use this information to confirm that the vial positions in the
software match the vial positions in the autosampler.

Operating Instructions — Batches

SCIEX 4500MD Systems
152/313

System User Guide
IVD-IDV-05-6996-D



Figure 12-5 Locations Tab

Note: Depending on the autosampler being used, it might not be necessary to type details
in additional columns.

7. To select whether samples are marked by row or column, click the Row/Column selection
selector button.
If the button shows a red horizontal line, then the Batch Editor marks the samples by row. If
the button shows a red vertical line, then the Batch Editor marks the samples by column.

8. Click the sample wells or vials in the order in which they should be analyzed.

Tip! Click a selected well or vial again to clear it.
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Tip! To fill in the samples automatically, press Shift while clicking the first and last vial within
a set. To perform multiple injections from the same vial, press Ctrl while clicking the vial
location. The red circle changes to a green circle.

Set Quantitation Details in the Batch Editor (Optional)
If a quantitation method is used with a batch and if the user does not want to select quantitation
details after acquisition, then the quantitation details (sample type, sample concentration) must
be defined before the batch is submitted.

The appropriate Internal Standard and Standard columns are shown in the Quantitation tab
according to the quantitation method selected in the Sample tab.

1. With a batch file open in the Batch Editor window, open the Quantitation tab.

2. Select the set containing the samples.

3. Select a Quant Type, Dilution Factor, and Weight/Volume for all of the samples from the
list in the cell.

4. (If required) In the Analyte column, type the analyte concentration.

5. (If required) In the Internal Standard column, type the internal standard concentration.

6. Repeat this procedure for each set in the batch.

Equilibrate the System
Equilibrate the system before submitting a batch. Equilibration warms up and prepares the mass
spectrometer for the next sample or batch.

1. Click Equilibrate ( ).
The Equilibrate dialog opens.

2. Select the acquisition method used for the submitted batch.

3. Type the equilibration time in the Time (min) field, in minutes.

4. Click OK. The system starts the equilibration.
After the equilibration is completed, the system state changes to Ready.
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Tip! If the equilibration does not finish as expected, or if the system state does not change
to Ready after the equilibration finishes, then make sure that the following conditions are
true:

• The activated hardware profile is appropriate for the acquisition method.

• The LC system is turned on.

• The LC system has correctly established communication with the software.

Acquire Data
The software must not be in Tune and Calibrate mode when sample acquisition is started. Also,
if the system has been previously run that day and has not yet been set to Standby state, then
sample acquisition will start automatically.

1. Make sure that the column oven temperature is reached.

2. Make sure that the Reserve Instrument for Tuning ( ) icon is not pressed in.

3. On the Navigation bar, click Acquire.

4. Click View > Sample Queue.
The Queue Manager opens with all of the submitted samples.

Figure 12-6 Queue Manager

Item Description

1 The Reserve Instrument for Tuning icon should not be pressed in.

2 Queue state must be Ready.

3 Queue Server state must be Normal. Refer to the section: Queue
States.

5. Click Acquire > Start Sample.

Note: We recommend that the sample be run again if an abnormal termination occurs
during sample acquisition.
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Import Batch Files
Users can import a text file containing batch information instead of creating a batch in the Batch
Editor. If all of the sample details are in a spreadsheet, then rearranging and importing the data
in the spreadsheet is faster than manually typing the data in the Batch Editor.

Before importing batch information from a text file, make sure that the data in the file is
organized and formatted correctly. In particular, the column headings in the spreadsheet must
match the Batch Editor column headings. To make sure that the text file includes the proper
headings, create a batch using the Batch Editor, export it as a text file, type the appropriate
values in a spreadsheet editor, and then import the file back into the Batch Editor.

For examples of correctly formatted files, refer to the Batch folder in the Example project.

The information in a batch file can also be exported for use with other applications, such as
Microsoft Excel, Microsoft Access, and certain Laboratory Information Management System
(LIMS) software.

Build a Batch as a Text File

Prerequisites

Make sure that the active hardware profile includes all of the devices to be used to acquire the
samples.

To make sure that the text file includes the proper headings, create a batch using the Batch
Editor, export it as a text file, type the appropriate values in a spreadsheet editor, and then
import the file back into the Batch Editor. Users can export a batch only if it contains at least one
set with at least one sample. The saved text file can be used again later as a template.

1. In the Batch Editor, create a single-set, single-sample batch.

2. Click File > Export.
The Save As dialog opens.

3. Type a name for the text file in the File name field and then click Save.

4. Open the text file in a spreadsheet program such as Excel.

5. Type, or copy and paste, the details for the samples: one sample per row, with the details
under the appropriate headings.

Note: Do not delete any of the columns. The columns in the spreadsheet must match the
columns in the Batch Editor.

6. Save the modified text file as a txt or csv file and then close the spreadsheet program.
The text file is now ready to be imported into the Batch Editor.
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Import a Batch from a Text File
1. In the Batch Editor, on the Sample tab, right-click, and then click Import From > File.

The Open dialog opens.

2. Click the required text file and then click Open.
If an autosampler is used, then the Select Autosampler dialog opens.

Note: If the saved text file is not visible in the Files of type list, then select Microsoft Text
Driver (*.txt; *.csv). Files with the extension .txt are shown in the field.

3. In the autosampler list, select the autosampler and then click OK.
The sample table fills with the details from the text file.

4. Submit the batch.

Batch and Acquisition Method Editor Tips
To Do This Do This

To change the values in the table (For example, to change a sample name) Click
in a cell and then type the new value.

To change all the values in a column
simultaneously

Click a column heading and then right-click.
From the menu that is shown, select the
Auto Increment and Fill Down commands to
change the values in the column.

This feature also works for multiple cells in the
same column.

To change an existing acquisition method From the list, select the method and then click
Method Editor. To create a new acquisition
method, from the list, select None and then
click Method Editor. Only experienced users
should use this feature.

Do not use this feature when you are using the
Use Multiple Methods option.

To apply a previously created quantitation
method

Select the method from the Quantitation
menu.

To select more than one well or vial at a time Press Shift and click the first and last well or
vial of the range you want to select.

For information on using the Batch Editor right-click menu, refer to the section: Batch Editor.
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Batch Troubleshooting Tips
Symptom Possible Cause Corrective Action

In the Analyst MD software,
Batch editor, the injection
volume (uL) column is shown
as -1.

The acquisition method is not
selected in the batch.

Select the correct acquisition
method for the batch.

LC device in the selected
acquisition method does not
match the activated LC device
in hardware profile.

Open and review the intended
acquisition method. Correct
the LC device information and
then save the method.

The activated hardware profile
does not contain an LC device
or it contains a different LC
device.

Open the Hardware
Configuration Editor and
then deactivate the hardware
profile. Edit the hardware
profile, correct the LC device
information, and then activate
the hardware profile.

Stop Sample Acquisition
When a sample acquisition is stopped, the software completes the current scan before stopping
acquisition.

1. In the Queue Manager, click the sample in the queue after the point where acquisition
should stop.

2. On the Navigation bar, click Acquire.

3. Click Acquire > Stop Sample.
The acquisition stops after the current scan in the selected sample is acquired. The sample
status in the Queue Manager (Local) window changes to Terminated, and all other
samples following in the queue are Waiting.

4. To continue processing the batch, click Acquire > Start Sample.
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Operating Instructions — Analyze
and Explore Data 13
Use the sample files installed in the Example folder to learn how to view and analyze data
using the most common analysis and processing tools. For more information about the following
topics, refer to the document: Advanced User Guide.

• Labeling graphs

• Overlaying and summing spectra or chromatograms

• Performing background subtractions

• Smoothing algorithms

• Working with smoothed data

• Working with centroid data

• Working with contour plots

• Working with the fragment interpretation tool

• Working with library databases and library records

Overview of Spectral and Chromatographic Data
Spectral data provides mass-specific information about a compound. A chromatogram provides
a general view of the data, usually time dependent when using an LC column, but it does not
provide any information about the components of a peak. A spectrum, however, looks at a
particular peak and provides the molecular weight of the corresponding compound, which can be
used to find more specific information. For example, while a chromatogram might show only one
peak, that peak can represent more than one compound, that is, different masses. A spectrum
shows all of the masses that make up a peak, including the intensity of each mass.

Chromatographic data can change in both time and intensity if there is a change in the
chromatographic conditions in a given sample. Spectral intensities might change, but the
masses are fixed because the mass of a compound does not change.

There are two ways to generate spectral data:

• If only one scan is acquired, by default the data is shown as a spectrum.

• From a chromatogram.
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A typical spectrum is shown with the molecular weight, labeled with the mass/charge ratio (m/z),
on the X-axis. The intensity is shown on the Y-axis.

Analyze Data
When a data file is opened, different panes are shown in windows, depending on the type of
experiment performed. The software stores data in files with a wiff extension. Wiff files can
contain data for more than one sample. In addition to wiff files, the software can open txt files.
However, txt files contain data for only one sample.

The information contained in a data file can be viewed in tabular or graphical form. Graphical
data is presented either as a chromatogram or as a spectrum. Data from either of these can
appear as a table of data points, and various sorting operations can be performed on the data.

Users can open files containing existing data or data that is currently being acquired. Users can
also view all experiment-related data in tabular form. The table pane consists of two tabs, the
Data List tab and the Peak List tab. The Data List tab contains experiment-related information,
such as acquisition time and scan intensity. The Peak List tab displays peak-related information
such as peak height, peak area, and baseline type.

If the data contains results from multiple experiments, users can create individual TICs (Total
Ion Chromatograms) for each experiment, and another TIC that represents the sum of all
experiments.

The preset TIC that represents the sum of all of the experiments is shown with a splitter tool
below the center of the X-axis.

Open Data Files
Tip! To turn off the automatic update on the mass spectrum, right-click the mass spectrum and
then click Show Last Scan. If there is a check mark beside Show Last Scan, then the spectrum
will update in real-time.

1. On the Navigation bar, under Explore, double-click Open Data File.
The Select Sample dialog is shown.

2. In the Data Files list, navigate to the data file to open, select a sample, and then click OK.
The data acquired from the sample is shown. If data is still being acquired, then the mass
spectrum, DAD/UV trace, and TIC continue to update automatically.

Navigate Between Samples in a Data File
Note: If samples were saved in separate data files, then open each file individually.
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For descriptions of the navigation icons used in this procedure, refer to the table: Table D-4.

Open a data file that contains multiple samples and then do one of the following:

• To skip to the next sample in the data file, click the Show Next Sample icon ( ).

• To skip to a non-sequential sample, click the Go to Sample icon ( ).

• In the Select Sample dialog, from the Sample list, select the sample to view.

• To go to the previous sample in the data file, click the Show Previous Sample icon ( ).

View Experimental Conditions
The experimental conditions used to collect data are stored in the data file with the results. The
information contains the details of the acquisition method used: the MS acquisition method, that
is, the number of periods, experiments, and cycles, including instrument parameters, and the LC
device method, including the LC pump flow rate. In addition, it also contains the MS resolution
and mass calibration tables used for the sample acquisition. For the software functionality
available when the user views the file information, refer to the section: Show File Information
Pane Right-click Menu.

Note: If data is acquired from more than one sample into the same wiff file, then the file
information pane does not refresh automatically when the user scrolls through the samples.
Close the file information pane and then open it again to view the details for the next sample in
the wiff file.

Click Explore > Show > Show File Information.
The File Information pane opens below the graph.

Tip! To create an acquisition method from the File Information pane, right-click the File
Information pane and then click Save Acquisition Method.

Show Data in Tables
1. Open a data file.

2. Click Explore > Show > Show List Data.
The data is shown in a pane below the graph.
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Figure 13-1 Peak List Tab (QTRAP systems)

Table 13-1 Right-click Menu for the Spectral Peak List Tab

Menu Function

Column Options Opens the Select Columns for Peak List dialog.

Save As Text Saves the data as a .txt file.

Delete Pane Deletes the selected pane.
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Table 13-2 Right-click Menu for the Chromatographic Peak List Tab

Menu Function

Show Peaks in Graph Show the peaks in two colors in the graph.

IntelliQuan Parameters Opens the Intelliquan dialog.

Save As Text Saves the data as a txt file.

Delete Pane Deletes the selected pane.

Show Basic Quantitative Data
1. Open a data file.

2. Click Explore > Show > Show List Data.

Figure 13-2 List Data

3. On the Peak List tab, right-click and then select Show Peaks in Graph.
Peaks are shown in two colors.

4. To change the peak finding algorithm settings, right-click and then select either Analyst
Classic Parameters or Intelliquan Parameters, whichever is active.
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5. (Optional) To remove the colored peaks, right-click in the Peak List tab and then clear Show
Peaks in Graph.

Spectra
A spectrum is the data that is obtained directly from the mass spectrometer and normally
represents the number of ions detected with particular mass-to-charge (m/z) values. It is shown
as a graph with the m/z values on the X-axis and intensity (cps) represented on the Y-axis. For
more information on how to work with spectra, refer to Table G-4.

In the case of MS/MS data, the intensity is associated with two masses, the precursor ion mass
(Q1) and the product ion mass or masses (Q3).

Chromatograms
A chromatogram is a graphical view of the data obtained from the analysis of a sample. It plots
the signal intensity along an axis that shows either time or scan number. For more information
about software functionality available for chromatograms, and on using the Chromatogram
Panes right-click menu, refer to the section: Chromatogram Panes.

The software plots intensity, in counts per second (cps), on the Y-axis against time on the X-axis.
Peaks above a set threshold are labeled automatically. In the case of LC-MS, the chromatogram
is often shown as a function of time. For a description of the types of chromatograms, refer to
the table: Table 13-3.

For more information about using the available icons, refer to the table: Table 13-5.

Table 13-3 Types of Chromatograms

Types of
Chromatograms

Purpose

Total Ion
Chromatogram
(TIC)

A chromatogram generated by plotting the intensity of all ions in a scan
against time or scan number.

When a data file is opened, it is preset to open as a TIC. If the experiment
contains only one scan, then it is shown as a spectrum.

If the MCA check box is selected during acquisition of the data file, then the
data file opens to the mass spectrum. If the MCA check box is not selected,
then the data file opens as the TIC.
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Table 13-3 Types of Chromatograms (continued)

Types of
Chromatograms

Purpose

Extracted Ion
Chromatogram
(XIC)

An chromatogram created by taking intensity values at a single, discrete
mass value, or a mass range, from a series of mass spectral scans. It
indicates the behavior of a given mass, or mass range, as a function of
time.

Base Peak
Chromatogram
(BPC)

A chromatogram that shows the intensity of the most intense ion within a
scan versus time or scan number.

Total Wavelength
Chromatogram
(TWC)

A chromatogram created by summing all of the absorbance values in the
acquired wavelength range and then plotting the values against time. It
consists of the summed absorbances of all ions in a scan plotted against
time in a chromatographic pane.

Extracted
Wavelength
Chromatogram
(XWC)

A subset of TWC. An XWC shows the absorbance for a single wavelength
or the sum of the absorbance for a range of wavelengths.

Diode Array
Detector (DAD)

A chromatogram that shows the absorption spectrum of eluting compounds
at one or more wavelengths.

Show TICs from a Spectrum
To see an example data file, make sure that the Example project is selected.

To see an LIT spectrum, open the LIT folder, and then open the Reserpine.wiff file.

Click Explore > Show > Show TIC.
The TIC opens in a new pane.

Tip! Right-click inside a pane containing a spectrum and then click Show TIC.

For information on using the Spectra Panes right-click menu, refer to the section: Spectra
Panes

Show a Spectrum from a TIC
A TIC is created by summing the intensity contributions of all ions from a series of mass scans.
Use the TIC to view an entire data set in a single pane. It consists of the summed intensities
of all of the ions in a scan plotted against time in a chromatographic pane. If the data contains
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results from multiple experiments, then a TIC for each experiment can be created below the TIC
that represents the sum of all of the experiments.

When a data file is opened, it is preset to be shown as a TIC. However, if the experiment
contains only one scan, it is shown as a spectrum. If the user selects the MCA check box before
acquiring the data file, then the data file opens to the mass spectrum. If the MCA check box is
not selected, then the data file opens with the TIC.

For information on using the Spectra Panes right-click menu, refer to the section: Spectra
Panes.

1. In a pane containing a TIC, select a range.

2. Click Explore > Show > Show Spectrum.
The spectrum opens in a new pane.

Tip! Double-click in the TIC pane at a particular time to show the spectrum.

Figure 13-3 Example of a TIC
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XICs
An XIC is an extracted ion chromatogram created by taking intensity values at a single, discrete
mass value, or a mass range from a series of mass spectral scans. It shows the behavior of
a given mass, or mass range, as a function of time. The intensity of the ion, or the summed
intensities of all ions in a given range, is plotted in a chromatographic pane.

Generate XICs
XICs can be generated only from single-period, single-experiment chromatograms or spectra. To
obtain an XIC from multi-period or multi-experiment data, split the data into separate panes by
clicking the triangle under the X-axis. For more information about using the available icons, refer
to the table: Table 13-5.

Several methods are available for extracting ions to generate an XIC, depending on whether
chromatographic or spectral data is used. For a summary of methods that can be used with
chromatograms and spectra, refer to the following table.

Table 13-4 Summary of XIC Generation Methods

Method Use with
Chromatogram

Use with
Spectrum

Extraction

Selected range No Yes Extracts ions from a selected area in
a spectrum.

Maximum No Yes Extracts ions from a selected area in
a spectrum using the most intense
peak in the selected area. This
option creates an XIC using the
maximum mass from the selected
spectral range.

Base peak
masses

Yes Yes Can be used only with Base Peak
Chromatograms (BPCs). Use the
Use Base Peak Masses command
to extract ion results in an XIC
with a different colored trace for
each mass. If the selection includes
multiple peaks, then the resulting
XIC will have an equal number of
colored traces, one for each mass.

Specified masses Yes Yes Extracts ions from any type of
spectrum or chromatogram. Select
up to ten start and stop masses for
which to generate XICs.
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Generate an XIC Using a Selected Range
1. Open a data file containing spectra.

2. Select a range by pressing the left mouse button at the start of the range, dragging the
cursor to the end of the range, and then releasing the left mouse button.
The selection is shown in blue.

3. Click Explore > Extract Ions > Use Range.
An XIC of the selection opens in a pane below the spectrum pane. The experiment
information at the top of the pane contains the mass range and the maximum intensity
in counts per second.

Generate an XIC Using the Maximum Peak
1. Open a data file containing spectra.

2. Select a range in a spectrum.
The selection is shown in blue.

3. Click Explore > Extract Ions > Use Maximum.
An XIC of the maximum peak specified selection opens below the spectrum pane. The
experiment information at the top of the pane contains the mass range and the maximum
intensity in counts per second.

Generate an XIC Using Base Peak Masses
1. Open a data file containing spectra.

2. In a BPC, select the peak from which to extract ions.
The selection is shown in blue.

3. Click Explore > Extract Ions > Use Base Peak Masses.
An XIC of the specified selection opens below the spectrum pane. The experiment
information at the top of the pane shows the mass range and the maximum intensity in
counts per second.

Extract Ion by Selecting Masses
1. Open a spectrum or chromatogram.

2. Click Explore > Extract Ions > Use Dialog.
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Figure 13-4 Extract Ions Dialog

3. Type the values for each XIC to be created.

• In the Start field, type the start value (lower value) for the mass range.

• In the Stop field, type the stop value (higher value) for the mass range.

Note: If a stop value is not typed, then the range is defined by the start value.

4. Click OK.
An XIC of the selection opens below the chromatogram pane. The experiment information at
the top of the pane includes the masses and the maximum intensity in counts per second.

BPCs
A BPC shows the intensity of the most intense ion in every scan as a function of scan number
or retention time. It is useful in instances where the TIC is so dominated by noise that there
is a large offset and chromatographic peaks are hard to distinguish. It also helps to distinguish
between co-eluting components. BPCs are generated only from single period, single experiment
data.

Operating Instructions — Analyze and Explore Data

System User Guide
IVD-IDV-05-6996-D

SCIEX 4500MD Systems
169/313



The graph uses two colors, alternating each time the mass of the base peak changes. The color
changes are maintained when the data is manipulated by scrolling or zooming. For information
about selecting the colors used in the graph, refer to the document: Help.

Generate BPCs
BPCs can be generated only from single-period, single-experiment data.

1. Open a data file.

2. Select an area within a TIC.
The selection is shown in blue.

3. Click Explore > Show > Show Base Peak Chromatogram.
The selections are shown in the Start Time and End Time fields.

Figure 13-5 Base Peak Chromatogram Options

4. In the Mass Tolerance field, type the value to indicate the mass range used to find a peak.
The software finds the peak using a value twice the typed range (± the mass value).

5. In the Minimum Intensity field, type the intensity below which peaks are ignored by the
algorithm.

6. In the Minimum Mass field, type the mass at the beginning of the scan range.

7. In the Maximum Mass field, type the mass at the end of the scan range.
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8. To set the start and end times, select the Use Limited Range check box and do the
following:

• In the Start Time field, type the time when the targeted range of the experiment starts.

• In the End Time field, type the time when the targeted range of the experiment ends.

9. Click OK.
The BPC is generated in a new pane.

Adjust the Threshold
The threshold is an invisible line drawn parallel to the X-axis of a graph that sets a limit below
which the software will not include peaks in a spectrum. The line has a handle, represented by a
blue triangle to the left of the Y-axis. Click the blue triangle to view a dotted line that represents
the threshold. The threshold can be raised or lowered, but changing the threshold value does
not change the data. The software does not label any peaks in the region that lies below the
threshold.

1. Open a data file.

2. Do one of the following:

• To increase the threshold, drag the blue triangle up the Y-axis.

• To decrease the threshold, drag the blue triangle down.

• Click Explore > Set Threshold. In the Threshold Options dialog that opens, type the
threshold value and then click OK.

• Click Explore > Threshold.

The graph updates to show the new threshold. Peak labeling and the peak list are also
updated.

Tip! To view the current threshold value, move the pointer over the threshold handle.

Generate TWCs
A TWC is a less commonly used chromatogram. It shows the total absorbance (mAU) as
a function of time. The TWC provides a way of viewing an entire data set in a single
pane. It consists of the summed absorbances of all ions in a scan plotted against time in a
chromatogram. If the data contains results from multiple experiments, then a TWC for each
experiment can be created below the TWC that represents the sum of all of the experiments.

A TWC shows total absorbance (mAU) on the Y-axis plotted against time on the X-axis. For
more information about using the available icons, refer to the table: Table 13-5.
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1. Open a data file that contains a DAD spectrum.

2. Click Explore > Show > Show DAD TWC.
The TWC is shown in a pane below the DAD spectrum.

Tip! Right-click inside the pane containing the DAD spectrum and then click Show DAD
TWC.

Generate XWCs
An XWC is a wavelength chromatogram created by taking intensity values at a single
wavelength, or by taking the sum of the absorbance for a range of several wavelengths. Up to
three ranges can be extracted from a DAD spectrum to generate the XWC. For more information
about using the available icons, refer to the table: Table 13-5.

1. Open a data file that contains a DAD spectrum.

2. Right-click anywhere in the pane and then click Extract Wavelengths.

Figure 13-6 Extract Wavelengths Dialog

3. Type Start and Stop values.

4. Click OK.
The XWC is shown in a pane below the DAD spectrum.

Show DAD Data
Like mass spectrometer data, DAD data can be viewed in chromatogram or spectrum form.
Users can view the DAD spectrum for a single point in time, or for a range of time as a Total
Wavelength Chromatogram (TWC).

1. Open a data file containing data acquired with a DAD.
The TWC, which is analogous to a TIC, opens in a pane below the TIC.

2. In the TWC pane, click a point to select a single point in time, or highlight an area of the
spectrum to select a range of time.
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3. Click Explore > Show > Show DAD Spectrum.
The DAD spectrum opens in a pane below the TWC. The Y-axis shows the absorbance and
the X-axis shows the wavelength.

Tip! If the pane with the TWC is closed, then click a point anywhere in the TWC to open it
again. Click Explore > Show > Show DAD TWC.

Show ADC Data
Analog-to-digital converter (ADC) data is acquired from a secondary detector, for example from
a UV detector through an ADC card, and is useful for comparison with mass spectrometer
data. To make ADC data available, acquire the ADC data and the mass spectrometer data
simultaneously. Both types of data are then saved in the same file.

1. Make sure that the project folder where the ADC data is stored is selected. For example,
click the Example folder.

2. On the Navigation bar, under Explore, double-click Open Data File.
The Select Sample dialog opens.

3. In the Data Files field, double-click the sub-data folder (if applicable), and then click the
data file to be opened. For example, in the Example folder, double-click Devices and then
click Adc16chan.wiff.

4. In the Samples list, select a sample, and then click OK.

5. Click Explore > Show > Show ADC Data.

Figure 13-7 Select ADC Channel Dialog

6. In the Channel list, select a channel, and then click OK.
The ADC data is shown in a new pane beneath the active pane.

Graphical Data Processing
Graphical data can be processed many ways. This section provides information and procedures
for using some of the most commonly used tools.
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The user can zoom in on part of a graph to view a particular peak or an area in greater detail in
both spectra and chromatograms. The user can also zoom in repeatedly to view smaller peaks.

Manage Data
Use the following menu options or icons to manage data in graphs.

Table 13-5 Graph Options

To Do This Use This Menu Option Or Click This Icon

Copy a graph to a
new window

Select the graph to copy. Click Explore >
Duplicate Data > In New Window.

Rescale a graph to
its original size

Select the graph. Click Explore > Home Graph.

Move a pane • Select the graph. Click Window > Move Pane.

• Select the pane or window and then drag it to
the new position. This position can be inside
the same window or within another window.

A four-headed arrow is shown when the cursor is
on the boundary of the active window or pane.

• If the pane is at the top or bottom of the target
pane, then the pane moves above or below that
pane, respectively.

• If the pane is at the left or right of the target
pane, then the pane moves to the left or right of
that pane, respectively.

• If the pane is at any other position, then the
pane moves to the target row. The drop shadow
of the pane as the pane is moved indicates its
new position.

Link panes a. With the two graphs open, click one to make
that pane active.

b. Click Explore > Link and then click the other
pane.

Remove linking Close one of the panes. Click Explore > Remove
Link.
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Table 13-5 Graph Options (continued)

To Do This Use This Menu Option Or Click This Icon

Delete a pane Select the graph. Click Window > Delete Pane.

Lock a pane Select the graph. Click Window > Lock Panes.

Hide a pane Select the graph. Click Window > Hide Pane.

Maximize a pane Select the graph. Click Window > Maximize
Pane.

Tile panes Select the graph. Click Window > Tile all Panes.

Zoom in on a Graph
Zoom in on part of a graph to view a particular peak or area in greater detail in both spectra and
chromatograms. Zoom in repeatedly to view smaller peaks.

Zoom In on the Y-axis
1. Move the pointer to the left of the Y-axis on either side of the area to be expanded and then

drag away from the starting point in a vertical direction while holding the left mouse button.
A box is drawn along the Y-axis representing the new scale.

Note: Take care when zooming in on the baseline. Zoom in too far and the zoom-in box
closes.

2. Release the mouse button to draw the graph to the new scale.

Tip! To return the Y-axis of the graph to the original scale, double-click either axis. To return
the entire graph to the original scale, click Explore > Home Graph.

Zoom In on the X-axis
1. Move the pointer under the X-axis to either side of the area to be expanded and then drag

away from the starting point in a horizontal direction while holding the left mouse button.

2. Release the mouse button to draw the graph to the new scale.

Tip! To return the X-axis of the graph to the original scale, double-click the X-axis. To return
the entire graph to the original scale, click Explore > Home Graph.
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Label Graphs
The preset style for labels on graphs and chromatograms can be customized. Select the fonts to
use for peak and axis labels, and the colors to use for the traces. Add axis labels and the type of
label and precision for the peaks.

Add Captions to a Graph
Use captions to label peaks of interest or significant points on the graph. A caption placed
beside a peak stays with the peak when the peak is zoomed in or out. Captions also stay with
the original sample when the user navigates between samples in a data file. A caption contains
one line of text, with a maximum of 128 characters.

1. On the spectrum, right-click, and then click Add Caption.
The Add Caption dialog opens.

2. In the Caption box, type the text.

3. To change the size and style of the caption, click Font.

4. To place the caption, click OK.

Tip! To change the position of the caption, drag it to a different position. The caption stays in
the same place relative to the X- and Y-axes when the peak is zoomed in or out. To edit or
delete the caption, right-click the caption and then click the appropriate command.

Add Text to a Graph
Use text to add multiple lines of information to a graph. Unlike captions, which are associated
with a specific peak and move with it as the user zooms the graph, text labels remain in their
original location as the user zooms the graph. They do not stay with the original sample when
the user navigates between samples in a data file.

1. On the graph, right-click and then click Add User Text.
The Add User Text dialog opens.

2. In the User Text field, type the text.

3. To center the text, select the Center Text check box.

4. To change the size and style of the caption, click Font.

5. To insert the text, click OK.

Tip! To change the position of the text, drag the text to a different position. To edit or delete
the text, right-click the text and then choose the appropriate command.
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Overlay and Sum Spectra or Chromatograms
Overlay graphs created using similar methods to visually compare two or more sets of data.
Each individual spectrum is distinguished by the color of its trace. For full scan data, this allows
the user to visualize the differences between several sample spectra.

After two or more graphs are overlaid, sum the graphs to get a new trace. Each point on the new
trace is the sum of the points from the graphs. Summing several overlays of similar data type
can make subsequent processing operations easier and faster. For example, overlay several
XICs, sum them, and then smooth the summed overlay to remove noise.

Summing overlays is similar to generating a TIC with the benefit of being able to choose which
graphs to overlay. For example, if the user is looking at ten experiments, the TIC will add all ten
experiments together. If the overlays are summed, then the user has the option of adding only
nine of the ten overlaid graphs. This is useful if the data collected in the one experiment is just
noise.

Overlay Graphs
Two or more sets of data can be visually compared by overlaying graphs created by similar
methods. Each individual spectrum is distinguished by the color of its trace. For full scan data,
this allows users to visualize the differences between several sample spectra.

If one or more panes are chosen, then each XIC opens in a separate pane.

Tip! To overlay fewer than four graphs in the same pane, press Ctrl, right-click in a pane,
and then click Appearance Options. In the Appearance Options dialog, on the Multiple
Graph Options tab, select Yes for the Overlay Multiple Panes fields for Spectrum and
Chromatogram.

1. Select the first pane to be overlaid.

2. Click Explore > Overlay.

3. Click in the second pane.

The graphs are overlaid showing the two traces in different colors.

Tip! To view a color-coded list of the overlaid graphs, right-click the title bar of the pane.

Cycle Between Overlaid Graphs
1. Select a pane that contains overlaid graphs.

2. Click Explore > Cycle Overlays.
The view changes so that the next graph in the sequence is shown in the foreground.
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Sum Overlays
1. Overlay the graphs to sum.

2. Click Explore > Sum Overlays.
The overlaid graphs are added together.

Table 13-6 Explore Toolbar Quick Reference: Overlaying Graphs

Icon Name Function

Home Graph Click to return the graph to the original
scale.

Overlay Click to overlay graphs.

Cycle Overlays Click to cycle between overlaid graphs.

Sum Overlays Click to add the graphs together.

Perform Background Subtractions
Background subtraction reduces the amount of noise in a spectrum by subtracting either
one or two ranges that contain noise from a range that contains a peak. Move the ranges
independently, or lock them and then move them as a single entity within the graph. Locked
Background Subtraction is the preset setting.

Background Subtract: Use background subtract to isolate a peak of interest. Highlight and then
subtract up to two selected ranges from the peak. Lock the ranges and then move them within
the graph to optimize peak isolation, or to isolate another peak.

Perform a Background Subtraction from a Spectrum
1. Open a data file.

2. Select a background range.
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Figure 13-8 Background Range Selected

3. Hold down the Shift key and then select another background range.

4. To set the subtract range, click Explore > Background Subtract > Set Subtract Range.

5. Select the peak of interest.

6. Click Explore > Background Subtract > Perform Background Subtract.
The background is subtracted from the peak and a new spectrum is generated.

7. To isolate another peak, drag the locked ranges in the chromatogram and repeat the
background subtract.

Note: To clear the background subtract region, click Explore > Background Subtract >
Clear Subtract Range.

8. To save the background subtracted spectrum as a processed data file, click File > Save.

Unlock the Ranges
The selected subtraction range is set to locked.
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• Click Explore > Background Subtract > Subtract Range Locked.

The ranges are unlocked and you can move each one independently.

Table 13-7 Explore Toolbar Quick Reference: Background Subtract

Icon Name Function

Perform Background
Subtract

Click to perform a background subtract after
the background ranges are selected.

Subtract Range Locked Click to lock the selected background
ranges. Unlock the background ranges to
move each range independently.

Smoothing Algorithms
Smoothing a data set removes local variations that are most likely due to noise. Several
smoothing cycles can be applied to the data, but users can only undo the most recent smooth.
Smoothing is not available for MI/MRM spectra. Choose the smooth algorithm or the Gaussian
smoothing algorithm as the preset smoothing method.

Smooth Algorithm
When this algorithm is used to smooth data, the point weighting values are set for three data
points: the current data point, the preceding data point, and the following data point. The smooth
algorithm multiplies the data points by the assigned weighting values, sums these values, and
then divides the total by the sum of the point weight values. It is a gentler smooth than the
Gaussian algorithm, and it takes a long time to smooth very noisy data.

Gaussian Smoothing Algorithm
Gaussian smoothing involves replacing each data point with the weighted average of a number
of data points on either side of it. The weighting for each new data point is calculated on the
basis of a Gaussian curve. It is a coarser smooth than the smooth algorithm, but it is good for
smoothing very noisy data.

You set two values when using the Gaussian smoothing method:

Gaussian filter width (% of minimal distance between points): This value shows the width
used to calculate the weighting of neighboring points. The width is described in terms of
percentages of the distance between two points in the scan, where the preset width of 100%
gives a distribution that is as wide as the distance between data points.
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Limit of Gaussian filter (number of minimal distance between points): This value
corresponds to the limits of the Gaussian curve, shown in multiples of the distance between
points. For example, the preset value of 10 creates a Gaussian curve that truncates after ten
data point widths on either side of the center.

Smooth Data
You can choose the Analyst MD software smoothing method or the Gaussian smoothing
method.

Tip! To undo smoothing, click Edit > Undo. The software supports one level of undo.

Smooth Data using the Smooth Algorithm
Tip! To undo smoothing, click Edit > Undo. The software supports one level of undo.

1. Select a pane containing a chromatogram or spectrum.

2. Click Explore > Smooth.
The Smoothing Options dialog opens.

Figure 13-9 Smoothing Options Dialog

3. In the Previous Point Weight field, type the weighting factor to be applied to the previous
data point.

4. In the Current Point Weight field, type the weighting factor to be applied to the center data
point.

5. In the Next Point Weight field, type the weighting factor to be applied to the following data
point.

6. Click OK.
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The data set is smoothed, replacing the current data set in the pane.

Smooth Data using Gaussian Smoothing
1. Select a pane containing a chromatogram or spectrum.

2. Click Explore > Gaussian Smooth.
The Gaussian smooth options dialog is shown.

Figure 13-10 Gaussian smooth options dialog

3. In the Gaussian filter width field, type the width used to find the weighting of neighboring
points as a percentage of the distance between the two points.

4. In the Limit of gaussian filter field, type the limit of the Gaussian curve, given in multiples
of the distance between points.

5. To smooth the data, click OK.
The data set is smoothed, replacing the current data set in the pane.

Table 13-8 Explore Toolbar Quick Reference: Smoothing Data

Icon Name Function

Smooth Click to smooth data using the smooth
algorithm.

Gaussian smooth Click to smooth data using Gaussian
smoothing.

Centroid Data
Centroiding converts peak distribution values into a single value of m/z and intensity that
represents the peak. Centroiding data collected in profile mode simplifies the data and reduces
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the file size. Centroiding provides more accurate peak assignment and reduces the amount of
data, but it also removes the information about the peak shape.

The centroiding algorithm converts peaks to single values by using an intensity weighted
average to calculate the center of gravity of the peak. The output of the algorithm is a list of
peaks with parameters, as shown in the table: Table 13-9.

Table 13-9 Peak Parameters

Parameter Definition

Centroid Value The value of the centroided data in units of mass or time.

Intensity The intensity of each peak in cps.

Width The width of the centroided peak in amu.

Data is automatically centroided when added to a library or when a search is conducted.

1. Select a pane containing a spectrum.
Centroiding data changes the appearance of the existing graph. To compare the result with
the original data, make a copy of the graph before centroiding.

2. Click Explore > Centroid.

The data is centroided.
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Figure 13-11 Analyte Centroid Location

Icon Name Function

Centroid Click to centroid data.

Save and Open Processed Data Files
Users can save processed data, such as specific layouts and captions, that can be re-opened in
Explore mode only. These files also contain relevant history information and are similar to data
files except they will contain only the data from the active pane in Explore. These files have the
pdt extension and are stored in the Data folder in the current project.

Save a Processed Data File
1. Select the pane of data to be saved.

2. Click File > Save Processed Data File.

3. In the File name field, type a name.
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4. Click Save.

Open a Processed Data File
1. In Explore mode, click File > Open Processed Data File.

The Load Processed Data File dialog opens.

2. Select a file and then click Open.

Work with Contour Plots
A Contour Plot is a color-coded plot of a complete data set that uses color to represent a third
dimension in the plot. In a Contour Plot of a TIC, the X-axis represents retention time or scan
number, the Y-axis represents mass, and the color represents the intensity of the data at that
point. In a Contour Plot of a TWC for DAD data, the X-axis represents retention time or scan
number, the Y-axis represents wavelength, and the color represents absorbance. Contour Plot is
a post-acquisition tool that does not function in a real-time scan acquisition.

Note: Contour Plot does not support MI or MRM scans, but it does support DAD scans.

Color is the third axis in Contour Plot, and it represents either intensity or absorbance. Change
the high and low intensity or absorbance values in Contour Plot using the control triangles on
the color bar above the Contour Plot. The percentage parameters at the top of the Contour
Plot pane indicate the values held by the low and high sliders. The actual values are based on
a percentage of the maximum intensity or absorbance within the selected area. The value is
shown in the top right corner of the Contour Plot pane.

The controls shown in Figure 13-12 change the colors in a Contour Plot.

Figure 13-12 Buttons Controlling Contour Plot Colors

Define the colors on a Contour Plot graph to provide better contrast and show data
specifications according to requirements. For example, setting the intensity/wavelength and
changing the color of the values for Below Low Data and Above High Data can eliminate
background noise in Contour Plot.
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The Below Low Data and Above High Data buttons shrink and expand on the color bar if the
slider controls are moved. When the contour plot colors are changed, the new colors become
the preset colors for all subsequent graphs.

View a Contour Plot
Users can view a Contour Plot from TIC, XIC, TWC, or XWC graphs only after acquisition.
TICs and XICs are available for all wiff data files. TWCs and XWCs are available only for data
acquired by a DAD.

1. In Explore mode, open a data file as a TIC, XIC, TWC, or XWC graph.

2. Highlight the range to view in the Contour Plot. If a selection is not made, then the entire
range is viewed.

3. Click Explore > Show > Show Contour Plot.
A Contour Plot of the selected area is shown in a separate pane.

Select an Area in a Contour Plot
Users can zoom in on a particular selection or view the corresponding mass spectrum for that
selection.

Do one of the following:

• To select a standard area within a box, drag the pointer to create a box around an area in the
Contour Plot.

• To make a vertical selection, press Ctrl and drag the pointer vertically.

• To make a horizontal selection, press the space bar and drag the pointer horizontally.

Set the Intensity and Absorbance in a Contour Plot
Do one of the following:

• To set the low intensity/absorbance value in Contour Plot, drag the left triangular slider from
the color bar above the Contour Plot to the required position.

Contour Plot automatically adjusts the color of values below the setting to indicate they are
outside the range.

• To set the high intensity/absorbance value in Contour Plot, drag the right triangular slider from
the color bar above the Contour Plot to the required position.

Contour Plot automatically adjusts the color of values above the setting to indicate they are
outside the range.
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Change Colors in a Contour Plot
1. In the Contour Plot pane, click one of the color buttons.

The Color dialog opens.

2. Click a color, and then click OK.

The graph changes to reflect the color change.

Tip! Use the Define Custom Colors palette to create customized colors for use in a
Contour Plot.

Fragment Interpretation
The Fragment Interpretation tool helps the user interpret MS/MS data. The Fragment
Interpretation Tool generates a list of theoretical fragment masses from single, non-cyclic bond
cleavage of a molecular structure. The molecular structure can be created in a third-party
drawing program and then saved as a mol file. The tool can then match the theoretical list with
peaks in the current mass spectrum. Fragment Interpretation shows the theoretical fragments
in the fragment list and compares the fragment masses to peaks in the mass spectrum. Peaks
above the threshold intensity and within the user-defined mass tolerance (maximum 2 Da) of
fragment masses are considered matched and are shown in bold text in the fragment list.

Note: The Fragment Interpretation tool cannot be used with the following scan types:

• Precursor Ion

• Neutral Loss

• Q1 Multiple Ion

• Q3 Multiple Ion

• Multiple Reaction Monitoring (MRM)

Work with the Fragment Interpretation Tool
If multiple spectrum panes are viewed, then the Fragment Interpretation tool connects to the
active spectrum. If the data file contains more than one sample, then the Fragment Interpretation
tool connects to the active spectrum.

The tool automatically calculates the single, non-cyclic bond cleavage fragments from a mol file.
When the Fragment Interpretation tool is connected to a spectrum, theoretical fragments in bold
text, indicate a matching peak in the spectrum within the specified mass tolerance and intensity
threshold.
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When a single, non-cyclic bond is selected in the molecular structure, the Fragment
Interpretation tool highlights the two fragments created when the bond is cleaved, and then
shows matching peaks in the connected spectrum.

Connect the Fragment Interpretation Tool to a Spectrum
If a spectrum is open when the Fragment Interpretation tool is opened, then the active panel
links to the open spectrum automatically.

1. Click Explore > Show > Show Fragment Interpretation Tool.

2. From the lower right corner of the Fragment Interpretation pane, click the connect button.
The pointer changes to the connecting tool.

3. Click the spectrum graph to be connected to the Fragment Interpretation tool.
The connected graph indicator in the lower left corner contains the name of the graph
connected to the Fragment Interpretation pane. The connection is broken when either the
graph or Fragment Interpretation is closed. If the connected wiff file has more than one
sample, then the Fragment Interpretation pane updates automatically as the user scrolls
through the samples.

Match Fragments with Peaks
1. Click Explore > Show > Show Fragment Interpretation Tool.

2. With a mol file in the Fragment Interpretation pane, select a cell in the Fragment List that is
shown in bold.

In the spectrum, the software highlights the matching spectral peak in the color selected
under the Options tab. In the molecular structure, the bond is highlighted.

If a row that has more than one matching fragment is clicked, then the spectral peak that is
closest to its monoisotopic mass is highlighted in the mass spectrum in the color specified in
the Options tab.

Select a Bond in a Molecular Structure
1. Click Explore > Show > Show Fragment Interpretation Tool.

2. With a mol file opened in the Fragment Interpretation pane, click a single, non-cyclic bond in
the molecular structure.
The two resulting fragments are shown as highlights in the fragment list. The masses of the
two fragments are shown on either side of the bond.
If a spectrum is connected, then the Fragment Interpretation tool shows any matching peaks
in the graph. If a fragment in the list is selected and the fragment is matched to a peak, then
the Fragment Interpretation window zooms in on that peak.
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View Isotopes
The Fragment Interpretation tool can show the theoretical isotopic distribution for a peak
matching a fragment in the fragment list.

1. Click Explore > Show > Show Fragment Interpretation Tool.

2. In the Fragment Interpretation pane, click the Options tab.

3. Select the Show Isotopes check box.

4. Click Apply.

5. From the Fragment List, select a fragment that matches a peak.
The isotopic distribution for matched peaks is shown in the spectrum.

Show Formula Differences for Fragments
The formula and monoisotopic mass difference between two related hypothetical fragments can
be shown in the software. The formula difference is shown when two peaks are selected. The
formula and monoisotopic mass difference is shown when two fragments are selected, or when
two single, non-cyclic bonds are selected.

Show a Formula Difference in a Spectrum
1. Click a fragment peak.

2. Press Shift and then click another fragment peak.
If the formula difference is equal to a fragment from the fragment list, the fragment highlights
in the list. Otherwise, the formula difference between the matching fragments of the peaks is
shown in a message box.

Show a Formula Difference in the Fragment List
1. Click the row number for one fragment.

2. Press Shift and then click another fragment peak.
The formula and monoisotopic mass difference is shown in a message box if the fragments
are related.

Show a Formula Difference in a Molecular Structure
1. Click a single, non-cyclic bond. The default fragment (of the two highlighted fragments) is

selected. To select the other fragment of the cleaved bond, press Ctrl and then click the
bond.
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2. Select a second non-cyclic bond. To select the default fragment, press Shift and then click
the bond. To select the other fragment of the cleaved bond, press Ctrl+Shift and then click
the bond.
Fragment Interpretation calculates the formula and monoisotopic mass difference between
the fragment selected in step 1 and the fragment selected in step 2, if the fragments are
related. The formula and monoisotopic mass difference is shown in a message box.

Library Databases
The Library Search feature compares unknown spectra to known MS spectra contained in the
library database and generates a list of possible matches.

Use Library Search to do the following:

• Compare library contents against an unknown spectrum.

• Add records to the library.

• Edit existing records.

Library data is stored in the following locations:

• MS Access on a local database

• MS SQL Server

Before using the Library Search feature, locate where the library data is stored and then connect
the computer to that location. Library databases can be stored locally on the computer or on a
server and accessed over a network.

Switch between Existing Library Databases
Users can connect to any databases that have aliases that are already set up.

1. Click Tools > Settings > Optimization Options.
The Optimization Options dialog opens.

2. Click the Library Manager tab.
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Figure 13-13 Library Manager Tab

3. In the Available Libraries section, click the alias of the database to connect to and then
click Connect.

4. To allow other users to access the database, select the Available to all users of this
machine check box.
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5. Click OK.

Connect to a Local Library Database
1. Click Tools > Settings > Optimization Options.

The Optimization Options dialog opens.

2. Click the Library Manager tab.

3. In the Available Libraries section, click New.

Figure 13-14 Add Library Dialog
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4. Type a name for the library.

5. In the Database Information section, select MS Access (local).

6. Type the database location.

7. In the Security Information section, if a user name and password are required to access
this database, then type the user name and password.

8. Click Save.

Connect to a Server Library Database
1. Click Tools > Settings > Optimization Options.

The Optimization Options dialog opens.

2. Click the Library Manager tab.

3. In the Available Libraries section, click New.

4. Type a name for the library.

5. In the Database Information section, select MS SQL Server (server).
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Figure 13-15 Add Library Dialog

6. Type the name of the database server.

7. Type the name of the database.

8. Do one of the following in the Security Information section:

• If a specific user name and password are required to access this database, then type the
user name and password.

• To use Windows security, select the Use Windows integrated security option.

9. Click Save.
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Work with Library Records
If the library contents are searched without constraints, then all records are listed. If the
library contents are searched with constraints, then only those records that match the specified
constraints are listed. The number of records shown depends on the number of constraints
selected. If many restraints are selected, then few records are listed.

View all Library Records
Click Explore > Library Search > List.
The Librarian dialog opens with all records in the database.

Search Library Records with Constraints
1. Click Explore > Library Search > List With Constraints.

Figure 13-16 List Constraints Dialog

2. In the Field Name list, select a field on which you want to base a constraint.
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3. In the Relation list, select the relation (operator) that applies to the field name.

4. In the Value field, type the value of the field name based on the relation.

5. To add the selected constraint to the Conditions list, click Add.

6. Continue adding constraints to the conditions list as required.

7. Coupling distinct constraints within the Conditions list creates more specific conditions that
enhance the search.

• To group constraints, select the constraints and then click Group.

• To separate grouped constraints, click the group, and then click Ungroup.

8. To change the relationship between constraints, click the relationship, and then click And or
Or.

9. To exclude compounds containing a certain number of atoms of specific elements, select or
type the elements in the Elements Included table, and then type a minimum and maximum
number of atoms of the element.

Note: Element symbols are case-sensitive. For example, Hydrogen is H, not h and Sodium
is Na, not NA or na.

10. To exclude compounds containing certain elements, select or type the elements in the
Excluded table.

11. To search for compounds fitting your criteria, click List.
Records that match all the constraints are shown in the Records table. Listing constraints
are saved.

Add a Record to the Library
1. Right-click an active spectrum, and then click Add a Record.

The spectrum will be centroided automatically if it has not been centroided already.
The Add a Record dialog opens with data from the spectrum.

2. On the Mass Spectral Information tab, type a name in the Compound Name field. The
compound name is mandatory and must uniquely identify the compound within the library.

3. Edit any of the other fields. Many of the fields are filled in automatically from the data
associated with the spectrum.

4. Click the General Information tab, edit the fields as required, and then click OK.

Search for a Similar Spectrum
Users can search the library for a spectrum (and its related compound information) that matches
(or is similar to) an active spectrum. Searches can be performed with or without constraints.
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When searches are performed with constraints, only those records that match all the criteria are
listed. The results are shown in a ranked list. The first item on the list is the best fit to the active
spectrum. Entries lower in the list do not match as well.

The more constraints selected, the more precise the list becomes and fewer, more relevant
matches are listed. After a set of constraints is defined, they will apply to all subsequent
searches, unless they are edited.

Only peaks above the threshold are used in the search. When selecting search constraints,
peaks can be added or removed from the active spectrum. For example, if a peak is considered
to be background or noise spike, then it should not be used in the search because it could
produce inaccurate results.

When searches are preformed without constraints, a much larger list of suggested spectra is
returned because the library makes fewer specific matches to the spectral data.

Search for a Similar Spectrum
1. Right-click on an active spectrum and then click Search With Constraints.

The software will centroid the spectrum automatically, if required.
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Figure 13-17 Search Constraints Dialog

2. In the Maximum Number of Match field, type the maximum number of compounds to be
returned by the search.

3. In the Preselect Constraints section, select the check boxes for the constraints to apply.

4. For each constraint selected, in the Preset Tolerance section, type the tolerance.
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5. If required, select a method of sorting records from the Result Sorted by list.

6. If required, type text in the Comment Contains field.

7. If required, type text in the Keyword Contains field.

8. To apply peak constraints by adding and removing peaks, click Peak Constraints.
The Peaks Included table opens.

9. To add peaks to the list you want to search against, click Add and then type the m/z and the
corresponding intensity in the empty cell.

10. To remove peaks so they will not be included in the search, select the peaks to exclude in
the search and then click Remove.

11. Click Search to save the constraints and begin the search.

View a Compound from the Search Results
If several spectra match the unknown spectrum, then other spectra can be viewed and
compared to the unknown.

1. In the Search Results dialog, in the list of compounds, select the row number of the
compound.

2. Click the spectrum pane of one of the known compounds.
The spectrum of the selected compound opens.

Library Search Tips
To Do This Do This

Library searches:
To group
conditions

Select the conditions to group and then click Group. This function behaves
like parentheses in formulas.

Library searches:
To search without
using constraints

Right-click an active spectrum, and then click Search Library. The Search
Results dialog opens.

Table-specific
queries: To view
the entire table
again

Right-click anywhere in the Results Table and then click Query > Show All.
You Queries can be applied again or edited.

It is recommended that the user validate any queries that are used to
analyze data in a Results Table.
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To Do This Do This

Peak Integration:
To review peaks

To review all peaks, make sure that all samples are listed in the Results
Table.

The Peak Review window contains the peaks listed in the Results Table. If
some samples are hidden in the table (for example, if a query was applied),
then they are also hidden in peak review.

It is recommended that the user validate any queries that are used to
analyze data in a Results Table.

Peak Integration:
To move to the
first peak in the
batch

Right-click anywhere in the Peak Review pane and then click Show First
Page. To move to the last peak in the batch, right-click anywhere in the
Peak Review pane and then click Show Last Page.

To examine
calibration curves

Right-click anywhere in the curve, click Active Plot, and select the curve to
be plotted on top.

Sample statistic
review: To review
an individual
peak

Select the Display the Data Set(s) check box, and then, in the Data Point
column, double-click the data point that represents the peak. The software
shows the Peak Review window with the selected peak.

Results Tables:
To return the
Results Table to
its original order

Right-click on the Results Table and click Sort > Sort By Index.

Acquisition
Methods: To
create an
acquisition
method from the
file information
pane

Right-click the file information pane and then click Save Acquisition
Method.
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Operating Instructions — Analyze
and Process Quantitative Data 14
This section describes how to use the Analyst MD software to analyze and process quantitative
data. Data can also be processed using the MultiQuant MD software. We recommend that the
MultiQuant MD software be used to quantitate data. Refer to the documentation that comes with
the MultiQuant MD software.

Use the sample files found in the Example folder to learn how to select samples for quantitation,
how to select preset queries and create table-specific queries, and how to analyze the acquired
data. For more information about the following topics, refer to the document: Advanced User
Guide.

We recommend that the user validate any queries that are used to analyze data in a Results
Table.

• Metric Plots

• Layout of a Results Table

Quantitative Analysis
Quantitative analysis is used to find the concentration of a specific substance in a sample. By
analyzing an unknown sample and comparing it to standard samples, that is, samples containing
the same substance with known concentrations, the software can calculate the concentration
of the unknown sample. The process involves creating a calibration curve using the signal
response or response ratio of the standards and then calculating the concentrations of the
unknown samples. The calculated concentrations of all of the samples are added to a Results
Table.

Quantitative analysis is most commonly performed using a Multiple Reactions Monitoring (MRM)
scan. In an MRM scan, a precursor ion and a characteristic product ion are used to define
an MRM transition that is highly specific to the analyte. The MRM transition, coupled with the
retention time associated with the analyte during liquid chromatography, provides the specificity
required for quantitation.

Quantitation is accomplished through the use of validated MRM LC-MS/MS acquisition methods,
acquisition of calibration standard curves, and the subsequent integration of the peaks
associated with the compounds of interest. The calibration curve relationship between signal
response and concentration is used to determine the quantity of a particular analyte in an
unknown sample.
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Quantitation Methods
A quantitation method is a set of parameters used to generate peaks in a sample. The
quantitation method can include parameters used to locate and integrate peaks, generate
standard curves, and calculate unknown concentrations. A previously saved quantitation method
can be selected from the Quantitation menu in the batch.

Three tools can be used to create a quantitation method: the Quantitation Wizard, the Build
Quantitation Method, and Quick Quant.

Build Quantitation Method
The Build Quantitation Method does not generate a quantitation Results Table, although the
method can subsequently be used in the Quantitation Wizard to create a Results Table. The
Build Quantitation Method can also be used to change existing quantitation methods. This is the
most flexible way of creating a quantitation method. Refer to the section: Create a Method Using
the Quantitation Method Editor.

Quantitation Wizard
The Quantitation Wizard generates a Results Table at the same time as the quantitation method.
Alternatively, an existing quantitation method can be used to quantitate different sets of data.

Quick Quant
Quick Quant is not recommended for quantitation of results.

Quick Quant is part of the Batch Editor. Use Quick Quant to add compound concentrations
before acquiring data. Because a sample has not been acquired, a representative sample
cannot be selected, nor can peaks be reviewed. With this feature, only the method components
are defined.

Do not use the automatically generated Quick Quant method to perform quantitation if the Quick
Quant feature is used to store sample types and concentrations in the data file. This quantitation
method does not use compound and sample-specific integration parameters that have been
optimized for peak selection.

To use a previously saved quantitation method, select it from the Quantitation menu in the
batch. For instructions on creating a batch, refer to the section: Create and Submit a Batch.
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Quantitation Methods and Results Tables
For the following procedures, use the sample data that is installed in Example/Triple Quad
folder. The folder contains the data files, Mix_Batch_1 and Mix_Batch_2. These sample files
are used to demonstrate the usefulness of metric plots to isolate problematic samples. The ions
scanned were reserpine (609.3/195.0), minoxidil (210.2/164.2), tolbutamide (271.1/91.1) and
rescinnamine (635.3/221.2), which is the internal standard. Mix_Batch_1 contains no errors, but
Mix_Batch_2 contains a QC sample to which the internal standard was added twice (sample
QC2).

Create a Method Using the Quantitation Method Editor

Note: We recommend that the user validate any queries that are used to analyze data in a
Results Table.

Prerequisites

• Select the project or subproject that contains the data to be quantified. Refer to the section:
Change Between Projects and Subprojects

1. Make sure that the Example project is selected.

2. On the Navigation bar, under Quantitate, double-click Build Quantitation Method.
The Select Sample dialog opens.

3. Double-click the Triple Quad folder in the Data Files list.

4. Select Mix_Batch_2. wiff.
The samples in the selected data file are shown in the Samples list.

Note: If the Compound ID field was populated for the samples and internal standards in
the acquisition method, then in the Internal Standards table, when a value is selected in the
Q1/Q3 field, the Name field is automatically populated.

5. Select a sample that provides a detectable signal to select integration parameters that fit the
entire batch and then click OK.

6. In the Internal Standards table, in the Name column, select rescinnamine. In Q1/Q3
column, select 635.3/221.2.

7. In the Analytes table, do the following:

a. In the Name column, select minoxidol for the Q1/Q3 column masses of 210.2/164.188,
tolbutamide for 271.3/91.146, and reserpine for 609.4/195.039.

b. In the Internal Standard column, from the list, select the rescinnamine as internal
standard to be associated with each analyte.
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c. Delete 635.4/221.185 from the Q1/Q3 column in the Analytes table.

Note: If the Compound ID field was populated for the samples and internal standards in
the acquisition method, then in the Analytes table, the Name field and Q1/Q3 field are
populated.

8. Open the Integration tab.
The preset integration parameters are suitable for most peaks.

9. If the integration is not suitable, then change the algorithm. Refer to the section: Manually
Integrate Peaks.

10. Click Show or Hide Parameters ( ) to show the additional integration algorithms.

11. Open the Calibration tab.
The preset parameters are suitable for these samples. User can change the fit, weighting,
and regression parameter depending on the specific applications.

12. Save the quantitation method.
The new method can be used when a batch is created in the Batch Editor or when the
Quantitation Wizard is used to generate a Results Table.

Tip! The quantitation method can only be used in the current project unless it is copied
to another project. To do this, click Tools > Project > Copy Data. A new project must be
created and selected to be available for use.

Create a Results Table Using the Quantitation Wizard

Note: We recommend that the user validate any queries that are used to analyze data in a
Results Table.

Prerequisites

• Select the project or subproject that contains the data to be quantified. Refer to the section:
Change Between Projects and Subprojects

1. On the Navigation bar, under Quantitate, double-click Quantitation Wizard.
The Create Quantitation Set - Select Samples page opens.

2. In the Available Data Files list, double-click the Triple Quad folder.

3. Select Mix_batch_2. wiff.

4. Click Add All.

Note: We recommend that users do not process or report results from any sample for which
acquisition was abnormally or unexpectedly terminated.
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5. Click Next.
The Create Quantitation Set - Select Settings & Query page opens.

6. Click Select Existing: Query in the Default Query section.

7. Select Accuracy 15% from the Query list.

Note: To create a query at the same time, refer to the section: Create a Standard Query
(Optional).

Note: It is the responsibility of the user to evaluate and validate the query to be used for
specific applications.

8. Click Next.
The Create Quantitation Set - Select Method page opens.

9. Click Choose Existing Method.

10. Select PK Data_Mix.qmf from the Method list.

11. Click Finish.
The Results Table opens.

Tip! To add or remove samples in the Results Table, click Tools > Results Table > Add/
Remove Samples.

12. Review the sample type, actual concentration, peak integration, calibration curves, statistics
pane, metric plot for the internal standard, and other information related to data quantitation.

13. Save the Results Table.

Note: We recommend that users do not change datafile (wiff) names if a Results Table
includes samples from that file.

Tip! Well-formatted reports can be created from a Results Table using the Reporter
software. We recommend that the user validate the results if a Reporter template that
contains a query is used. Refer to the section: Reporter Software.

Create a Standard Query (Optional)
Advanced users can create a query and a standard query numerous ways. The following is one
example. For more information about creating queries, refer to the document: Help.

We recommend that the user validate any queries that are used to analyze data in a Results
Table.

1. On the Navigation bar, under Quantitate, double-click Quantitation Wizard.
The Create Quantitation Set - Select Samples page opens.
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2. Select samples to be used as part of the quantitation set.

3. Click Next.
The Select Settings & Query page opens.

4. In the Default Query section, select Create New Standard Query.

5. Type a query name.

Figure 14-1 Create Quantitation Set — Select Settings & Query Page

6. Click Next.

Operating Instructions — Analyze and Process Quantitative Data

SCIEX 4500MD Systems
206/313

System User Guide
IVD-IDV-05-6996-D



Figure 14-2 Create Quantitation Set — Create Default Query Page

7. In the Maximum Allowed Accuracy Variation for QCs (%) table in the Max. Variation
column, type the maximum allowable percent of variation for each QC, for example 5 is
± 5%, in the same row as the corresponding concentration. If the concentrations were
not specified during acquisition, then they are not shown. In this case, type them in the
Concentration column.

8. In the Maximum Allowed Accuracy Variation for Standards (%) table, in the Max.
Variation column, type the maximum allowable percent of variation for each standard,
for example 10 is ±10%, in the same row as the corresponding concentration. If the
concentrations were not specified during acquisition, then they are not shown. Type the
concentrations in the Concentration column.

9. Click Next.
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Figure 14-3 Create Quantitation Set — Select Method Page

10. Select or create a method.

11. Click Finish.
The query is applied as a standard query. The query results are shown as a Pass or Fail
entry in the Standard Query Status column of the Results Table.

Tip! To return to the full view, right-click and then click Full.

Define the Layout of Results Tables
Predefined views of the Results Table are available.

Right-click in the Results Table and then click one of the following:

• To view the Full layout, click Full.

All the analytes are shown.

• To view the Summary layout, click Summary and then click a field name.

• To view the Analyte layout, click Analyte and then click a single analyte if more than one
analyte exists.

• To view the Analyte Group layout, click Analyte Group and then click an analyte group.
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Tip! A new analyte group must be created first. To do this, right-click in the Results Table and
then click Analyte Group > New.

Tip! To go back to the full view, right-click and then click Full.

The table is shown with the selected layout.

Sort Data in Results Tables
Data in a Results Table can be sorted in the following ways:

• Quickly sort the table on one to three columns, using one of the Sort buttons. This sort criteria
cannot be saved.

• Create a table-specific sort to save the sort criteria with the current table. Table-specific sorts
allows the user to sort the current table on one to three columns and save the criterion for use
with that table.

• Use a previously created preset sort. Users can create and save a sort and then later apply it
to a Results Table.

Tip! To save a sort or any other table setting, right-click in the table and then click Table
Settings > Export To New Table Settings. The sort and other parameters can be used in the
current project. To use the table settings in a different project, copy it to another project. Click
Tools > Project > Copy Data. A new project must be created and selected to be available for
use.

Sort a Results Table
1. Select up to three columns in the Results Table in the order to be sorted.

2. Do one of the following:

• To sort in ascending order, click A-Z.

• To sort in descending order, click Z-A.

Sort a Results Table and Save the Sort Criteria
1. Right-click in the Results Table and then click Sort > New.
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Figure 14-4 Sort Dialog

2. In the Name field, type the name for the new sort.

3. For each sorting rule, in the Sort By and Then By sections, do the following:

• In the Group list, select the type of column to sort on.

• In the Column list, select the column to sort on.

• Select the direction of the sort: Ascending or Descending.

4. Do one of the following:

• To perform the sort, save the sort criteria, and close the Sort dialog, click Save/Execute.

• To perform the sort and close the Sort dialog without saving the sort criteria, click
Execute.

Save Default Sort Criteria for Future Results Tables
1. Click Tools > Settings > New Quantitation Results Table Settings.
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Figure 14-5 Table Settings Dialog

2. Expand the Table Settings folder and then double-click the Default folder.

3. From the expanded Default folder, select the Sorts folder, and then click New.
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Figure 14-6 Sort dialog

4. In the Name field, type the name for the new sort.

5. For each sorting rule, in the Sort By and Then By sections, do the following:

• In the Group list, select the type of column to sort on.

• In the Column list, select the column to sort on.

• Select the direction of the sort: Ascending or Descending.

6. To save the criteria and close the Sort dialog, click OK.

7. To close the Table Settings dialog, click Done.

Sort a Results Table using Preset Sort Criteria
• Right-click in the Results Table, click Sort and then select the name of the sort.

Peak Review and Manual Integration of Peaks
Use peak review to survey the peaks that the software has identified and then redefine the peak
or the start and end points where required.
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After identifying the analytes and internal standards that the software must find, the software
searches for the peaks in the samples. When the software identifies a peak, it shows the
chromatograms for each analyte and internal standard in the Create Quantitation Method: Define
Integration page of the Standard Wizard or on the Integration tab of the Full Method Editor. The
user can confirm the peaks that are found or change the quantitation method to better define the
peaks. We recommend that users manually review all integration results.

For information on using the Peak Review right-click menu, refer to the section: Peak Review.

Review Peaks
During peak review, the user might want to view a peak in its entirety or to examine the baseline
to find out how well the software found the start and end points of the peak. The automatic
zooming feature can be used to do either.

To help the software find a peak, define the exact start and end points of the peak and
background manually. These changes will apply only to that individual peak unless the global
method is updated.

Note: We recommend that manually integrated results be validated.

Tip! To review an individual peak, right-click on a point on the curve and then click Show Peak.
The software opens the Peak Review window with the selected peak.

1. Right-click the Results Table and then click Analyte.

2. Select an analyte.

3. Click Tools > Peak Review > Pane.
The peaks are shown below the Results Table with only the peaks listed in the Results
Table.
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Figure 14-7 Peak Review

4. Right-click the pane and then click Options.
The Peak Review Options dialog opens.

5. In the Appearance section, change Num. rows to 1 and Num. columns to 2.

6. In the Automatic Zooming section, click Zoom Y axis to: 100% of largest peak to show
the entire peak.
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Figure 14-8 Peak Review Options Dialog

Item Definition

1 Number of rows

2 Number of columns

3 Zoom Y-axis to 100% of largest peak to show the entire peak

7. Click OK.

8. To move through the peaks, click the right-pointing arrow. Refer to the figure: Figure 14-9.

9. Go to the second injection of standard 3.
In this example, the peak can be integrated closer to the baseline by selecting the Specify
Parameters option.

Tip! To move to a specific peak in the Peak Review pane, select the corresponding row in
the Results Table.
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Figure 14-9 Peak Review Pane

Item Definition

1 Arrows: Click to move through the peaks.

2 Show or Hide Parameters: Click to show the integration parameters.

3 Integration parameters: Click to change the parameters.

4 Noise Percentage: Type a noise percentage.

5 Apply: Click to integrate the parameters.

10. Click Show or Hide Parameters twice.

11. Click Specify Parameters - MQ III.

12. Change the Noise Percent value.

13. Click Apply.
The peak is integrated closer to the baseline.

14. If the change does not improve the peak integration, then adjust the Noise Percent
parameter until the optimal value is found.

Note: The Update Method option only updates the algorithm values for that specific analyte
(or internal standard) and not all analytes.

15. To update the algorithm for all peaks, right-click in the pane and then click Update Method.
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Figure 14-10 Update Method

Manually Integrate Peaks
Manually integrating peaks should be done last, to limit person-to-person variability. Manually
integrate peaks only if all the peaks have not been found after the algorithm parameters have
been adjusted and updated. We recommend that users validate the results to determine whether
manual integration is acceptable for specific applications.

Note: Peaks that are manually integrated, or where the algorithm was changed for only that
peak, are identified in the Record Modified column of the Results Table, as are peaks that have
algorithm parameter changes for a sample that are not applied to the entire analyte group.

1. In the Peak Review pane, click Manual Integration Mode.

Figure 14-11 Peak Review Pane: Manual Integration Mode

2. Zoom in on the lower 10% of the peak.
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Figure 14-12 Peak Review Pane: Zooming in on a Peak

3. Move the cross-hair to where the start of the peak is to be defined and then drag the
cross-hair to where the end of the peak is to be defined.
The software shades the area bounded by the base and sides of the peak. Peak parameters
are gray because they are no longer applicable because the peak was drawn manually.

4. Do one of the following:

• To make this change permanent, click Accept.

• To discard the changes, clear the Manual Integration check box.

Tip! If a peak was correct as originally selected, right-click the peak and then click Revert to
Method.

Calibration Curves
Use calibration curves to find the calculated concentration of samples, including quality control
(QC) samples. QC samples are added to a batch to estimate the data quality and accuracy
of standards in the batch. QC samples have known analyte concentrations but are treated as
unknowns so that the measured concentrations can be compared to the actual value.

The calibration curve is generated by plotting the concentration of the standard against its area
or height. If an internal standard is used, then the ratio of the standard concentration or internal
standard is plotted against the ratio of the standard peak height or area to the internal standard
peak height or area. The area or height ratio of a sample is then applied to this curve to find the
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concentration of the sample, as shown in the Results Table. A regression equation is generated
by this calibration curve according to the regression that was specified. The regression equation
is used to calculate the concentration of the unknown samples.

Linear regression is recommended for the calibration curve.

We recommend that the user does not report quantitative values that fall outside the
concentration range covered by the calibration curve.

For information on using the Calibration Curve right-click menu, refer to the section: Calibration
Curve.

View Calibration Curves
The user can view the calibration curve and change the regression options in an open Results
Table. If two or more Results Tables are open, then the calibration curves can be overlaid. To
overlay curves, make sure that the method used to create the tables is the same.

Plot a calibration curve to see the curve used for regression. The Calculated Concentration
column in the Results Table reflects any changes resulting from the fit of the curve to the points
of the standard.

Note: This option is available only when a Results Table is open.

1. Open a Results Table.

2. Click Tools > Calibration > Pane.
The Calibration Curve pane containing the calibration curve opens.

Figure 14-13 Calibration Curve

3. If there is more than one analyte, then use the following steps to view the calibration curve
for another analyte:

a. From the Analyte list, select an analyte.
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b. If required, from the next list, select Area or Height.

4. To change the regression options for the calibration curve, do the following:

a. Click Regression.

Figure 14-14 Regression Options Dialog

b. Select Linear in the Fit list.

c. Select 1 / x in the Weighting list.

d. Click OK.

The calibration curve opens. The user can review individual peaks on the curve or exclude
points from the curve to produce a better curve.

5. If required, repeat these steps to create a more appropriate curve.

6. To save the changes, click Accept.

Overlay Calibration Curves
Tip! To examine the curve for one table more closely, right-click the curve and then click Active
Plot. Select the curve to be plotted on top.

1. With two or more open Results Tables, view a calibration curve for one of the tables.

2. Right-click the calibration curve and then click Overlay.
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Figure 14-15 Overlay Dialog

3. Select the tables to overlay with the current curve.

4. Click OK.
The software plots the curves for all selected tables on the same graph.

Sample Statistics
Use the Statistics window to view the statistics for samples, typically for standards and quality
controls (QCs). The data from each available batch in the Results Table opens in tabular form in
the grid and a row of data is shown for each standard or QC concentration.

We recommend that batch statistics be included in reports to be sure of the validity of the
results.

View the Statistics for Standards and QCs
When more than one Results Table is open, statistical information about the standards and
QCs for additional batches can be shown in the Statistics window. This facilitates comparison of
results between batches and identification of trends in the standards or QCs.

1. Open a Results Table.

2. Click Tools > Statistics.

3. Select Concentration from the Statistics Metric list.

4. Select an analyte in the Analyte Name field.

5. Select Standard in the Sample Type field.
The results are shown.

6. Examine the %CV and Accuracy columns.
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The %CV shows the coefficient of variance between the measurements of a single
parameter, for example the area. Accuracy shows how close the plotted point is to the
interpolated value.

7. If required, select the Display Low/High values check box and then examine the Low,
High values, and Mean for each row in the grid. Each row represents standards that have
the same concentration levels.

8. Select another analyte.
The results are shown on a per-analyte basis.

9. To check for quality control (QC) variations at the same concentration levels, select QC in
the Sample Type field.

Metric Plots
A metric plot graphically shows the data in a Results Table column plotted against the X-axis or
the Y-axis, or the data in two columns plotted against each other. This section describes how to
generate and work with metric plots.

A few predefined metric plots are also included:

• Int_Std_Response (to locate problem sample)

• Analyte_Area versus Height (to verify chromatography behavior)

• PK profile (conc. versus time point, to run after Sample query)

Generate Metric Plots
Use metric plots to plot a given column, such as Analyte Peak Area, Accuracy, or Calculated
Concentration, from the Results Table. Two Results Table fields can also be plotted against
each other and the plot then used to investigate points that are shown outside of the normal
range. Metric plots are often used with queries. For more information about queries, refer to the
document: Help.

Generate metric plots in the following ways:

• Use the Plot button to plot a column or columns of the current Results Table, but not save the
plotting criteria.

• Create a table-specific plot to save the plot criteria with the current table.

• Create a global plot to save the plotting criteria for use with future Results Tables.

QC, unknown, blanks, double blanks, or solvents are not shown on the calibration curve, but
metric plots of them can be generated.
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Figure 14-16 Example of a Metric Plot

Item Description

1 Double blanks

Generate a Metric Temporary Plot
1. With a Results Table open, do one of the following:

• To plot the data on the Y-axis with the X-axis as an index, click the heading of the column
for the data to be plotted.

• To plot the data from the first selected column on the X-axis and the second selected
column on the Y-axis, select two columns by pressing the Ctrl key and then clicking the
column headings.

2. Above the Results Table, click the Metric Plot by Selection icon. Refer to Table D-9.
The metric plot opens.

3. Right-click in the plot pane and then click Data Legend to view an explanation of the colors
used by the plot.

4. Right-click in the plot pane and then click Point Legend to view an explanation of the
symbols used by the plot.

Generate a Metric Plot and Save the Plot Criteria
1. Open the appropriate Results Table.

2. Right-click in the Results Table and then click Metric Plot > New.
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Figure 14-17 Metric Plot Dialog

3. In the Name field, type the name for the new plot criteria.

4. In the X-Axis section, in the Group list, to plot a field in the Y-axis using the X-axis as an
index, select Index and leave the Column list blank.

5. To plot two columns against each other, in the Y-axis section, in the Group list, select
Internal Standard, and then, in the Column list, select IS Peak Area.

6. If required, in the Regression list, select the type of regression to use, and then select the
appropriate regression settings.

7. To generate the plot and save the plot criteria, click Save/Execute.
The metric plot opens. For more information, refer to Figure 14-16.

8. Right-click in the plot pane and then click Data Legend to view an explanation of the colors
used by the plot.
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9. Right-click in the plot pane and then click Point Legend to view an explanation of the
symbols used by the plot.
This set of criteria is now available for future plots of this Results Table in the right-click
menu of the Results Table. Users can also edit the plotting criteria.

10. To view the problem sample, try plotting the concentration of the unknown against time or
plotting the area of the internal standard against the index.

Save Default Plot Criteria for Future Results Tables
1. Right-click in the Results Table and then click Table Settings > Export To New Table

Settings.
This will export the table settings from the rdb so that it can be reused in other quantitation
runs within the project.

2. To export table settings to another project, click Tools > Project > Copy Data.

Figure 14-18 Copy Data Dialog
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Reporter Software 15
The Reporter software extends the reporting functionality available in the Analyst MD software.

CAUTION: Potential Wrong Results. To avoid incorrect results:

• Validate all Reporter queries before using them.

• Validate the results if a modified Reporter template or one that contains a query is
used.

• Make sure that validation is completed on Reporter templates.

The Reporter software can be used to create custom reports with Microsoft Word and Excel
(2013, 2016, or Office 365). The Reporter software has the following features:

• Provides a variety of reports that use the data available in a Results Table, in file information,
and in quantitative peak review windows.

• Provides a variety of reports that present MS/MS library search results. The user can
configure the Reporter software to search against any MS/MS spectral library that uses the
Analyst MD software (mdb) format.

• Uses Microsoft Word templates to provide the format information needed when generating
reports. These templates can be created or modified to provide customized report formats.
For information about creating or editing the Report Template Editor refer to the document:
Help.

• Contains a blank starting template that can be used in the Reporter software editing
environment to design report templates to meet most reporting requirements.

• Automatically prints, exports to Adobe Portable Document Format (pdf), and delivers results
by e-mail.

• Generates reports from custom software applications that use the available Analyst MD
software programming libraries.

Reporter software can be used as follows:

• Within the Analyst MD software to manually generate a report or set of reports.

• By applications that do not use the Analyst MD software.
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Analyst Reporter User Interface
Figure 15-1 Analyst Reporter

Item Option Description

1 File > Exit Exits the program and releases all resources.
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Item Option Description

2 Settings > Select
Output Language

Sets the language dictionary that will be used to
replace language tags within a report template. Templates
that contain language tags can be used to generate
reports in any language. The language tags are
replaced with text from a matching tag in the dictionary
file for the selected language. These dictionary files
are contained in the folder: C:\Program Files\AB
SCIEX\AnalystReporter\Resources\Languages
on Windows 7, 32- bit operating
systems or C:\Program Files (x86)\AB
SCIEX\AnalystReporter\Resources\Languages on
Windows 7, 64-bit or Windows 10, 64-bit operating
systems.

2 Settings > Select
Library

Browse to a spectral library. This library will be used for
matching and scoring MS/MS data from Results Tables that
contain data from information dependent acquisition (IDA)
triggered MS/MS scan types.

2 Settings > Select
Template Folder

Sets the folder from which the available templates will be
read. To return to the default template folder, select the
Default option.

3 Help > About Shows information about the version of Reporter software
currently installed.

4 Current Output
Language

Shows the currently selected language dictionary used for
replacing language tags within a report template. To select
a language dictionary, click Settings > Select Output
Language.

5 Current Spectral
Library

Shows the currently selected spectral library. To select a
spectral library, click Settings > Select Library.

6 Available
Templates and
Description

Shows a list of available report templates. Select a
template to show a description of the template. To change
the folder from which available templates are read, select
Settings > Select Template Folder > Browse.
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Item Option Description

7 Output Format Shows the output formats that are supported by the
Reporter software. Only formats that are compatible with
the selected report template are enabled.

• Word: Microsoft Word document (docx) is produced.
This document can be viewed by Microsoft Word 2010
and above.

• PDF: A report is created directly in PDF format.

• HTML: Microsoft Word is used to generate an HTML file.
Associated image files are stored in a folder with the
same name as the HTML file.

• Excel: A plain text file (csv) is produced. Report
templates that contain values separated by commas can
be opened in Microsoft Excel, where each value will
be shown in a separate cell. Only templates that are
specifically marked as text-compatible can be used for
this output format.

• Text: A plain text document (txt) is produced. Only
templates that are specifically marked as text compatible
can be used for this output format.

8 Print
Automatically

After the report has been created it is printed to the
selected printer. Select any available printer.

9 Create Report Creates the report in the selected output format using the
selected report template.

10 Close Exits the program and releases all resources.

Generate Reports
The Reporter software extracts numerical data from the Results Table and sample and graphical
information from the wiff file.

1. Open a Results Table.

2. Under Companion Software, double-click Reporter.
The Analyst Reporter opens.

3. In the Available Templates field, select the applicable report template.

4. Click the PDF output format.
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The Word option is pre-selected and the report is automatically saved in the current project
Results folder. If the PDF output format is not selected, then the report is created and
opened in Word or printed as selected, but the report is not saved. This lets the user edit the
report in Word before saving the original report.

5. Optional for a library search (qualitative) workflow when a Results Tables that contains
data from information dependent acquisition (IDA) triggered MS/MS scan types is used:
Click Settings > Select Library, navigate to the applicable MS/MS library database (mdb
format), and then click Open.

6. (Optional) Select the Print Automatically check box to print the reports automatically on a
pre-selected printer.
The default printer set in Windows is used unless a different printer is selected. The
Reporter software keeps the selected printer between operations. If the printer is set to
a PDF printer driver, then the Reporter software generates PDF file versions of the created
reports automatically.

7. Click Create Report.
The screen shows various progress indicators as the software opens the template and
populates it with data from the Results Table. Some reports can take seconds to generate,
others can take longer. A large data set with many MRM transitions or a large number of
graphics might result in reports of several hundred pages that take hours to generate.
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Service and Maintenance
Information — Mass Spectrometer 16
Regularly clean and maintain the system for optimal performance.

WARNING! Electrical Shock Hazard. Do not remove the covers. Removing
the covers might cause injury or malfunctioning of the system. The covers
need not be removed for routine maintenance, inspection, or adjustment.
Contact a SCIEX Field Service Employee (FSE) for repairs that require the
covers to be removed.

WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical
Hazard. Determine whether decontamination is required before cleaning
or maintenance. If radioactive materials, biological agents, or toxic
chemicals have been used with the system, then the customer must
decontaminate the system before cleaning or maintenance.

Recommended Maintenance Schedule
The following tables provide a recommended schedule for cleaning and maintaining the system.

Tip! Perform maintenance tasks regularly to make sure that the system is performing optimally.

• Perform periodic gas leakage tests and general maintenance inspections to be sure of safe
operation of the system.

• Clean the system regularly to keep it in good working condition.

• During system maintenance, carefully examine parts of the external gas supply system,
including tubing connected to the equipment, to confirm that the condition is satisfactory.
Replace any cracked, pinched, or collapsed tubing.

To determine how often to clean or perform maintenance on the mass spectrometer and ion
source, consider the following factors. These factors can cause changes in mass spectrometer
performance, indicating that maintenance is required.

• Compounds tested

• Cleanliness of the samples and the sample preparation methods

• Amount of time that the probe is exposed to the sample
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• Overall system run time

For information about tuning frequency, refer to the section: Calibration Ions and Solutions.

To order consumable parts and for basic service and maintenance requirements, contact a QMP
or refer to the document: Parts and Equipment Guide. Contact a SCIEX FSE for all other service
and maintenance requirements.

Table 16-1 Mass Spectrometer Maintenance Tasks

Component Frequency Task For More Information

System Daily Inspect for leaks Refer to the section: Chemical
Precautions.

Curtain plate Daily Clean Refer to the section: Clean the
Curtain Plate.

Roughing pump oil Weekly Inspect the level Refer to the section: Inspect
the Roughing Pump Oil Level.
Contact the local QMP or FSE to
add oil, if required.

Roughing pump oil Every 3 years,
or as needed.

Replace Contact the local QMP or FSE.

Roughing pump oil As needed Refill Contact the local QMP or FSE.

Orifice plate (front) As needed Clean Refer to the section: Clean the
Front of the Orifice Plate.

Orifice plate (front and
back)

As needed Clean Contact the local QMP or FSE.

Mass spectrometer air
filter

As needed Replace Contact the local QMP or FSE.

QJet ion guide and IQ0
lens

As needed Clean Contact the local QMP or FSE.

Q0 rod set and IQ1 lens As needed Clean Contact the local QMP or FSE.

Instrument surfaces As needed Clean Refer to the section: Clean the
Surfaces.

Source exhaust drain
bottle

As needed Empty Refer to the section: Empty the
Source Exhaust Drain Bottle.

Interface heater As needed Replace Contact the local QMP or FSE.
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Table 16-2 Ion Source Maintenance Tasks

Component Frequency Task For More Information

TurboIonSpray and
APCI probes

As needed Examine and
replace

Refer to the section: Remove the
Probe and Install the Probe.

Electrodes for the
TurboIonSpray and
APCI probes

As needed Examine and
replace

Refer to the section: Replace the
Electrode.

Corona discharge
needle

As needed Replace Refer to the section: Replace the
Corona Discharge Needle.

Turbo heater As needed Replace Contact the local QMP or FSE.

Sample tubing As needed Replace Refer to the section: Connect the
Ion Source Tubing.

For “As needed” tasks, follow these guidelines:

• Clean the mass spectrometer surfaces after a spill or when they become dirty.

• Empty the source exhaust drain bottle before it becomes full.

• Clean the orifice plate, QJet ion guide, and Q0 region if system sensitivity degrades.

Tip! Clean the Q0 region regularly to minimize the impact of charging, a significant loss of
sensitivity of the ions of interest over a short period of time, on the quadrupoles and lenses.
Contact a QMP or FSE.

• For systems with oil-sealed roughing pumps, refill the oil when it falls below the minimum oil
level.

• Periodically inspect all exhaust connections to make sure that the integrity is maintained, and
that any exhaust is removed from the customer lab.

Clean the Surfaces
Clean the external surfaces of the mass spectrometer after a spill or when they become dirty.

CAUTION: Potential System Damage. Use only the recommended cleaning methods and
materials to avoid damaging the equipment.

1. Wipe the external surfaces with a soft cloth dampened with warm, soapy water.

2. Wipe the external surfaces with a soft cloth dampened with water to remove any soap
residue.
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Empty the Source Exhaust Drain Bottle
WARNING! Hot Surface Hazard. Let the Turbo V ion source cool for at least
30 minutes before starting any maintenance procedures. Some surfaces of
the ion source and vacuum interface become hot during operation.

WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical
Hazard. Deposit hazardous materials in appropriately labeled waste
containers and dispose of them according to local regulations.

WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical
Hazard. Take care to vent exhaust gases to a dedicated laboratory fume
hood or exhaust system and make sure that the ventilation tubing is
secured with clamps. Make sure that the laboratory has appropriate air
exchange for the work performed.

Note: Make sure that there are no kinks, sags, or twists in the source waste line.

Inspect the source exhaust drain bottle regularly, and empty it before it becomes full. Also
inspect the bottle and the fitting for leaks, and tighten connections or replace components, if
required. Follow the steps in this procedure to empty the bottle.

1. Remove the ion source.

2. Loosen the clamps connecting the hoses to the cap of the source exhaust drain bottle.
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Figure 16-1 Source Exhaust Drain Bottle

Item Description

1 Connection to vent

2 Source exhaust drain tubing: 2.5 cm (1.0 inch) inner diameter (i.d.)

3 Roughing pump exhaust hose: 3.2 cm (1.25 inch) i.d.

4 Source exhaust drain bottle
Make sure that the bottle is secured to prevent spillage.

5 Source exhaust connection to the mass spectrometer: 1.6 cm
(0.625 inch) i.d.

Note: Source exhaust hose connections at the drain bottle, mass spectrometer, and the lab
vent are secured with hose clamps.
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3. Lift the drain bottle out of the holder.

4. Disconnect the hoses from the cap.

5. Remove the cap from the drain bottle.

6. Empty the drain bottle and then dispose of the waste according to laboratory procedures
and local waste regulations.

7. Install the cap on the bottle and then put the bottle in the holder.

8. Attach the hoses to the cap and then secure them tightly with clamps.

Clean the Front-End
The following warning applies to all of the procedures in this section:

WARNING! Hot Surface Hazard. Let the Turbo V ion source cool for at least
30 minutes before starting any maintenance procedures. Some surfaces of
the ion source and vacuum interface become hot during operation.

Clean the mass spectrometer front-end using the routine cleaning method, to:

• Minimize unscheduled system downtime.

• Maintain optimum sensitivity.

• Avoid more extensive cleaning that requires a service visit.

When contamination occurs, perform an initial routine cleaning. Clean up to and including the
front of the orifice plate. If routine cleaning does not resolve issues with sensitivity, then a full
cleaning might be necessary. Contact the local QMP or FSE.

This section provides instructions for performing routine cleaning without breaking vacuum.

Note: Follow all of the applicable local regulations. For health and safety guidelines, refer to the
section: Chemical Precautions.

Symptoms of Contamination
The system might be contaminated if any one of the following is observed:

• Significant loss in sensitivity

• Increased background noise

• Additional peaks that are not part of the sample in full scan or survey scan methods

If any of these issues are observed, then clean the mass spectrometer front-end.

Service and Maintenance Information — Mass Spectrometer

SCIEX 4500MD Systems
236/313

System User Guide
IVD-IDV-05-6996-D



Required Materials
Note: For consumables ordering information and inquiries, refer to the MD Instrument Family
Parts and Equipment Guide. Contact a local FSE or visit sciex.com for more information.

• Powder-free gloves, nitrile or neoprene recommended

• Safety glasses

• Laboratory coat

• Fresh LC-MS-grade water. Old water can contain contaminants that can further contaminate
the mass spectrometer.

• LC-MS-grade methanol, isopropanol (2-propanol), or acetonitrile

• Cleaning solution. Use one of:

• 100% methanol

• 100% isopropanol

• 1:1 acetonitrile:water solution, freshly prepared

• 1:1 acetonitrile:water with 0.1% acetic acid solution, freshly prepared

• Clean 1 L or 500 mL glass beaker to prepare cleaning solutions

• 1 L beaker to catch used solvent

• Organic waste container

• Lint-free wipes. Refer to the section: Tools and Supplies Available from the Manufacturer.

• (Optional) Polyester (poly) swabs

Tools and Supplies Available from the Manufacturer

Note: For part numbers, refer to the document: Parts and Equipment Guide.

• Small poly swab, thermally bonded. Also available in the Cleaning kit.

• Lint-free wipe (11 cm x 21 cm, 4.3 inches x 8.3 inches). Also available in the Cleaning kit.

• Cleaning kit. Contains the small poly swab, lint-free wipes, Q0 cleaning tool, straight QJet ion
guide cleaning brush, and Alconox
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Cleaning Best Practices
WARNING! Hot Surface Hazard. Let the Turbo V ion source cool for at least
30 minutes before starting any maintenance procedures. Some surfaces of
the ion source and vacuum interface become hot during operation.

WARNING! Toxic Chemical Hazard. Refer to the chemical product safety data
sheets and follow all of the recommended safety procedures when handling,
storing, and disposing of chemicals.

WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical
Hazard. Determine whether decontamination is required before cleaning
or maintenance. If radioactive materials, biological agents, or toxic
chemicals have been used with the system, then the customer must
decontaminate the system before cleaning or maintenance.

WARNING! Environmental Hazard. Do not dispose of system components in
municipal waste. Follow local regulations when disposing of components.

• Allow the ion source to cool before removing it.

• Always wear clean, powder-free gloves, nitrile or neoprene recommended, for the cleaning
procedures.

• After cleaning the mass spectrometer components, and before reassembling them, put on a
new, clean pair of gloves.

• Do not use cleaning supplies other than those specified in this procedure.

• If possible, prepare cleaning solutions just before cleaning.

• Prepare and store all of the organic solutions and organic-containing solutions in very clean
glassware only. Never use plastic bottles. Contaminants can leach from these bottles and
further contaminate the mass spectrometer.

• To avoid contaminating the cleaning solution, pour the solution on the wipe or swab.

• Allow only the center area of the wipe to contact the mass spectrometer surface. Cut edges
can leave fibers behind.

Tip! Wrap the wipe around a thermally-bonded poly swab.
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Figure 16-2 Example: Folding the Wipe

• To avoid cross-contamination, discard the wipe or swab after it has touched the surface once.

• If required, perform multiple cleanings, using multiple wipes for larger parts of the vacuum
interface, such as the curtain plate.

• Only dampen the wipe or swab slightly when applying water or cleaning solution. Water, more
often than organic solvents, might cause the wipe to deteriorate, leaving residue on the mass
spectrometer.

• Do not rub the wipe across the aperture. Wipe around the aperture to prevent fibers from the
wipes from entering the mass spectrometer.

• Do not insert the brush in the aperture on the curtain plate or orifice plate.

Prepare the Mass Spectrometer
WARNING! Hot Surface Hazard. Let the Turbo V ion source cool for at least
30 minutes before starting any maintenance procedures. Some surfaces of
the ion source and vacuum interface become hot during operation.
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CAUTION: Potential System Damage. Do not drop anything in the source drain when the
ion source is removed.

Figure 16-3 Source Drain on the Vacuum Interface

1. Deactivate the hardware profile. Refer to the document: Software User Guide.

2. Remove the ion source. Refer to the section: Remove the Ion Source.
When the ion source is not in use, store it to protect it from damage and to maintain
operating integrity.

Clean the Curtain Plate
CAUTION: Potential System Damage. Do not rest the curtain plate or orifice plate on the
aperture tip. Make sure that the conical side of the curtain plate faces up.

CAUTION: Potential System Damage. To avoid damaging the aperture, do not insert a
wire or metal brush in the aperture on the curtain plate, orifice plate, or interface heater.

1. Pull the curtain plate off of the vacuum interface and then put it, conical side up, on a clean,
stable surface.
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Figure 16-4 Curtain Plate Removal

The curtain plate is held in place by three retaining ball catches mounted on the orifice plate.

Tip! If the curtain plate does not immediately separate from the orifice plate, then turn the
curtain plate slightly, less than 90 degrees, to release the ball spring latches.

2. Dampen a lint-free wipe with LC-MS-grade water and then clean both sides of the curtain
plate.

Note: Use multiple wipes, as required.

3. Repeat step 2 using the cleaning solution.

4. Using a dampened wipe or small poly swab, clean the aperture.

5. Wait until the curtain plate is dry.

6. Inspect the curtain plate for solvent stains or lint, removing any residue with a clean, slightly
damp, lint-free wipe.

Note: Persistent spotting or filming is an indicator of contaminated solvent.

Clean the Front of the Orifice Plate
CAUTION: Potential System Damage. When cleaning the surface of the orifice plate, do
not remove the interface heater. Frequent removal of the interface heater can result in
damage to the interface heater. Surface cleaning of the interface heater is adequate for
routine cleaning.
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CAUTION: Potential System Damage. To avoid damaging the aperture, do not insert a
wire or metal brush in the aperture on the curtain plate, orifice plate, or interface heater.

1. Dampen a lint-free wipe with LC-MS-grade water and then wipe the front of the orifice plate,
including the interface heater.

2. Repeat step 1 using the cleaning solution.

3. Wait until the orifice plate is dry.

4. Inspect the orifice plate for solvent stains or lint, removing any residue with a clean, slightly
damp, lint-free wipe.

Note: Persistent spotting or filming is an indicator of contaminated solvent.

Put the Mass Spectrometer Back in Service
1. Install the curtain plate.

2. Install the ion source on the mass spectrometer. Refer to the section: Install the Ion Source
on the Mass Spectrometer.
Tighten the ion source by turning the source latches down in the locking position.

3. If the mass spectrometer is connected to the LC system, then restore all of the connections
to the LC system.

4. Activate the hardware profile. Refer to the document: Software User Guide.

Storage and Handling
WARNING! Environmental Hazard. Do not dispose of system components in
municipal waste. Follow local regulations when disposing of components.

If the mass spectrometer must be stored for a long time or prepared for shipping, then contact a
SCIEX FSE for decommissioning information. To disconnect power from the mass spectrometer,
remove the mains supply connector from the AC mains supply.

Note: The ion source and mass spectrometer must be transported and stored at a temperature
between –30 °C to +60 °C (–22 °F to 140 °F) and relative humidity not exceeding 99%, non-
condensing. Store the system at an altitude not exceeding 2,000 m (6,562 feet) above sea level.
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Inspect the Roughing Pump Oil Level
Inspect the sight glass on the roughing pump to verify that the oil is above the minimum level.

If the oil is below the minimum level, then contact the Qualified Maintenance Person (QMP) or
SCIEX Field Service Employee (FSE).

Figure 16-5 Sight Glass

Service and Maintenance — Ion Source
The following warnings apply to all of the maintenance procedures in this section.

WARNING! Hot Surface Hazard. Let the Turbo V ion source cool for at least
30 minutes before starting any maintenance procedures. Some surfaces of
the ion source and vacuum interface become hot during operation.

WARNING! Fire and Toxic Chemical Hazard. Keep flammable liquids away
from flame and sparks and use them only in vented chemical fume hoods or
safety cabinets.
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WARNING! Toxic Chemical Hazard. Wear personal protective equipment, including
a laboratory coat, gloves, and safety glasses, to avoid skin or eye exposure.

WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical
Hazard. In the event of a chemical spill, review product safety data sheets
for specific instructions. Make sure that the system is in Standby state
before cleaning a spill near the ion source. Use appropriate personal
protective equipment and absorbent wipes to contain the spill and dispose
of it following local regulations.

WARNING! Electrical Shock Hazard. Avoid contact with the high voltages
applied to the ion source during operation. Put the system in Standby state
before adjusting the sample tubing or other equipment near the ion source.

WARNING! Puncture Hazard, Ionizing Radiation Hazard, Biohazard, or
Toxic Chemical Hazard. Discontinue use of the ion source if the ion
source window is cracked or broken, and then contact a SCIEX Field
Service Employee (FSE). Any toxic or injurious materials introduced in
the equipment will be present in the source exhaust output. Exhaust from
equipment should be vented from the room. Dispose of sharps following
established laboratory safety procedures.

CAUTION: Potential System Damage. Do not lift or carry the ion source with one hand.
The ion source is designed to be lifted or carried using two hands, one on each side of
the ion source.

This section contains general maintenance procedures for the ion source. To determine how
often to clean or perform maintenance on the ion source, consider the following:

• Compounds tested

• Cleanliness of the samples and sample preparation techniques

• Amount of time an idle probe contains a sample

• Overall system run time

These factors can cause changes in ion source performance, indicating that maintenance is
required.

Make sure that the installed ion source is fully sealed to the mass spectrometer with no evidence
of gas leaks. Regularly inspect the ion source and its fittings for leaks. Clean the ion source
components regularly to keep the ion source in good working condition.
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CAUTION: Potential System Damage. Use only the recommended cleaning methods and
materials to avoid damaging the equipment.

Required Materials

• 1/4 inch open-ended wrench

• Flat-bladed screwdriver

• LC-MS-grade methanol

• LC-MS-grade deionized water

• Safety glasses

• Breathing mask and filter

• Powder-free gloves, nitrile or neoprene recommended

• Lab coat

Ion Source Handling
Surfaces of the ion source become hot during operation. The following figure shows surfaces
that are cooler (blue and gray) and surfaces that remain hot for an extended period of time (red).
Do not touch the surfaces shown in red while using or removing the ion source.
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Figure 16-6 Ion Source Hot Surfaces (Red=Hot, Gray=Warm, Blue=Handle with Care)

Item Description

1 Front

2 Back

Remove the Ion Source
Note: Nitrogen continues to flow at a rate of 5.3 L/min when the mass spectrometer is off or
when the ion source is removed from the system. To minimize nitrogen gas consumption and to
keep the mass spectrometer clean when it is not in use, leave the ion source installed on the
mass spectrometer and leave the system on.

The ion source can be removed quickly and easily, without tools. Always remove the ion
source from the mass spectrometer before performing any maintenance on the ion source or
exchanging the probes.

1. Stop any ongoing scans.

2. Turn off the sample stream.

3. Set the ion source Temperature to 0, if the heaters are in use.
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4. Wait at least 30 minutes for the ion source to cool.

5. Disconnect the sample tubing from the grounding union.

6. Turn the two source latches up to the 12 o'clock position to release the ion source.

7. Pull the ion source gently away from the vacuum interface.

Note: Be careful not to lose the O-rings that are installed on the vacuum interface.

8. Put the ion source on a clean, secure surface.

Clean the Surfaces
WARNING! Electrical Shock Hazard. Make sure that the ion source is
completely disconnected from the mass spectrometer before proceeding.

Clean the surfaces of the ion source after a spill or when they become dirty.

Prerequisite Procedures

• Remove the Ion Source

Wipe the surfaces of the ion source with a soft, damp, cloth.

Clean the Probe
Flush the ion source periodically, regardless of the type of compounds sampled. Do this by
setting up a method in the control software specifically for performing a flushing operation.

1. Change to a mobile phase that is 1:1 water:acetonitrile or 1:1 water:methanol.

2. Adjust the position of the probe so that it is as far from the orifice as possible.

3. In the control software, do the following:

a. Create an MS method.

b. Set the ion source temperature between 500 ° C and 600 °C.

c. Set ion source gas 1 and ion source gas 2 to at least 40.

d. Set the flow rate of the gas for the Curtain Gas interface to the highest setting possible.

4. Wait until the temperature setpoint is reached.

5. Make sure that the probe and sample tubing are flushed thoroughly.
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Remove the Probe
WARNING! Electrical Shock Hazard. Remove the ion source from the mass
spectrometer before starting this procedure. Follow all electrical safe work
practices.

CAUTION: Potential System Damage. Do not let the protruding electrode tip or the corona
discharge needle touch any part of the ion source housing, to avoid damaging the probe.

Prerequisite Procedures

• Remove the Ion Source.

The probe can be removed quickly and easily, without tools. Always remove the ion source from
the mass spectrometer before changing probes or performing maintenance on the probe.

1. Loosen the sample tubing nut and then disconnect the sample tubing from the probe.

2. Loosen the retaining ring that secures the probe on the ion source housing.

3. Gently pull the probe straight up out of the tower.

4. Put the probe on a secure, clean surface.

Replace the Electrode
WARNING! Electrical Shock Hazard. Remove the ion source from the mass
spectrometer before starting this procedure. Follow all electrical safe work
practices.

WARNING! Puncture Hazard. Be careful when handling the electrode. The tip of the
electrode is extremely sharp.

Prerequisite Procedures

• Remove the Ion Source.

• Remove the Probe.

The probe contains an electrode. Replace the electrode when there is a decrease in
performance.

Note: After replacing the electrode, evaluate the effect of the change on system performance.

This procedure applies to both probes.
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1. Remove the electrode adjustment nut and then remove the electrode.

2. Holding the probe with the tip pointing down, so that the spring remains inside the probe,
install a sample fitting in the PEEK union, tightening until it is finger-tight.

Figure 16-7 Probe, Expanded View

Item Description

1 Electrode adjustment nut

2 1/4 inch retaining nut

3 Spring

4 Retaining ring

5 Sprayer tube

6 Electrode tip

7 Electrode tube

8 PEEK union

3. Pull the PEEK union and the attached electrode tube from the probe.

4. Remove the sample fitting from the PEEK union.

5. Use the 1/4 inch open-ended wrench to remove the retaining nut that holds the electrode
tube in the PEEK union.

6. Remove the electrode tube from the retaining nut.

7. Insert the new electrode tube in the retaining nut and then in the PEEK union.
Make sure that the electrode tube is inserted as far as possible in the PEEK union. If there
is a gap between the electrode tube and its seat inside the union, a dead volume may occur.

8. Tighten the retaining nut.
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Do not cross-thread or over-tighten the retaining nut or the tubing might leak.

9. Make sure that the spring is still inside the probe and then tighten the electrode adjustment
nut.

10. Align the electrode tube with the narrow opening in the sprayer tube and then insert the
PEEK union and attached electrode tube in the probe. Be careful not to bend the electrode
tube.

11. Install and then tighten the electrode adjustment nut.

12. Install the probe. Refer to the section: Install the Probe.

13. Install the ion source on the mass spectrometer. Refer to the section: Ion Source
Installation.

14. Connect the sample tubing. Refer to the section: Connect the Ion Source Tubing.

15. Adjust the electrode tip extension. Refer to the section: Optimize the TurboIonSpray Probe
Position or Optimize the APCI Probe Position.

Replace the Corona Discharge Needle

WARNING! Electrical Shock Hazard. Remove the ion source from the mass
spectrometer before starting this procedure. Follow all electrical safe work
practices.

WARNING! Puncture Hazard. Handle the needle with care. The tip of the needle is
extremely sharp.

Prerequisite Procedures

• Remove the Ion Source.

• Remove the Probe.

If the corona discharge needle tip becomes corroded, then it might not be removable by hand.
If it cannot be removed, then cut off the needle tip to remove it and replace the entire corona
discharge needle.

1. Rotate the ion source so that the open side is accessible.
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Figure 16-8 Corona Discharge Needle

Item Description

1 Exhaust chimney

2 Ceramic sleeve

3 Corona discharge needle tip

2. While holding the corona discharge needle adjustment screw between the thumb and
forefinger of one hand and the corona discharge needle with the other hand, rotate the
corona discharge needle tip counter-clockwise to loosen and then gently remove the tip.
Refer to the section: Ion Source Components.

3. Gently pull the corona discharge needle down through the exhaust chimney to remove it.

4. Insert the new needle through the exhaust chimney in the ceramic sleeve as far as possible.

5. Holding a new tip between the thumb and forefinger of one hand and the corona discharge
needle adjustment screw with the other hand, rotate the corona discharge needle tip
clockwise to install the tip.

6. Insert the probe and then install the ion source on the mass spectrometer. Refer to the
section: Ion Source Installation.
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Replace the Sample Tubing
WARNING! Electrical Shock Hazard. Remove the ion source from the mass
spectrometer before starting this procedure. Follow all electrical safe work
practices.

Prerequisite Procedures

• Stop the sample flow and make sure that any remaining gas has been removed through the
source exhaust system.

• Remove the ion source. Refer to the section: Remove the Ion Source.

Use the following procedure to replace the sample tubing if it has a blockage.

1. Disconnect the sample tubing from the probe and the grounding union.

2. Replace the sample tubing with an appropriate length of tubing, cut with a proper tubing
cutter. Refer to the section: Connect the Ion Source Tubing.

3. Install the ion source. Refer to the section: Ion Source Installation.

4. Start the sample flow.
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Mass Spectrometer Troubleshooting 17
This section contains information for troubleshooting basic system issues. Certain activities can
only be carried out by a SCIEX-trained Qualified Maintenance Person (QMP) in the laboratory.
For advanced troubleshooting, contact a SCIEX Field Service Employee (FSE).

Table 17-1 System Issues

Symptom Possible Cause Corrective Action

The QJet ion guide is
extremely dirty or frequently
becomes dirty.

The flow rate of the gas for the
Curtain Gas interface is too
low.

Examine the setting for the
gas for the Curtain Gas
interface and increase it, if
applicable.

A system fault has occurred
because the vacuum pressure
is too high.

1. The oil level is too low.

2. There is a leak.

3. The wrong orifice plate is
installed.

1. Inspect the oil level in the
roughing pump, and then
contact the local QMP or
an FSE to add oil. Refer
to the section: Inspect the
Roughing Pump Oil Level.

2. Inspect and repair leaks.

3. Install the correct orifice
plate.

A system fault has occurred
because the QPS exciter
module temperature is too
high.

1. The mass spectrometer
air filter is blocked.

2. The coil box is not tuned.

3. Ambient temperature is
too high.

1. Contact the local QMP or
FSE.

2. For the
ambient temperature
specifications, refer to the
document: Site Planning
Guide for the system.
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Table 17-1 System Issues (continued)

Symptom Possible Cause Corrective Action

The control software reports
that the mass spectrometer is
in Fault status because of the
ion source.

1. The probe is not installed.

2. The probe is not
connected securely.

Confirm the fault in the Status
panel of the device details
page.

1. Install the probe. Refer
to the section: Install the
Probe.

2. Remove and then install
the probe. Tighten the
retaining ring securely.
Refer to the section:
Remove the Probe and
Install the Probe.

The control software indicates
that the APCI probe is in use,
but the TurboIonSpray probe
is installed.

The F3 fuse is blown. Contact an FSE.

The spray is not uniform. The electrode is blocked. Clean or replace the
electrode. Refer to the
section: Replace the
Electrode.

The interface heater is not
ready.

The interface heater is faulty. Contact the local QMP or
FSE.

The mass spectrometer
resolution is poor.

The mass spectrometer is not
tuned.

Use the Instrument
Optimization wizard to
optimize the mass
spectrometer. Refer to the
documents: Software User
Guide or Help.
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Table 17-1 System Issues (continued)

Symptom Possible Cause Corrective Action

The mass spectrometer
performance has degraded.

1. The ion source conditions
are not optimized.

2. The sample was not
prepared correctly or the
sample has degraded.

3. The sample inlet fittings
are leaking.

1. Optimize the ion source
conditions. Refer to
the section: Optimize
the TurboIonSpray Probe
Position or Optimize the
APCI Probe Position.

2. Confirm that the sample
was prepared correctly.

3. Verify that the fittings
are the right size and
type and make sure that
they are tight. Do not
overtighten the fittings.
Replace the fittings if
leaks continue.

4. Install and optimize an
alternate ion source.

5. Contact an FSE if the
issue persists.

Arcing or sparks occur. The position of the corona
discharge needle is incorrect.

If the TurboIonSpray probe
is being used, then turn
the corona discharge needle
toward the curtain plate and
away from the stream of
heater gas. Refer to the
section: Adjust the Position of
the Corona Discharge Needle.

Table 17-2 Sensitivity Issues

Possible Cause Corrective Action

Sensitivity is Decreased

The ion source parameters are not optimized. Optimize the ion source parameters.

The mass spectrometer is not optimized. Use the Instrument Optimization wizard to
optimize the mass spectrometer.
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Table 17-2 Sensitivity Issues (continued)

Possible Cause Corrective Action

The curtain plate is dirty. Clean the curtain plate. Refer to the section:
Clean the Curtain Plate.

The orifice plate is dirty. Refer to the section: Clean the Front of the
Orifice Plate or contact the local QMP or FSE.

The QJet ion guide or IQ0 lens is dirty. Clean the QJet ion guide and IQ0 lens.
Contact the local QMP or FSE.

Q0 region is dirty. Test for contamination of the Q0 region.
Contact the local QMP or FSE.

The syringe or sample line is leaking. Inspect the syringe or sample line for leaks
and repair any leaks found. Make sure that all
fittings are the correct type and size.

The sample has degraded or has a low
concentration.

Verify the sample concentration. Use a fresh
sample.

The probe is not installed properly. Remove and install the probe.

The ion source is not installed properly or it is
faulty.

Remove and install the ion source, making
sure that the latches are properly secured. If
this does not resolve the issue, then install and
optimize an alternate ion source.

One or more of the O-rings on the vacuum
interface is missing.

If the O-rings are on the ion source, then
install them on the vacuum interface. If they
are missing, then replace them.

There is an issue with the LC system or
connections.

Troubleshoot the LC system.

The Declustering Potential (DP) is not
optimized.

Optimize DP.

The electrode is dirty or blocked. Replace the electrode. Refer to the section:
Replace the Electrode.

There is No Signal or the Signal is Unstable

The tubing is blocked. Replace the sample tubing. Refer to the
section: Connect the Ion Source Tubing.
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Table 17-3 Background Noise Issues

Possible Cause Corrective Action

The Temperature (TEM), IonSpray voltage
(IS) or heater gas flow rate (GS2) is too high.

Optimize the ion source parameters.
Refer to the section: TurboIonSpray Probe
Optimization or APCI Probe Optimization.

The syringe or sample line is dirty. Clean or replace the syringe or sample line.

The curtain plate is dirty. Clean the curtain plate. Refer to the section:
Clean the Curtain Plate.

The orifice plate is dirty. Clean the front of the orifice plate. Refer to the
section: Clean the Front of the Orifice Plate.

The QJet ion guide or IQ0 lens is dirty. Do a full cleaning of the front end components
of the mass spectrometer. Contact the local
QMP or FSE.

The Q0 region is dirty. Clean the Q0 region. Contact the QMP or
FSE.

Mobile phase is contaminated. Replace the mobile phase.

The ion source is contaminated. Clean or replace the ion source components
and then condition the ion source and front
end:
1. Move the probe to the furthest

position from the aperture, vertically and
horizontally.

2. (Analyst MD software) Make sure that the
interface heater is on.

3. Infuse or inject 50:50 methanol:water with
a pump flow rate of 1 mL/min.

4. In the control software, set the
temperature to 650, ion source gas 1 to
60, and ion source gas 2 to 60.

5. Set the flow rate for the gas for the
Curtain Gas interface to 45 or 50.

6. Run for a minimum of 2 hours or
preferably overnight for best results.

For sales, technical assistance, or service, contact an FSE or visit the SCIEX website at
sciex.com for contact information.
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Parameters for the SCIEX 4500MD
Systems A
The following table contains generic parameters for the SCIEX 4500MD systems. The first
number under each scan type is the preset value. The range of numbers is the accessible range
for each parameter.

Table A-1 System Parameters for Triple Quadrupole Scan Types

Access ID Positive Ion Mode Negative Ion Mode

Q1 Q3 MS/MS Q1 Q3 MS/MS

CUR3 4 20

10 to 55

20

10 to 55

20

10 to 55

20

10 to 55

20

10 to 55

20

10 to 55

CAD5 0

Fixed

6

Fixed

Medium

Low,
Medium,
High

0

Fixed

6

Fixed

Medium

Low,
Medium,
High

CAD6 0

Fixed

5

Fixed

9

0 to 12

0

Fixed

5

Fixed

9

0 to 12

IS3 4 5500

0 to 5500

5500

0 to 5500

5500

0 to 5500

–4500

–4500 to 0

–4500

–4500 to 0

–4500

–4500 to 0

NC7 3

0 to 5

3

0 to 5

3

0 to 5

–3

–5 to 0

–3

–5 to 0

–3

–5 to 0

TEM 4 7 0

0 to 750

0

0 to 750

0

0 to 750

0

0 to 750

0

0 to 750

0

0 to 750

3 Turbo V ion source
4 TurboIonSpray probe
5 QTRAP 4500MD system
6 SCIEX Triple Quad 4500MD system
7 APCI probe
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Table A-1 System Parameters for Triple Quadrupole Scan Types (continued)

Access ID Positive Ion Mode Negative Ion Mode

DP5 200

0 to 300

100

0 to 300

100

0 to 300

–100

–300 to 0

–100

–300 to 0

–100

–300 to 0

DP6 130

0 to 300

130

0 to 300

120

0 to 300

–60

–300 to 0

–60

–300 to 0

–150

–300 to 0

EP 10

2 to 15

10

2 to 15

10

2 to 15

–10

–15 to –2

–10

–15 to –2

–10

–15 to –2

CEM5 1800

0 to 3300

1800

0 to 3300

1800

0 to 3300

1800

0 to 3300

1800

0 to 3300

1800

0 to 3300

CEM6 2000

0 to 3300

2000

0 to 3300

2000

0 to 3300

2000

0 to 3300

2000

0 to 3300

2000

0 to 3300

GS15 20

0 to 90

20

0 to 90

20

0 to 90

20

0 to 90

20

0 to 90

20

0 to 90

GS16 15

0 to 90

15

0 to 90

15

0 to 90

15

0 to 90

15

0 to 90

15

0 to 90

GS2 0

0 to 90

0

0 to 90

0

0 to 90

0

0 to 90

0

0 to 90

0

0 to 90

CE5 N/A N/A 30

5 to 180

N/A N/A –30

–180 to –5

CE6 N/A N/A 53

5 to 180

N/A N/A –40

–180 to –5

CXP5 N/A 15

0 to 55

15

0 to 55

N/A –15

–55 to 0

–15

–55 to 0
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Table A-1 System Parameters for Triple Quadrupole Scan Types (continued)

Access ID Positive Ion Mode Negative Ion Mode

CXP6 N/A 9

0 to 55

27

0 to 55

N/A –17

–55 to 0

–12

–55 to 0

Table A-2 System Parameters for LIT Scan Types (QTRAP Only)

Access ID Positive Ion Mode Negative Ion Mode

CUR3 4 7 20

10 to 55

20

10 to 55

CAD High

Low; Medium; High

High

Low; Medium; High

IS3 5500

0 to 5500

–4500

–4500 to 0

NC7 3

0 to 5

–3

–5 to 0

TEM4 7 0

0 to 750

0

0 to 750

DP 100

0 to 300

–100

–300 to 0

EP 10

2 to 15

–10

–15 to –2

AF2 0.100

0 or 1

0.100

0 or 1

AF3 Mass-Speed Dependent

0 to 10

Mass-Speed Dependent

0 to 10
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Table A-2 System Parameters for LIT Scan Types (QTRAP Only) (continued)

Access ID Positive Ion Mode Negative Ion Mode

EXB Mass-Speed Dependent

–165 to 0

Mass-Speed Dependent

0 to 165

CEM 1800

0 to 3300

1800

0 to 3300

GS1 20

0 to 90

20

0 to 90

GS2 0

0 to 90

0

0 to 90

CES 0

0 to 50

0

0 to 50

CE 10

5 to 180

–30

–180 to –10
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Source Parameters and Voltages B

TurboIonSpray Probe Parameters
The following table shows the recommended operating conditions for the TurboIonSpray probe
at three different flow rates. For each flow rate, the flow rate of the gas for the Curtain Gas
interface should be as high as possible. The solvent composition used for optimization was 1:1
water:acetonitrile. These conditions represent a starting point from which to optimize the probe.
Using an iterative process, optimize the parameters using flow injection analysis to achieve the
best signal or signal-to-noise for the compound of interest.

Table B-1 Parameter Optimization for the TurboIonSpray Probe

Parameters Typical Values Operational
RangeLow Medium High

LC flow rate 5 µL/min
to 50
µL/min

200 µL/min 1,000 µL/min 5 µL/min to
3,000 µL/min

Ion source gas 1
(nebulizer gas)

20 psi to
40 psi

40 psi to 60 psi 40 psi to 60 psi 0 psi to 90 psi

Ion source gas 2
(heater gas)

0 psi 50 psi 50 psi 0 psi to 90 psi

IonSpray Voltage 5500 V 5500 V 5500 V 5500 V

Gas for the Curtain Gas
interface

20 psi 20 psi 20 psi 20 psi to 50 psi

Ion source
temperature8

Ambient to
200 ºC

200 ºC to 650 ºC 400 ºC to 750 ºC Up to 750 ºC

Declustering potential
(DP)9

Positive:
70 V

Negative:
–70 V

Positive: 70 V

Negative: –70 V

Positive: 100 V

Negative: –100 V

Positive: 0 V to
400 V

Negative: –400 V
to 0 V

8 Optimum temperature values depend on the compound and mobile phase composition. Higher aqueous
content requires a higher temperature. Zero (0) means no temperature is applied.

9 DP values depend on the compound.
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Table B-1 Parameter Optimization for the TurboIonSpray Probe (continued)

Parameters Typical Values Operational
RangeLow Medium High

Probe vertical
micrometer setting

7 to 10 2 to 5 0 to 2 0 to 13

Probe horizontal
micrometer setting

4 to 6 4 to 6 4 to 6 0 to 10

APCI Probe Parameters
Table B-2 Parameter Optimization for the APCI Probe

Parameter Typical Value Operational Range

LC flow rate 1,000 µL/min 200 µL/min to 3,000 µL/min

Ion source gas 1 (nebulizer
gas)

30 psi 0 psi to 90 psi

Gas for the Curtain Gas
interface

20 psi 20 psi to 50 psi

Ion source temperature10 400 ºC 100 ºC to 750 ºC

Nebulizer current Positive: 3 µA

Negative: –3 µA

Positive: 0 mA to 5 µA

Negative: –5 mA to 0 µA

Declustering potential (DP) Positive: 60 V

Negative: –60 V

Positive: 0 V to 300 V

Negative: –300 V to 0 V

Probe vertical micrometer
setting

4 Scale 0 to 13

Probe Position
The position of the probe can affect the sensitivity of the analysis. For more information on how
to optimize the position of the probe, refer to the section: Ion Source Optimization.

10 Temperature values depend on the compound.
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Solvent Composition
The standard concentration of ammonium formate or ammonium acetate is from 2 mmol/L to
10 mmol/L for positive ions and 2 mmol/L to 50 mmol/L for negative ions. The concentration
of organic acids is 0.1% to 0.5% by volume for the TurboIonSpray probe and 0.1% to 1.0% by
volume for the APCI probe.

Commonly used solvents are:

• Acetonitrile

• Methanol

• Propanol

• Water

Commonly used modifiers are:

• Acetic acid

• Formic acid

• Ammonium formate

• Ammonium acetate

The following modifiers are not commonly used because they complicate the spectrum with
their ion mixtures and cluster combinations. They might also suppress the strength of the target
compound ion signal.

• Triethyl amine (TEA)

• Sodium phosphate

• Trifluoroacetic acid (TFA)

• Sodium dodecyl sulfate
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Calibration Ions and Solutions C
CAUTION: Potential Wrong Result. Do not use expired solutions or solutions that have not been stored at the indicated
storage temperature.

Table C-1 Tuning Frequency

Calibration Resolution Optimization

Scan Type Frequency Manual/Automated Frequency Manual/Automated

Q1 and Q3 3 months to 6 months Both 3 months to 6 months Both

LIT Every 2 weeks, as
required

Both 3 months to 6 months Automated only

Table C-2 Suggested Tuning Solutions for the SCIEX 4500MD Systems

System Q1 and Q3 LIT

Positive Negative Positive and Negative

SCIEX Triple Quad 4500MD
system

POS PPG, 2e-6 M NEG PPG, 3e-4 M N/A

QTRAP 4500MD system POS PPG, 2e-6 M NEG PPG, 3e-4 M ES Tuning Solution (1:100
dilution)
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Table C-3 Q1 and Q3 PPG Positive Ion Scans

Instrument Masses

SCIEX Triple Quad 4500MD
system

59.0 175.1 500.3 616.5 906.7 1254.9 1545.1 1952.4

QTRAP 4500MD system 59.0 175.1 500.3 616.5 906.7 1254.9 1545.1 1952.4

Table C-4 Q1 and Q3 PPG Negative Ion Scans

Instrument Masses

SCIEX Triple Quad 4500MD LC-
MS/MS system

45.0 411.2 585.4 933.6 1223.8 1572.1 1863.3 1979.3

QTRAP 4500MD LC-MS/MS system 45.0 411.2 585.4 933.6 1223.8 1572.1 1863.3 1979.3

Table C-5 Masses and Polarity for the QTRAP 4500MD LC-MS/MS System (Agilent)

Instrument/ Polarity Masses

LIT Positive 118.087 322.049 622.030 922.010 1521.972

LIT Negative 112.985 431.982 601.978 1033.988 1633.949
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Toolbar Icons D
For additional toolbar icons, refer to the document: Advanced User Guide.

Table D-1 Tool Bar Icons

Icon Name Description

New Subproject Creates a subproject. Subprojects can only be created
later in the process if the project was originally created
with subprojects.

Copy
Subproject

Copies a subproject folder.

Subprojects can be copied only from another project
that has existing subprojects. If the same folders exist at
both the project and subproject levels, then the software
uses the project level folders.

Table D-2 Acquisition Method Editor Icons

Icon Name Description

Mass Spec Shows the MS tab in the Acquisition Method editor.

Period Adds an experiment, an IDA Criteria Level, or deletes
the period.

Autosampler Opens the Autosampler Properties tab.

Syringe Pump Opens the Syringe Pump Properties tab.

Column Oven Opens the Column Oven Properties tab.

Valve Opens the Valve Properties tab.

DAD Opens the DAD Method Editor. Refer to the section:
Show DAD Data.

ADC Opens the ADC Properties tab. Refer to the section:
Show ADC Data.
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Table D-3 Acquire Mode Icons

Icon Name Description

View Queue Shows the sample queue.

Instrument
Queue

Shows a remote instrument station.

Status for
Remote
Instrument

Shows the status of a remote instrument.

Start Sample Starts the sample in the queue.

Stop Sample Stops the sample in the queue.

Abort Sample Aborts a sample acquisition in the middle of the
processing of that sample.

Stop Queue Stops the queue before it has completed processing all
of the samples.

Equilibrate Selects the method to be used to equilibrate the
devices. This method should be the same as the
method that was used with the first sample in the queue.

Standby Puts the instrument in Standby state.

Ready Puts the instrument in Ready state.

Reserve
Instrument for
Tuning

Reserves the mass spectrometer for tuning and
calibrating.

IDA Method
Wizard

Starts the IDA Method Wizard.

Icon Name Description

Calibrate from
spectrum

Opens the Mass Calibration Option dialog and uses the
active spectrum to calibrate the mass spectrometer.

Manual Tune Opens the Manual Tune Editor.
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Icon Name Description

Compound
Optimization

Optimizes for a compound using infusion by FIA.

Instrument
Optimization

Verifies the instrument performance, adjusts the mass
calibration, or adjusts mass spectrometer settings.

View Queue Shows the sample queue.

Instrument
Queue

Shows a remote instrument.

Status for
Remote
Instrument

Shows the status of a remote instrument.

Reserve
Instrument for
Tuning

Reserves the instrument for tuning and calibrating.

IDA Method
Wizard

Starts the IDA Method Wizard.

Table D-4 Explore Quick Reference: Chromatograms and Spectrum

Icon Name Description

Open Data File Opens files.

Show Next
Sample

Goes to the next sample.

Show Previous
Sample

Goes to the previous sample.

Go To Sample Opens the Select Sample dialog.

List Data Shows the data in tables.

Show TIC Generates a TIC from a spectrum.

Extract Using
Dialog

Extracts ions by selecting masses.

Show Base
Peak
Chromatogram

Generates a BPC.

Toolbar Icons
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Table D-4 Explore Quick Reference: Chromatograms and Spectrum (continued)

Icon Name Description

Show Spectrum Generates a spectrum from a TIC.

Copy Graph to
new Window

Copies the active graph to a new window.

Baseline
Subtract

Opens the Baseline Subtract dialog.

Threshold Adjusts the threshold.

Noise Filter Shows the Noise Filter Options dialog, which can be
used define the minimum width of a peak. Signals below
this minimum width are regarded as noise.

Show ADC Shows ADC data.

Show Auxiliary
Traces

Opens the Select Auxiliary Trace Channel dialog

Show File Info Shows the experimental conditions used to collect the
data.

Add arrows Adds arrows to the X-axis of the active graph.

Remove all
arrows

Removes arrows from the X-axis of the active graph.

Offset Graph Compensates for slight differences in the time during
which the ADC data and the mass spectrometer data
were recorded. This is useful when overlaying graphs
for comparison.

Force Peak
Labels

Labels all of the peaks.

Expand
Selection By

Sets the expansion factor for a portion of a graph to be
viewed in greater detail.

Clear ranges Returns the expanded selection to normal view.

Set Selection Defines start and stop points for a selection. This feature
provides more accurate selection than is possible by
selecting the region using the cursor.
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Table D-4 Explore Quick Reference: Chromatograms and Spectrum (continued)

Icon Name Description

Normalize To
Max

Scales a graph to maximum size, so that the most
intense peak is scaled to full scale, whether or not it
is visible.

Show History Shows a summary of data processing operations
performed on a particular file, such as smoothing,
subtraction, calibration, and noise filtering.

Open
Compound
Database

Opens the compound database.

Set Threshold Adjusts the threshold.

Show Contour
Plot

Shows selected data as either a spectrum graph or an
XIC. Additionally, for data acquired by a DAD, a contour
plot can show selected data as either a DAD spectrum
or an XWC.

Show DAD TWC Generates a TWC of the DAD spectrum.

Show DAD
Spectrum

Generates a DAD spectrum.

Extract
Wavelength

Extracts up to three wavelength ranges from a DAD
spectrum to view the XWC.

Table D-5 Explore Toolbar Quick Reference: Overlaying Graphs

Icon Name Description

Home Graph Return the graph to the original scale.

Overlay Overlays graphs.

Cycle Overlays Cycles between overlaid graphs.

Sum Overlays Adds the graphs together.
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Table D-6 Explore Toolbar Quick Reference: Fragment Interpretation Tool

Icon Name Description

Show Fragment
Interpretation
Tool

Opens the Fragment Interpretation tool, which
calculates the single, non-cyclic bond cleavage
fragments from a mol file.

Table D-7 Navigation Icons on the Explore Toolbar

Icon Name Function

Open File Opens files.

Show Next
Sample

Navigates to the next sample.

Show Previous
Sample

Navigates to the previous sample.

GoTo Sample Opens the Select Sample dialog.

List Data Shows the data in tables.

Show TIC Generates a TIC from a spectrum.

Extract Using
Dialog

Click to extract ions by selecting masses.

Show Base
Peak
Chromatogram

Generates a BPC.

Show Spectrum Generates a spectrum from a TIC.

Copy Graph to
new Window

Copies the active graph to a new window.

Baseline
Subtract

Opens the Baseline Subtract dialog.

Threshold Adjusts the threshold.

Noise Filter Opens the Noise Filter Options dialog that defines the
minimum width of a peak. Signals below this minimum
width are regarded as noise.

Show ADC Shows ADC data.
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Table D-7 Navigation Icons on the Explore Toolbar (continued)

Icon Name Function

Show Auxiliary
Traces

Opens the Select Auxiliary Trace Channel dialog

Show File Info Shows the experimental conditions used to collect the
data.

Add arrows Adds arrows to the X-axis of the active graph.

Remove all
arrows

Removes arrows from the X-axis of the active graph.

Offset Graph Compensates for slight differences in the time during
which the ADC data and the mass spectrometer data
were recorded. This is useful when overlaying graphs
for comparison.

Force Peak
Labels

Labels all the peaks.

Expand
Selection By

Sets the expansion factor for a portion of a graph to
view in greater detail.

Clear ranges Returns the expanded selection to normal view.

Set Selection Sets start and stop points for a selection. This provides
more accurate selection than is possible by highlighting
the region using the cursor.

Normalize to
Max

Scales a graph to maximum, so that the most intense
peak is scaled is to full scale, whether or not it is visible.

Show History Shows a summary of data processing operations
performed on a particular file, such as smoothing,
subtraction, calibration, and noise filtering.

Open
Compound
Database

Opens the compound database.

Set Threshold Adjusts the threshold.
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Table D-7 Navigation Icons on the Explore Toolbar (continued)

Icon Name Function

Show Contour
Plot

Shows selected data as either a spectrum graph or an
XIC. Additionally, for data acquired by a DAD, a contour
plot can display selected data as either a DAD spectrum
or an XWC.

Show DAD TWC Generates a TWC of the DAD.

Show DAD
Spectrum

Generates a DAD spectrum.

Extract
Wavelength

Extracts up to three wavelength ranges from a DAD
spectrum to view the XWC.

Table D-8 Integration Tab and Quantitation Wizard Icons

Icon Name Description

Set parameters
from
Background
Region

Uses the selected peak.

Select Peak Uses the selected background.

Manual
Integration
Mode

Manually integrates peaks.

Show or Hide
Parameters

Shows or hides the peak-finding parameters.

Show Active
Graph

Shows the analyte chromatogram only.

Show Both
Analyte and IS

Shows the analyte and its associated chromatogram.
Available only when an associated internal standard
exists.

Use Default
View for Graph

Returns to the preset, view all data, view if, for example,
the user has zoomed in on a chromatogram.
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Table D-9 Results Table Icons

Icon Name Description

Sort Ascending
by Selection

Sorts the selected column in ascending order.

Sort
Descending by
Selection

Sorts the selected column in descending order.

Lock Or Unlock
Column

Locks or unlocks the selected column. A locked column
cannot be moved.

Metric Plot By
Selection

Creates a metric plot from the selected column.

Show all
Samples

Shows all of the samples in the Results Table.

Delete Formula
Column

Deletes formula columns.

Report
Generator

Opens the Reporter software.

Table D-10 Icon Quick Reference: Quantitate Mode

Icon Name Description

Add/Remove
Samples

Adds or removes samples from the Results Table.

Export as Text Saves the Results Table as a text file.

Modify Method Opens a wiff file.

Peak Review -
Pane

Opens peaks in a pane.

Peak Review -
Window

Opens peaks in a window.

Calibration -
Pane

Opens the calibration curve in a pane.

Calibration -
Window

Opens the calibration curve in a window.

Show First Peak Shows the first peak in the pane or window.

Toolbar Icons
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Table D-10 Icon Quick Reference: Quantitate Mode (continued)

Icon Name Description

Show Last Peak Shows the last peak in the pane or window.

Show Audit Trail Shows the audit trail for the Results Table.

Clear Audit Trail Clears the audit trail for the Results Table. This
functionality is not available.

Statistics Opens the Statistics window.

Report
Generator

Opens the Reporter software.

Table D-11 Acquire Mode Icons

Icon Name Function

Start Sample Click to start the sample in the queue.

Stop Sample Click to stop the sample in the queue.

Equilibrate Click to select a method to use to equilibrate the mass
spectrometer, which includes the ion source, LC column
if used, and any peripheral devices. This method should
be the same as the one used with the first sample in the
queue.
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Theory of Operation — Ion Source E

Electrospray Ionization Mode
The probe is located centrally between the two turbo heaters, which are located at a 45-degree
angle on either side of the probe. The combination of the spray and the heated dry gas from the
turbo heaters is projected at a 90-degree angle to the aperture in the curtain plate.

Only compounds that ionize in the liquid solvent can be generated as gas phase ions in the
source. The efficiency and rate of ion generation depends on the solvation energies of the
specific ions. Ions with lower solvation energies are more likely to evaporate than ions with
higher solvation energies.

The interaction of the IonSpray Voltage and the turbo heaters helps focus the stream and
increases the rate of droplet evaporation, resulting in an increased ion signal. The heated gas
increases the efficiency of ion evaporation, resulting in increased sensitivity and the ability to
handle higher liquid sample flow rates.

A high-velocity flow of nebulizer gas shears droplets from the liquid sample stream in the
IonSpray Voltage inlet.Using the variable high voltage applied to the sprayer, the ion source
applies a net charge to each droplet. This charge aids in the droplet dispersion. Ions of a single
polarity are preferentially drawn in the droplets by the high voltage as they are separated from
the liquid stream. However, this separation is incomplete and each droplet contains many ions of
both polarities. Ions of one polarity are predominant in each droplet, and the difference between
the number of positively or negatively charged ions results in the net charge. Only the excess
ions of the predominant polarity are available for ion evaporation, and only a fraction of these
actually evaporate.

The probe can generate multiply-charged ions from compounds that have multiple charge sites,
such as peptides and oligonucleotides. This is useful during analysis of high-molecular-weight
species where the multiple charges produce ions of a mass-to-charge ratio (m/z) within the
mass range of the mass spectrometer. This allows routine molecular-weight determinations of
compounds in the kiloDalton (kDa) range.

Each charged droplet contains solvent and both positive and negative ions, but with ions of one
predominant polarity. Refer to the figure: Figure E-1. As a conducting medium, excess charges
reside at the surface of the droplet. As the solvent evaporates, the electrical field at the surface
of the droplet increases due to the decreasing radius of the droplet.
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Figure E-1 Ion Evaporation

Item Description

1 Droplet contains ions of both polarities with one polarity being predominant.

2 As the solvent evaporates, the electrical field increases and the ions move
to the surface.

3 At some critical field value, ions are emitted from the droplets.

4 Nonvolatile residue remains as a dry particle.

If the droplet contains excess ions and enough solvent evaporates from the droplet, a critical
field is reached at which ions are emitted from the surface. Eventually, all of the solvent will
evaporate from the droplet, leaving a dry particle consisting of the nonvolatile components of the
sample solution.

Because the solvation energies for most organic molecules are unknown, the sensitivities of any
given organic ion to ion evaporation are difficult to predict. The importance of solvation energy
is evident because surfactants that concentrate at the surface of a liquid can be detected very
sensitively.

APCI Mode
The basis for past incompatibilities in linking liquid chromatography with mass spectrometry
arose from difficulties converting relatively nonvolatile molecules in solution in a liquid into a
molecular gas without inducing excessive decomposition. The APCI probe process of gently
nebulizing the sample to finely dispersed small droplets in a heated ceramic tube results in the
rapid vaporization of the sample so that the sample molecules are not decomposed.

The following figure shows the reaction flow of the APCI process for reactant positive ions, the
proton hydrates, H3O+[H2O]n.
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Figure E-2 APCI Reaction Flow Diagram

The major primary ions N2
+, O2

+, H2O+, and NO+ are formed by the electron impact of corona-
created electrons on the major neutral components of air. Although NO+ is normally not a major
constituent of clean air, the concentration of this species in the ion source is enhanced due to
neutral reactions initiated by the corona discharge.
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Samples that are introduced through the APCI probe are sprayed, with the aid of a nebulizer
gas, in the heated ceramic tube. Within the tube, the finely dispersed droplets of sample
and solvent undergo a rapid vaporization with minimal thermal decomposition. The gentle
vaporization preserves the molecular identity of the sample.

The gaseous sample and solvent molecules pass to the ion source housing where the ionization
by APCI is induced by a corona discharge needle connected to the end of the ceramic tube. The
sample molecules are ionized by colliding with the reagent ions that are created by the ionization
of mobile phase solvent molecules. The vaporized solvent molecules ionize to produce the
reagent ions [X+H]+ in Positive polarity and [X-H]– in Negative polarity. Refer to the figure: Figure
E-3. It is these reagent ions that produce stable sample ions when they collide with the sample
molecules.

Figure E-3 Atmospheric Pressure Chemical Ionization

Item Description

1 Sample

2 Primary ions are created in the vicinity of the corona discharge needle

3 Ionization produces predominantly solvent ions

4 Reagent ions react with sample molecules, forming clusters

5 Curtain plate

6 Interface

x = solvent molecules; M=sample molecules

The sample molecules are ionized through a process of proton transfer in Positive polarity
and by either electron transfer or proton transfer in Negative polarity. The energy for the APCI
ionization process is collision-dominated because of the relatively high atmospheric pressure of
the ion source.

For reverse phase applications, the reagent ions consist of protonated solvent molecules in
Positive polarity and solvated oxygen ions in Negative polarity. With favorable thermodynamics,
the addition of modifiers changes the reagent ion composition. For example, the addition of
acetate buffers or modifiers can make the acetate ion [CH3COO]– the primary reagent in
Negative polarity. Ammonium modifiers might make protonated ammonia [NH4]+ the primary
reagent in Positive polarity.

Through collisions, an equilibrium distribution of certain ions, such as protonated water cluster
ions, is maintained. The likelihood of premature fragmentation of the sample ions in the ion
source is reduced because of the moderating influence of solvent clusters on the reagent ions
and the relatively high gas pressure in the ion source. As a result, the ionization process yields
primarily molecular product ions for mass analysis in the mass spectrometer.
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APCI Ionization Region
The following figure shows the general location of the ion-molecule reactor of the APCI probe.
The slanted lines indicate a wall-less reactor. A self-starting corona discharge ion current in the
microampere range is created as a result of the electric field between the discharge needle and
the curtain plate. Primary ions, for example, N2

+ and O2
+, are created by the loss of electrons

that originate in the plasma in the immediate vicinity of the discharge needle tip. The energy
of these electrons is moderated by a number of collisions with gas molecules before attaining
an energy where their effective ionization cross-section allows them to ionize neutral molecules
efficiently.

Figure E-4 APCI Ionization Region

Item Description

1 Discharge needle tip
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Item Description

2 Sample flow

3 Wall-less reactor

4 Curtain plate aperture

5 Gas for the Curtain Gas interface

6 Orifice

7 Orifice plate

8 Ceramic tube

The primary ions, in turn, generate intermediate ions that lead to the formation of sample ions.
Ions of the chosen polarity drift under the influence of the electric field in the direction of the
curtain plate and through the gas curtain to the mass analyzer. The whole ion formation process
is collision-dominated because of the relatively high atmospheric pressure of the APCI probe.
Except in the immediate vicinity of the discharge needle tip, where the strength of the electric
field is greatest, the energy imparted to an ion by the electric field is small in comparison with the
thermal energy of the ion.

Through collisions, an equal distribution of certain ions (for example, protonated water cluster
ions) is maintained. Any excess energy that an ion might acquire in the ion-molecule reaction
process is thermalized. Through collisional stabilization, many of the product ions are fixed, even
though many subsequent collisions occur. The formation of both product ions and reactant ions
is governed by equilibrium conditions at 760 torr (atmospheric) operating pressure.

The APCI probe functions as a wall-less reactor because the ions that pass from the ion source
to the vacuum chamber and eventually to the detector never experience collisions with a wall—
only collisions with other molecules. Ions are also formed outside the designated ion source, but
are not detected and are eventually neutralized by interacting with a wall surface.

The temperature of the probe is an important factor for APCI probe operation. To preserve the
molecular identity, the temperature must be set high enough to ensure a rapid evaporation.
At a sufficiently high operating temperature, the droplets are vaporized quickly so that organic
molecules are desorbed from the droplets with minimal thermal degradation. If, however, the
temperature is set too low, the evaporation process is slower and pyrolysis, or decomposition,
might occur before vaporization is complete. Operating the APCI probe at temperatures above
the optimal temperature might cause thermal decomposition of the sample.
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Manual Compound Optimization F
The user must control the autosampler and injection valve manually, because these devices
cannot be controlled through the system while it is in Tune and Calibrate mode.

Prerequisites

• The mass spectrometer is tuned and calibrated.

• Conditions for an LC separation are known.

• The hardware profile contains a syringe pump.

• All of the required peripheral devices, including the syringe pump, if required, and LC
components are in the hardware profile.

Required Materials

To tune instrument parameters for particular compounds the following solutions are
recommended. The mixture of four compounds is used for illustrating the steps of the
procedure. The user must apply the same procedure while using the appropriate compounds
for the assay of interest.

• Mobile phase: 1:1 acetonitrile:water + 2 mM ammonium acetate + 0.1% formic acid.

• LC pump and autosampler.

• Autosampler vials.

• Four-compound mix (10 ng/mL), consisting of reserpine, minoxidil, tolbutamide, and
rescinnamine. The solution can be used for infusion and FIA. The concentration is system-
dependent. Use a solution that is 49.9% acetonitrile, with 50% deionized water and 0.1%
formic acid as diluent. Other compounds can be substituted as long as their molecular
weight is known and the compound is reasonable to be ionized by the Turbo V ion source.

Table F-1 Compounds and m/z Values

Compound m/z Value

Minoxidil 210.2

Tolbutamide 271.1

Reserpine 609.3

Rescinnamin
e

635.3
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About Manual Compound Optimization
Manual compound optimization is used to optimize compound- and ion source-dependent
parameters for an analyte. When the user manually optimizes for an analyte, an MS acquisition
method is created in Tune and Calibrate mode. Depending on the method of sample introduction
selected, add an LC method to the acquisition method so that infusion or LC can be used.

Optimizing to give the highest signal does not always give the highest signal-to-noise ratios.
Noise can scale with signal for some parameters and should be verified during optimization if the
goal is to maximize the signal-to-noise ratio.

When optimizing ion source-dependent parameters, introduce the sample at flow rates that will
be used during sample analysis, using either flow injection analysis (FIA) or tee-infusion as
the method of sample introduction. The CAD gas parameter is the only compound-dependent
parameter that is shown on the Source/Gas tab and can be easily optimized while infusing the
analyte.

Optimize the position of the ion source before optimizing the ion source-dependent parameters.
Refer to the section: Ion Source Optimization.

About Scan Types
For this example, use the Q1 MS, Q1 MI, Product Ion, and MRM scan types. The Q1 MS scan
type is used to confirm the presence of compounds of interest. The Q1 MI scan is used to
optimize MS or pre-collision cell voltages. The Product Ion scan type is used to determine the
product ions of each compound. The MRM scan type is used to optimize the collision energy
(CE) and collision cell exit potential (CXP) for each product ion or fragment. Use the methods
created in this section for quantitative or qualitative analysis.

Manually Optimize an Analyte
After the acquisition method is created, optimize compound-dependent parameters using the
Edit Ramp function or by manually editing the parameters in the Tune Method Editor. Ion
source-dependent parameters can be optimized only by manually adjusting the parameters in
the Tune Method Editor. Depending on the scan type used, different parameters are available to
optimize.

Follow the procedures in the order given:

1. Confirm the Presence of Compounds

2. Optimize MS-Specific Parameters
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3. Determine the Product Ions for Optimization

4. Optimize Collision Cell Exit Potential for each Product Ion

Confirm the Presence of Compounds
1. Create a project.

2. Activate the hardware profile.

3. Prepare the sample:

a. Aspirate the compound solution into a syringe and remove the air from the syringe.

b. Use the tubing with the special fitting to connect the syringe to the mass spectrometer.

c. Install the syringe in the integrated syringe pump.

4. Infuse the compound in solution at a rate of 5 µL/min to 10 µL/min.

5. On the Navigation bar, under Tune and Calibrate, double-click Manual Tuning.

6. In the method list field, click Syringe Pump Method.

7. On the Syringe Pump Method Properties tab, type the parameter values shown in the
following table.

Table F-2 Syringe Pump Method Properties Tab

Parameter Value

Syringe Diameter Syringe dependent. 4.610 mm if a 1.0 mL
syringe is used

Flow Rate 10

Unit µL/min

Figure F-1 Syringe Pump Method Properties Tab

8. Click Start Syringe Pump.

Manual Compound Optimization

System User Guide
IVD-IDV-05-6996-D

SCIEX 4500MD Systems
285/313



9. Select MS Method from the method list.

10. On the MS tab, type the parameter values shown in the following table.

Table F-3 MS Tab

Parameter Value

Scan type Q1 MS (Q1)

Start (Da) 200

Stop (Da) 700

Scan rate (Da/s) 200

Duration (min) 3

11. Click Start.

12. Wait until an even TIC is shown on the left and peaks are shown on the right and then click
Stop.

13. Select the MCA check box.

14. Type 10 In the Cycles field.

15. Click Start.
When ten scans are complete, the masses of the four compounds are shown as ions.

Tip! If the previous or expected ion chromatogram pane is hidden, then select the window to
be shown from the Window menu.

Note: Ion intensities of the compounds can show large variances. To facilitate moving to a
solution of higher or lower concentration as needed during the optimization, have several
concentration levels prepared before beginning optimization.

16. Right-click the bottom-right spectral pane and then click Open File.

17. Find the compounds of interest and then write down the m/z values for the highest peaks.
These values should be within 0.1 Da to 0.2 Da of the expected m/z value. In the next
procedure, use the m/z values.

Optimize MS-Specific Parameters
The DP is the difference between the orifice and the ground. The higher the potential difference,
the greater the amount of declustering.

The DP parameter has a significant effect on analyte signal. Typical DP values range from 20 V
to 150 V. A DP value that is too low can result in lower ion intensity and potential interferences
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from clusters. A DP value that is too high can cause fragmentation of the analyte in the source.
Generally, the DP should be set to the value that provides the highest intensity.

The EP parameter controls the entrance potential, which guides and focuses the ions through
the high-pressure Q0 region. It is typically set at 10 V for positive ions or –10 V for negative ions.
The EP has a minor effect on compound optimization and can generally be left at default values
without impact on analyte detection limits.

1. Return to the Tune Method Editor and change the method to the Q1 Multiple Ions (Q1 MI)
scan type.

2. In the mass table, type the appropriate parameter values. Refer to the following table.

Table F-4 Mass Table Parameters—Q1 Multiple Ions (Q1 MI)

Compound Q1 Mass Time

Reserpine 609.3 1

Minoxidil 210.2 1

Tolbutamide 271.1 1

Rescinnamine 635.3 1

Start with reserpine for a simple case. Repeat the manual optimization process for the
remaining compounds.

3. Click Edit Ramp.

4. Select Declustering Potential (DP) in the Ramp Parameter Settings dialog.

Note: Start with the DP parameter and then optimize the other parameters in the order in
which they are shown in the dialog. The parameters might not be optimized correctly if they
are optimized out of order.

5. Type the required Start, Stop, and Step values.

Tip! The existing values are good starting points. Use the Edit Ramp function to change
these values to be more efficient.

6. Click OK.

7. Click Start.

8. Right-click the bottom-right XIC pane and then click Open File to maximize the XIC view.

9. Monitor the XICs.

Note: The value that gives the best signal per second for the ion of interest is the optimal
value.
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10. Note the optimal value for the ion of interest.

11. Move the cursor to the mass table, right-click, and then add the parameter just optimized.
A column is added to the table.

12. Add the optimized value to the appropriate row.

13. Repeat these steps for each mass in the acquisition method until there is a list of optimal
values for all of the masses.

14. Repeat these steps to optimize for the other MS-specific parameters.

Table F-5 MS-Specific Parameters

Parameter Comment

DP Set the DP to the value that provides the highest intensity.

EP Rarely optimize this parameter because it has a smaller effect.

CEP Select the CEP value with the largest intensity.

Determine the Product Ions for Optimization
The collision energy (CE) controls the amount of energy that the precursor ions receive as they
are accelerated into the collision cell.

Perform this procedure, one compound at a time, using the MS-specific optimized values that
were obtained previously. The product ions provide the Q3 mass of MRM transitions.

In this example, the compound reserpine is used.

1. In the Tune Method Editor, close the XIC panes.

2. Click Product Ion (MS2) in the Scan type field.

3. On the Compound tab, type the optimal value noted in section: Optimize MS-Specific
Parameters.

4. On the MS tab, in the Product Of field, type 609.4.
This value is the mass assignment for reserpine that was noted in the section: Confirm the
Presence of Compounds.

5. Make sure that the Center / Width check box is not selected.

6. In the mass table, type the appropriate Start, Stop, and Time values. Refer to the table:
Table F-6.
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Table F-6 Mass Table Parameters (Product Ion Scan)

Field Value

Start (Da) 100

Stop (Da) 650

Time (sec) 2

7. Click Edit Ramp.
The Ramp Parameter Settings dialog opens.

8. Select Collision Energy and then type the required Start, Stop, and Step values.

Note: The existing values are good starting points. Use the Edit Ramp function to change
these values to be more efficient.

9. Click OK.

10. Select the MCA check box.

11. Click Start.

12. Right-click the bottom-right XIC pane and then click Open File.

13. Select the product ions with the greatest intensity and note the product ion m/z value to the
first decimal point, such as 195.1.
We recommend that two or three product ions be optimized for each compound. The
additional transitions can be used for confirmation, or to avoid the need to re-optimize a
compound in case an interference is found.

Note: Make sure that the highest peaks selected for optimization do not represent a
common loss from the precursor ion, such as water or carbon dioxide. Also make sure
that the product ion is not too low in mass or interferences might occur for that transition in
real samples or clusters from the mobile phase when analyzing on column.

14. Repeat this procedure for the remaining compounds.

Optimize Collision Cell Exit Potential for each Product Ion
1. In the Tune Method Editor, close the XIC panes.

2. Open the previously saved method.

3. In the mass table, verify the Q1 and Q3 m/z values for the compound.

4. Click the Compound tab and then type the optimal DP and CE values noted in section:
Optimize MS-Specific Parameters.

5. Click Edit Ramp.
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6. Select Collision Cell Exit Potential (CXP) in the Ramp Parameter Settings dialog.

7. Type the required Start, Stop, and Step values.

Tip! The existing values are good starting points. Use the Edit Ramp function to change
these values to be more efficient.

8. Click OK.

9. Click Start.

10. Right-click the bottom-right XIC pane and then click Open File.

11. Note the optimal value for the ion of interest.
The value that gives the best signal is the optimal value.

12. In the mass table, right-click and then select the parameter just optimized.
This adds a column to the table.

13. Repeat if other product ions were monitored.

14. Add the optimized values to the appropriate row.

15. Save the method.

16. Repeat this procedure for any other compounds that were previously optimized.

Manually Optimize the Ion Source and Gas
Parameters
The ion source and gas settings must be set correctly to prevent contamination of the mass
spectrometer and to make sure that the compounds of interest are optimally put into the gas
phase as ions.

Note: The optimal ion source and gas settings are related to the solvent composition and the
flow rate.

The ion source and gas settings must be adjusted when the LC conditions change significantly.

To optimize the ion source and gas parameters, set up a syringe pump with the compounds
of interest and then connect the sample tubing with a tee to the LC device. Controlling the LC
pump can be done manually or through the software.

Another way to manually optimize ion source and gas settings is to use the autosampler to
manually inject the compound of interest while manually varying the parameters in manual
tuning to find the optimal settings.
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Prepare the Ion Source
1. Set the horizontal micrometer to 5.

2. Set the vertical micrometer on the ion source for the flow rate.
Use the parameters in the following table.

Table F-7 Turbo V Ion Source Vertical Parameters

Flow Rate Initial Vertical Parameters

1 µL/min to 20 µL/min 10

20 µL/min to 250 µL/min 5

250 µL/min to 500 µL/min 2

500 + µL/min 0

Depending on how the optimization is run, a hardware profile with the LC pumps might need
to be configured.

Refer to the section: Ion Source Optimization.

Optimize the Ion Source Parameters
Ion source parameters are optimized for best signal-to-noise for the compound of interest. The
flow rate for the gas for the Curtain Gas interface is optimized at the highest setting without
losing sensitivity. Refer to the section: Ion Source Optimization.

Use the following procedure to optimize the Curtain Gas (CUR) parameter. The main function of
the this parameter is to prevent the contamination of the ion optics. The CUR parameter should
always be maintained as high as possible without losing sensitivity. The value depends on the
type of mass spectrometer and ion source.

Do not set the parameter below the starting value.

1. On the Navigation bar, under Tune and Calibrate, double-click Manual Tuning.

2. Click File > Open.

3. In the Files list, click the acquisition method used to optimize the compound parameter and
then click OK.
The method opens in the Tune Method Editor.

4. Open the Source/Gas tab.

5. Using the ion source and gas flow guide, set all of the ion source and gas parameters so
that they are appropriate for the flow rate.
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6. Set the run time long enough so that many parameters can be adjusted. A recommended
starting time is 15 minutes.

7. Click Start.
Data is shown in panes below the Tune Method Editor.

8. Note the signal of the peak of interest.

9. In the Curtain Gas (CUR) field, increase the value by five.

10. Continue increasing the Curtain Gas (CUR) value until the highest value without losing
sensitivity is found.
As with most Source/Gas parameters, if two values give the same result, then use the
higher value.

11. Repeat this procedure for the other Source/Gas parameters.
When optimizing for these parameters, look for the value that gives the highest signal-to-
noise value.

Advanced Parameters
The following parameters should only be optimized by an experienced operator.

Optimize AF2
The AF2 parameter controls the fragmentation of the second precursor ion in an MS3 scan.
The amount of excitation energy used depends on the compound and the desired amount of
fragmentation.

1. For both positive and negative ion modes, ramp AF2 as follows: 70 mV to 300 mV, with a
Step value of 10 mV. The allowable range if 0 mV to 1000 mV.

2. Select the AF2 value that gives the best amount of fragmentation.

About Collision Energy Spread (CES)
A unique feature of QTRAP mass spectrometers is the ability to perform AutoFrag experiments.
A composite spectrum can be obtained by filling the linear ion trap with ions from three distinct
collision energies, which eliminates the need for optimizing the collision energy.

Under the compound-dependent parameters in Enhanced Product Ion (EPI) and MS3
experiments, the collision energy spread (CES) field allows users to specify the difference in
collision energies that will be applied in the experiment. For example, if CE value of 30 and a
CES value of 15 are used, then collision energies of 15, 30, and 45 are used.
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Right-Click Menus G

Batch Editor
Right-click the Batch Editor table to access the options.

Figure G-1 Batch Right-Click Menu

Menu Function

Open Opens a batch file.

Import From Imports a batch from a file.

Save As Batch Saves the batch with a different name.

Save As a
Template

Saves the batch as a template.
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Menu Function

Hide/Show
Column

Hides or shows a column.

Save Column
Settings

Saves the batch column settings.

Add Custom
Column

Adds a custom column.

Delete Custom
Column

Deletes a custom column.

Fill Down Copies the same data into the selected cells.

AutoIncrement Automatically increments data in the selected cells.

Delete Samples Deletes the selected row.

Select
Autosampler

Selects an autosampler.

Queue States and Device Status
The Queue Manager shows queue, batch, and sample status. Detailed information about a
particular sample in the queue can also be viewed.

Tip! Click View Queue ( ) to view the queue.

For information on using the Queue right-click menu, refer to the section: Queue.

Queue States
The current state of the queue is indicated in the Queue Server group.

Figure G-2 Queue Server Indicator Showing Normal Mode
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Figure G-3 Queue Server Indicator Showing Tune Mode

The first icon indicates the queue state. The second icon indicates whether the queue is in
Tune mode (for tuning) or Normal mode (for running samples). For descriptions of the icons and
queue states, refer to the table: Table G-1.

Table G-1 Queue States

Icons State Definition

Not
Ready

The hardware profile is deactivated and the queue is
not accepting any sample submissions.

Stand By The hardware profile has been activated, but all
devices are idle. Pumps are not running and gases
are turned off.

Warming
Up

The mass spectrometer and devices are
equilibrating, columns are being conditioned, the
autosampler needle is being washed, and column
ovens are reaching temperature. The duration of
equilibration is selected by the operator. From this
state, the system can go to the Ready state.

Ready The system is ready to start running samples and the
devices have been equilibrated and are ready to run.
In this state, the queue can receive samples and will
run after samples are submitted.

Waiting The system will automatically begin acquisition when
the next sample is submitted.

PreRun The method is being downloaded to each device and
device equilibration is occurring. This state occurs
before the acquisition of each sample in a batch.

Acquiring The method is running and data acquisition is
occuring.
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Table G-1 Queue States (continued)

Icons State Definition

Paused The system has been paused during acquisition.

View Instrument and Device Status Icons
Icons representing the mass spectrometer and each device in the active hardware configuration
are shown on the status bar in the bottom right corner of the window. The user can view the
detailed status of an LC pump to make sure the LC pump pressure is appropriate or view the
detailed status of the mass spectrometer to monitor the temperature of the ion source.

Note: For each status, the background color can be red. A red background indicates that the
device encountered an error while in that state.

On the status bar, double-click the icon for the device or mass spectrometer.
The Instrument Status dialog opens.

Table G-2 Instrument and Device Status Icons

Status Icon Background
Color

Description

Idle
 

Green or
yellow

The device is not running. If the background
color is yellow, then the device should be
equilibrated before it is ready to run. If the
background color is green, then the device is
ready to run.

Equilibrating
 

Green or
yellow

The device is equilibrating.

Waiting Green The device is waiting for a command from the
software or another device, or for some action
by the operator.

Running Green The device is running a batch.

Aborting Green The device is aborting a run.

Downloading Green A method is being transferred to the device.
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Table G-2 Instrument and Device Status Icons (continued)

Status Icon Background
Color

Description

Ready Green The device is not running, but is ready to run.

Error Red The device has encountered an error that
should be investigated.

Queue
Right-click the Queue table to access the options.

Figure G-4 Queue Manager Right-Click Menu

Menu Function

Sample Details Opens the Sample Details dialog.

Reacquire Acquires a sample again.
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Menu Function

Insert Pause Inserts a pause, in seconds, between two samples. This
feature is not available in this version of the software.

Delete Deletes either the batch or the selected samples.

Move Batch Moves the batch within the queue.

Sort Sorts on the preselected column.

Column Settings Changes the column settings.

Right-Click Menu for Contour Plot Panes
Menu Function

Show DAD Spectrum Opens a new pane with the DAD spectrum.

Extract Wavelengths (Use Range) Extracts up to three wavelength ranges from a
DAD spectrum to display the XWC.

Extract Wavelengths (Use Maximum) Extracts wavelength ranges using the
maximum wavelengths.

Zoom to selection Zooms in on the selected area.

Add User Text Adds a text box at the position of the cursor.

Undo Zoom Returns the graph to the original scale

Delete Pane Deletes the selected pane

Show Cross-Hair Shows the Cross-Hair (nm/min)

Show File Information Pane Right-click Menu
Table G-3 Show File Information Pane Right-click Menu

Menu Function

Copy Copies the selected data.

Paste Pastes data.

Right-Click Menus

SCIEX 4500MD Systems
298/313

System User Guide
IVD-IDV-05-6996-D



Table G-3 Show File Information Pane Right-click Menu (continued)

Menu Function

Select All Selects all of the data in the pane.

Save To File Saves data as an rtf file.

Font Changes the font.

Save Acquisition
Method

Saves the acquisition method as a dam file.

Save Acquisition
Method to
CompoundDB

Opens the Specify Compound Information dialog. Select the IDs
and molecular weights to be saved in the compound database.

Delete Pane Deletes the selected pane.

Spectra Panes
Table G-4 Right-click Menu for Spectra Panes

Menu Function

List Data Lists the data points and integrates chromatograms.

Show TIC Generates a new pane containing the TIC.

Extract Ions (Use Range) Extracts a specific ion or set of ions from a selected
pane and then generates a new pane containing a
chromatogram for the specific ions.

Extract Ions (Use Maximum) Extracts ions using the most intense peak in a selected
area.

Save to Text File Generates a text file of the pane, which can be opened in
Microsoft Excel or other programs.

Save Explore History Saves information about changes to processing
parameters, also called Processing Options, that were
made when a wiff file was processed in Explore mode.
The processing history is stored in a file with an eph
(explore processing history) extension.

Add Caption Adds a caption at the cursor location in the pane.

Add User Text Adds a text box at the cursor location in the pane.

Show Last Scan Shows the scan prior to the selection.
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Table G-4 Right-click Menu for Spectra Panes (continued)

Menu Function

Select Peaks For Label In this dialog, select the parameters to reduce peak
labeling.

Delete Pane Deletes the selected pane.

Add a Record Adds records and compound-related data, including
spectra, to the library. An active spectrum is required to
perform this task.

Search Library Searches the library without constraints or with previously
saved constraints.

Set Search Constraints Searches the library using the criteria typed in Search
Constraints dialog.

Chromatogram Panes
Table G-5 Right-click Menu for Chromatogram Panes

Menu Function

List Data Lists the data points and integrates the peaks found in chromatograms.

Show Spectrum Generates a new pane containing the spectrum.

Show Contour Plot Shows a color-coded plot of a dataset, where the color represents
the intensity of the data at that point. Only certain MS modes are
supported.

Extract Ions Extracts a specific ion or set of ions from a selected pane and then
generates a new pane containing a chromatogram for the specific ions.

Show Base Peak
Chromatogram

Generates a new pane containing a base peak chromatogram.

Show ADC Data Generates a new pane containing the ADC data trace, if acquired.

Show Auxiliary
Traces

Opens the Select Auxiliary Trace Channel dialog.

Show UV Detector
Data

Generates a new pane containing the UV data trace, if acquired.

Save to Text File Generates a text file containing the data in a pane, which can be
opened in Microsoft Excel or other programs.
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Table G-5 Right-click Menu for Chromatogram Panes (continued)

Menu Function

Save Explore
History

Saves information about changes to processing parameters, also
called processing options, that were made when a wiff file was
processed in Explore mode. The processing history is stored in a file
with an eph (explore processing history) extension.

Add Caption Adds a caption at the cursor location in the pane.

Add User Text Adds a text box at cursor location in the pane.

Set Subtract Range Sets the subtract range in the pane.

Clear Subtract
Range

Clears the subtract range in the pane.

Subtract Range
Locked

Locks or unlocks the subtract ranges. If the subtract ranges are not
locked, then each subtract range can be moved independently. The
subtract ranges are preset to locked.

Delete Pane Deletes the selected pane.

Results Table
Right-click the Results Table to access the options shown in the following table.

Table G-6 Results Table Right-click Menu

Menu Function

Full Shows all the columns.

Summary Shows specific columns.

Analyte Shows a specific analyte.

Analyte
Group

Creates an analyte group.

Sample Type Shows samples of a specific type or all samples.

Add Formula
Column

Adds a formula column. It is recommended that the user validate the results if
a formula column is used.

Table
Settings

Edits or selects a table setting.
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Table G-6 Results Table Right-click Menu (continued)

Menu Function

Query Creates or selects a query.

We recommend that the user validate any queries that are used to analyze
data in a Results Table.

Sort Creates a sort or sorts by index.

Metric Plot Creates a metric plot.

Delete Pane Deletes the active pane.

Fill Down Copies the same data into the selected cells.

Add Custom
Column

Adds a custom column.

Delete
Custom
Column

the selected custom column.

Peak Review
Right-click the Peak Review window or pane to access the options shown in Table G-7.

Table G-7 Peak Review Right-click Menu

Menu Function

Options Opens the Peak Review Options dialog.

Sample
Annotation

Opens the Sample Annotation dialog.

Save Active to
Text File

Saves the selected peak as a text file.

Show First
Page

Goes to the first sample.

Show Last
Page

Goes to the last sample.

Slide Show
Peak Review

Opens the slide show.

Update Method Updates the algorithm for all peaks.

Right-Click Menus

SCIEX 4500MD Systems
302/313

System User Guide
IVD-IDV-05-6996-D



Table G-7 Peak Review Right-click Menu (continued)

Menu Function

Revert to
Method

Selects a redefined peak based on the current quantitation method.

Delete Pane Deletes the active pane.

Calibration Curve
Right-click the Calibration window or pane table to access the options shown in the following
table.

Table G-8 Calibration Curve Right-click Menu

Menu Function

Exclude
(Include)

Right-click a point and then click Exclude to exclude the point from the
curve. Right-click a point and then click Include to include the point.

Exclude All
Analytes
(Include All
Analytes)

Right-click a point and then click Exclude All Analytes to exclude all of
the analytes from the curve. Right-click a point and then click Include All
Analytes to include the points.

Show Peak Reviews an individual peak.

Overlay Overlays two graphs.

Active Plot Determines which plot is active.

Legend Shows the graph legend.

Log Scale X
Axis*

Uses a log scale for the X-axis.

Log Scale Y
Axis*

Uses a log scale for the Y-axis.

Delete Pane Deletes the active pane.

Home Graph Scales the graph to its original size

* A log scale arranges the data points in a more manageable view so that the effect of all points
can be monitored simultaneously. For this view, select Log Scale Y Axis versus Log Scale X
and not just the log of one axis.
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Glossary of Symbols H
Note: Not all of the symbols in the following table are applicable to every instrument.

Symbol Description

Australian Regulatory Compliance Mark. Indicates that the product
complies with Australian Communications Media Authority (ACMA) EMC
Requirements.

Alternating current

A Amperes (current)

Asphyxiation Hazard

Authorized representative in the European community

Biohazard

CE Marking of Conformity

cCSAus mark. Indicates electrical safety certification for Canada and USA.

Catalog number
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Symbol Description

Caution. Consult the instructions for information about a possible hazard.
Note: In SCIEX documentation, this symbol identifies a personal injury
hazard.

China RoHS Caution Label. The electronic information product contains
certain toxic or hazardous substances. The center number is the
Environmentally Friendly Use Period (EFUP) date, and indicates the
number of calendar years the product can be in operation. Upon the
expiration of the EFUP, the product must be immediately recycled. The
circling arrows indicate the product is recyclable. The date code on the
label or product indicates the date of manufacture.

China RoHS logo. The device does not contain toxic and hazardous
substances or elements above the maximum concentration values and it
is an environmentally-friendly product that can be recycled and reused.

Consult instructions for use.

Crushing Hazard

cTUVus mark for TUV Rheinland of North America

Data Matrix symbol that can be scanned by a barcode reader to obtain a
unique device identifier (UDI)

Environmental Hazard

Ethernet connection
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Symbol Description

Explosion Hazard

Eye Injury Hazard

Fire Hazard

Flammable Chemical Hazard

Fragile

Fuse

Hz Hertz

International safety symbol "Caution, risk of electric shock" (ISO 3864), also
known as High Voltage symbol
If the main cover must be removed, then contact a SCIEX representative to
prevent electric shock.

Hot Surface Hazard

In Vitro Diagnostic Device

Ionizing Radiation Hazard
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Symbol Description

Keep dry.

Do not expose to rain.

Relative humidity must not exceed 99%.

Keep upright.

Lacerate/Sever Hazard

Laser Radiation Hazard

Lifting Hazard

Magnetic Hazard

Manufacturer

Moving Parts Hazard

Pacemaker Hazard. No access to people with pacemakers.

Pinching Hazard
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Symbol Description

Pressurized Gas Hazard

Protective Earth (ground)

Puncture Hazard

Reactive Chemical Hazard

Serial number

Toxic Chemical Hazard

Transport and store the system within 66 kPa to 103 kPa.

Transport and store the system within 75 kPa to 101 kPa.

Transport and store the system within the specified minimum (min) and
maximum (max) levels of relative humidity, noncondensing.

Transport and store the system within –30 °C to +45 °C.

Transport and store the system within –30 °C to +60 °C.
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Symbol Description

USB 2.0 connection

USB 3.0 connection

Ultraviolet Radiation Hazard

United Kingdom Conformity Assessment Mark

VA Volt Ampere (power)

V Volts (voltage)

WEEE. Do not dispose of equipment as unsorted municipal waste.
Environmental Hazard

W Watts

yyyy-mm-dd

Date of manufacture
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Glossary of Warnings I
Note: If any of the labels used to identify a component become detached, contact a Field
Service Employee (FSE).

Label Translation (if applicable)

EN61326—1, EN61326—2-6, CLASS A,
GROUP 1, ISM-IVD EQUIPMENT

EN61326—1, EN61326—2-6, CLASS A,
GROUP 1, ISM-IVD EQUIPMENT

IMPACT INDICATOR

SENSITIVE PRODUCT WARNING

IMPACT INDICATOR

SENSITIVE PRODUCT WARNING

Note: If the indicator is tripped, then this
container has been dropped or otherwise
mishandled. Make a note on the Bill of Lading
and then check for damage. Any claims for
shock damage require a notation.

IMPORTANT!

RECORD ANY VISIBLE CRATE DAMAGE
INCLUDING TRIPPED “IMPACT INDICATOR”
OR “TILT INDICATOR” ON THE
WAYBILL BEFORE ACCEPTING SHIPMENT
AND NOTIFY YOUR LOCAL AB
SCIEX CUSTOMER SUPPORT ENGINEER
IMMEDIATELY.

DO NOT UNCRATE. CONTACT YOUR
LOCAL CUSTOMER SUPPORT ENGINEER
FOR UNCRATING AND INSTALLATION.

IMPORTANT!

RECORD ANY VISIBLE CRATE DAMAGE
INCLUDING TRIPPED “IMPACT INDICATOR”
OR “TILT INDICATOR” ON THE
WAYBILL BEFORE ACCEPTING SHIPMENT
AND NOTIFY YOUR LOCAL AB
SCIEX CUSTOMER SUPPORT ENGINEER
IMMEDIATELY.

DO NOT UNCRATE. CONTACT YOUR
LOCAL CUSTOMER SUPPORT ENGINEER
FOR UNCRATING AND INSTALLATION.

MINIMUM OF SIX PERSONS REQUIRED TO
SAFELY LIFT THIS EQUIPMENT

MINIMUM OF SIX PERSONS REQUIRED TO
SAFELY LIFT THIS EQUIPMENT

Note: Consult instructions for use.
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Label Translation (if applicable)

TIP & TELL Tilt Indicator

Note: Indicates whether the container was
tipped or mishandled. Write on the Bill of
Lading and inspect for damage. Any claims for
tipping require a notation.

TiltWatch PLUS

ShockWatch

Tilt Indicator

Note: Indicates whether the container was
tipped or mishandled. Write on the Bill of
Lading and inspect for damage. Any claims for
tipping require a notation.

WARNING: DO NOT OPERATE WITHOUT
FIRST ENSURING BOTTLE CAP IS
SECURED.

WARNING: DO NOT OPERATE WITHOUT
FIRST ENSURING BOTTLE CAP IS
SECURED.

Note: This warning is attached to the source
exhaust waste bottle.

WARNING: NO USER SERVICEABLE PARTS
INSIDE. REFER SERVICING TO QUALIFIED
PERSONNEL.

WARNING: NO USER SERVICEABLE PARTS
INSIDE. REFER SERVICING TO QUALIFIED
PERSONNEL.

Note: Consult instructions for use.
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Contact Us

Customer Training
• In North America: NA.CustomerTraining@sciex.com

• In Europe: Europe.CustomerTraining@sciex.com

• Outside the EU and North America, visit sciex.com/education for contact information.

Online Learning Center
• SCIEX Now Learning Hub

SCIEX Support
SCIEX and its representatives maintain a staff of fully-trained service and technical specialists
located throughout the world. They can answer questions about the system or any technical
issues that might arise. For more information, visit the SCIEX website at sciex.com or contact us
in one of the following ways:

• sciex.com/contact-us

• sciex.com/request-support

CyberSecurity
For the latest guidance on cybersecurity for SCIEX products, visit sciex.com/productsecurity.

Documentation
This version of the document supercedes all previous versions of this document.

To view this document electronically, Adobe Acrobat Reader is required. To download the latest
version, go to https://get.adobe.com/reader.
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To find software product documentation, refer to the release notes or software installation guide
that comes with the software.

To find hardware product documentation, refer to the Customer Reference DVD that comes with
the system or component.

Note: To request a free, printed version of this document, contact sciex.com/contact-us.
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